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Указания по безопасности 

Это руководство содержит указания , которые вы должны соблюдать для обеспечения собствен-
ной безопасности , а также защиты  продукта и подключенного оборудования . Эти указания 
выделены в показанным ниже символом и подразделяются в соответствии с уровнем опасности: 

 

!  
Опасность 
Указывает, что несоблюдение надлежащих предосторожностей приведет к смерти, тяжким 
телесным повреждениям или существенному повреждению имущества. 

 

!  
Предупреждение 
Указывает, что несоблюдение надлежащих предосторожностей может привести к смерти, 
тяжким телесным повреждениям или существенному повреждению имущества. 

 

!  
Предостережение 
Указывает, что несоблюдение надлежащих предосторожностей может привести к небольшим 
телесным повреждениям. 

 
 Предостережение 

Указывает, что несоблюдение надлежащих предосторожностей может привести к порче 
имущества. 
 

 Замечание 
Привлекает ваше внимание к особенно важной информации о продукте, обращении с 
продуктом или к определенной части документации.. 

Квалифицированный персонал 

К установке и работе на данном оборудовании должен допускаться только квалифицированный 
персонал. К квалифицированному персоналу относятся лица, имеющие право пускать в 
эксплуатацию, заземлять и маркировать электрические цепи, оборудование и системы в 
соответствии с установленным порядком и стандартами. 

 
Правильное использование 

Примите во внимание следующее: 

!  
Предупреждение 
Это устройство и его компоненты могут быть использованы только для приложений, описанных 
в каталоге или технических описаниях, и только в соединении с устройствами или 
компонентами других производителей, которые были одобрены или рекомендованы фирмой 
Siemens. 
Этот продукт может правильно и безопасно функционировать только при правильной 
транспортировке, хранении, установке и инсталляции, а также эксплуатации и обслуживании в 
соответствии с рекомендациями.. 

Торговые марки 

SIMATIC®, SIMATIC HMI® и SIMATIC NET® являются зарегистрированными торговыми марками 
SIEMENS AG. 

Некоторые из других обозначений, использованных в этих документах, также являются 
зарегистрированными торговыми марками; права собственности могут быть нарушены, если эти 
обозначения используются третьей стороной для своих собственных целей. 
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Предисловие 

Назанчение руководства 
Руководство обеспечивает Вам полный обзор программирования с 
испоьзованием S7-GRAPH. Оно оказывает поддержку при устанвоке 
инастройке программного обеспечния. Оно включает разъяснения, как 
создать программу, структуру программы пользователя и отдельные 
программные элементы. 

Руководство предназначается для лиц с соответствующей квалификацией, 
которая включает программирование, конфигурирование, пуск и 
обслуживание программируемых логических диспетчеров.  
Мы рекомендуем Вам ознакомиться самостоятельно с примером, в главе 3 
"Проектирование системы последовательного управления на примере 
сверлильного станка".  
Это поможет Вам быстро ознакомиться с S7-GRAPH. 

Необходимые навыки 
Для понимания настоящего руководства, Вам необходимы общие сведения о 
системах автоматического управления.  
Кроме того, вы должны быть знакомы с использованием компьютеров или 
РС-подобных инструментальных средств (напр., устройств 
программирования) с операционной системой MS Windows 2000 Professional  
или MS Windows XP Professional. Поскольку S7-GRAPH компонент базового 
программного обеспечения STEP 7, Вам требуются знания о основном 
программном обеспечении, содержащиеся в  руководстве "Programming with 
STEP 7 V5.x [Программирование с испоьзованием STEP 7 V5.x]". 

Область применения руководства  
Руковожство пригодно для программного обеспечния S7-GRAPH V5.3. 
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Документация для S7-GRAPH и для стандартного программного 
обеспечения STEP 7 

Следующая таблица дает обзор документации STEP 7 и S7-GRAPH: 
 

Руководство Назанчение Порядковый номер 
S7-GRAPH V5.3 для S7-300/400 Основная и справочная 

информация, разъясняющая 
как создать программу, 
структуру пользовательских 
программ и отдельные 
элементы языка. 

Руководство не имеет 
отдельного номера  
Оно поставляется на 
CD с программным 
обеспечением, 
возможна загрузка 
через internet. 

Основы STEP 7: 
• Getting Started and Exercises with  

STEP 7 V5.3 [Быстрое начало и 
примеры для STEP 7 V5.3] 

• Programming with STEP 7 V5.3 
[Программирование 
сиспользованием STEP 7 V5.3] 

• Configuring Hardware and 
Connections with STEP 7 V5.3 
[Конфигурироание оборудования и 
соединений в STEP 7 V5.3] 

• Converting from S5 to S7 [Переход от 
S5 к S7] 

Основная информация для 
технического персонала, 
описывающая методы 
реализации задач управления с 
помощью STEP 7 и 
программируемых 
контроллеров S7-300/400. 

6ES7810-4CA07-8BW0 
 

STEP 7 Reference [Справочник по STEP 
7], включающий 
• Руководства по LAD/FBD/STL для S7-

300/400 
• Стандартные и системные функции 

для S7-300/400 

Предоставляет справочную 
информацию и описывает 
языки программирования LAD, 
FBD и STL, а также 
стандартные и системные 
функции в дополнение к 
базовой информации по 
STEP7.  

6ES7810-4CA07-8BW1 
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Руководство и интерактивная помощь (Help) 
Данное руководство является фрагментом интерактивной помощи. 
Руководство описавает основы необходмые для работы с  S7-GRAPH.  
Интерактивная помощь модержит детальные, пошаговые инструкции и 
справки. Поскольку руководство и интерактивная помощь имеют одинаковую 
структуру, Вы можете легко переключаться от руководства к помощи. 

Access to Online Help 
Система помощи встроена в программное обеспечение через несколько 
интерфейсов: 

• Имеется несколько команд, которые вы можете выбрать в меню Help 
[Помощь]: Команда Contents [Содержание] открывает указатель 
помощи для STEP 7. Introduction [Введение] предоставляет обзор 
программирования с использованием S7-GRAPH Using Help 
[Использование помощи] дает подробные указания по обращению с 
оперативной помощью. 

• Контекстно-чувствительная помощь предоставляет информацию к 
текущему контексту, напр., к открытому диалоговому окну или к активному 
окну. Ее можно вызвать через экранную кнопку ”Help [Помощь]” или с 
помощью клавиши F1. 

• Еще одну форму контекстно-чувствительной помощи предоставляет 
строка состояния. Для каждой команды меню здесь отображается краткое 
объяснение, как только указатель мыши оказывается на этой команде. 

• Для символов на панели инструментов также высвечивается краткое 
объяснение, когда указатель мыши находится кратковременно на 
символе. 

Если вы предпочитаете читать информацию из оперативной помощи в 
напечатанном виде, то вы можете распечатать отдельные темы помощи, 
книги или же всю помощь. 

Дополнительная поддержка 
Если Вы имеете любые технические вопросы, пожалуйста свяжитесь с Вашим 
представителем Siemens или ответственным агентом. 

You will find your contact person at:  

http://www.siemens.com/automation/partner 

Учебные центры SIMATIC  
Фирма Siemens предлагает вам ряд учебных курсов для ознакомления с 
системой автоматизации SIMATIC S7. Для получения подробной информации 
обращайтесь, пожалуйста, в свой региональный учебный центр или в 
центральный учебный центр в Нюрнберге (D 90327 Nuernberg).  
Тел.:+49 (911) 895-3200 
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Техническая поддержка A&D   
Доступна по всему миру в любое время суток  

  

Beijing 

 Nuernberg 

Johnson City 

 
Всемирная (Нюрнберг) 
Техническая поддержка  
 

Круглосуточно, в любой день 

Тел.: +49 (180) 5050-222 

Факс: +49 (180) 5050-223 

E-Mail: adsupport@
 siemens.com 

GMT: +1:00 

  

Европа и Африка (Нюрнберг) 
Авторизации 
 
Местное время: Пн.-Пт. с 7:00 до 
17:00 

Тел.: +49 (180) 5050-222 

Факс: +49 (180) 5050-223 

E-Mail: adsupport@
 siemens.com 

GMT: +1:00 

США (Джонсон-Сити) 
Техническая поддержка и 
Авторизации  
Местное время: Пн.-Пт. с 8:00 до 
17:00 

Тел.: +1 (423) 262 2522 

Факс: +1 (423) 262 2289 

E-Mail: simatic.hotline@ 

 sea.siemens.com 

GMT: -5:00 

Азия и Австралия (Пекин) 
Техническая поддержка и 
Авторизации  
Местное время: Пн.-Пт. с 8:00 до 
17:00 

Тел.: +86 10 64 75 75 75 

Факс: +86 10 64 74 74 74 

E-Mail: adsupport.asia@ 

 siemens.com 

GMT: +8:00 

Языки горячей линии SIMATIC Hotlines и линии авторизаций немецкий и английский. 
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Серсис и поддержка через Internet 
В дополнение к Нашей документации, мы предоставляем ноу-хау через 
internet: 
http://www.siemens.com/automation/service&support 

Здесь Вы можете найти : 

Информационные письма постоянно извещающие Вас о изменениях в Ваших 
продуктах. 

Документы через функции поиска в сервисе и поддержке. 

Форум, где эксперты и пользователи со всего мира обмениваются мненисми. 

Вашего регионального представителя для Automation & Drives. 

Информацию о полевом обслуживании, ремонте, запасных частях и другое в 
"Services". 
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1 Обзор продукта 

Язык программирования S7-GRAPH 
Язык программирования S7-GRAPH дополняет функциональные возможности 
STEP 7 графическим интерфейсом программирования систем 
последовательного управления. 

S7-GRAPH позволяет Вам быстро и наглядно запрограммировать требуемое 
последовательное функционирование для ПЛК SIMATIC. При этом процесс 
разделяется на отдельные шаги, обеспечивая наглядный обзор 
функционирования. Графическое представление секвенсора можно 
документировать как рисунок и как текст. 

Действия, которые должны быть выполнены, определяются в этих шагах. 
Переходы управляют переключениями между шагами (условие для перехода 
на следующий шаг). Эти условия определяются с помощью  
программирования на LAD (контактный план) или на FBD (функциональная 
блочная диаграмма). 

PLCopen Basis Level  
S7-GRAPH начиная с версии V5.1 соответствует PLCopen Basis Level для 
систем последовательного управления в соответствии со стандартом DIN EN 
61131-3. 

Если Вы имеете систему последовательного управления соответствующую 
стандарту,  Вы должны импортировать ее в STEP 7, как файл ASCII, 
используя SIMATIC Manager, и затем редактировать ее в S7-GRAPH. 

Для создания системы последовательного управления, соответствующей 
стандарту, откройте диалоговое окно "Application Settings [Настройки 
приложения]" и активируйте на закладке "General [Общее]" свойство "IEC-
compliant [Соответствие IEC]". 
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Блоки последовательного управления 
Последовательное управление выполняется в определенном порядке, 
который зависит от некоторых условий.  

Сложность системы последовательного управления зависит от решаемой 
задачи автоматизации. Однако, даже основная система потребует по крайней 
мере три следующие блока: 

• Блок STEP 7 (1), в котором вызывается FB (функциональный блок) 
S7-GRAPH. Это может быть организационный блок (OB), функция (FC), 
или другой FB. 

• FB S7-GRAPH (2), который описывает отдельные подзадачи и 
взаимозависимости системы последовательного управления. Эти 
подзадачи (шаги) и взаимозависимости (переходы) могут быть 
сгруппированы в один или несколько секвенсоров. 

• Экземплярный DB (3), содержащий данные и параметры системы 
последовательного управления. Экземпляр DB назначается FB 
S7-GRAPH и может быть создан системой автоматически.  
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Сущность секвенсора с шагами и переходами 
Вы программируете секвенсор в FB S7-GRAPH. Секвенсор содержит 
последовательность шагов, которые должны выполняться в определенном 
порядке в зависимости от переходов (условий для переключения к 
следующему шагу). 

Motor Limit switch

     S1
Step1

T1

Step1

Action

     S2
Step2

Step2

Action

T2

Input1 Input2

Conditions

Action

Transition1

Transition2
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1.1 Что нового? 

Версия 5.3 программного обеспечения S7-GRAPH имеет следующие 
расширенные функции и изменения в сравнении с версией Version 5.2. 

Установка 
• S7-GRAPH выпускается для MS Windows 2000 Professional и  

MS Windows XP Professional. 

• Начиная с S7-GRAPH V5.3 используется новая процедура 
лицензирования. Теперь права пользователя поддерживаются не 
авторизацией, а лицензионным ключом. Лицензионный ключ 
обрабатывается Автоматическим менеджером лицензий (смотри “Права 
пользователя с применением Автоматического менеджера лицензий”). 
Программа "AuthorsW" больше не используется. 
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2 Установка 

2.1 Автоматический менеджер лицензий 

2.1.1 Автоматический менеджер лицензий и права пользователя 

Автоматический менеджер лицензий 
Для использования программного обеспечения Вам требуется определенный 
для продукта ключ лицензии   (права пользователя). Начиная со STEP 7 V5.3, 
этот ключ устанавливается Автоматическим менеджером лицензий .  

Автоматический менеджер лицензий (Automation License Manager) – 
программный продукт Siemens AG. Он используется для управления ключами 
лицензий (лицензируемыми модулями) всех систем. 

Автоматический менеджер лицензий расположен в следующих местах: 

• На установочном устройстве STEP 7.  

• Загружается как страница Internet  системы поддержки пользователей 
департамента A&D Siemens AG 

Автоматический менеджер лицензий имеет собственную встроенную 
интерактивную систему помощи. Для использования помощи после того как 
менеджер лицензий установлен, нажмите F1 или выберите Help > Help on 
License Manager [Помощь > Помощь по менеджеру лицензий]. Эта 
интерактивная помощь содержит подробную информацию о функциональных 
возможностях и работе с Автоматическим менеджером лицензий. 

Лицензии 
Лицензии необходимы при работе с программными пакетами STEP 7, 
поскольку их легальное использование защищено лицензиями. Лицензия 
дает пользователю законные права на использование продукта. 
Предусматривается следующее подтверждение этих прав: 

• Сертификат лицензии (CoL - Certificate of License), и 

• Ключ лицензии  

Сертификат лицензии  (CoL) 
"Сертификат лицензии", который включен в продукт – это законное 
подтверждение прав на использование данного продукта. Этот продукт может 
использоваться собственником сертификата лицензии  (CoL) или теми 
лицами, которые уполномочены владельцем. 
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Ключ лицензии  
Ключ лицензии  это техническое представление (электронная "печать 
лицензии") лицензии на использование программного обеспечения. 
SIEMENS AG выпускает ключи лицензии для всех для всех программ, 
защищенных лицензией. Когда компьютер запускается, такое программное 
обеспечение может быть использовано только в соответствии с прилагаемой 
лицензией и условиями использования после проверки наличия правильного 
лицензионного ключа. 
 

 Замечания 
• Вы можете использовать программы без ключа лицензии  для 

самостоятельного изучения пользовательского интерфейса и функций. 
• Однако лицензия необходима для полного, неограниченного 

использования программного обеспечения в соответствии с лицензией  
• Если у Вас не установлен ключ лицензии, Вам будут регулярно 

выдаваться предупреждения об этом. 
  
Ключ лицензии может храниться и передаваться через различные типы 
устройств хранения: 
• На лицензионной дискете  
• На локальном твердом диске 
• На сетевом твердом диске 
Для дополнительной информации о работе и обращении с ключом лицензий 
справьтесь в системе помощи к Автоматическому менеджеру лицензий. 

Типы лицензий 
Для программного обеспечения Siemens AG возможны следующие типы 
пользовательских лицензий, ориентированных на приложения. Реальное 
поведение программного обеспечения определяется установленным ключом 
лицензии. Тип использования можно найти на сопутствующем Сертификате 
Лицензии. 
 

Тип лицензии  Описание 
Простая лицензия Программное обеспечение может использоваться на отдельном  

компьютере неограниченное время.  

Лицензия предприятия Программное обеспечение может использоваться в сети компьютеров 
("удаленный пользователь") неограниченное время.  

Пробная лицензия  Программное обеспечение может использоваться с следующими 
ограничениями 
• Период использования максимум 14 дней, 
• Общее число рабочих дней после дня первого использования, 
• Использование для проверки и освобождение от ответственности. 

Лицензия на 
обновление 

При обновлении программного обеспечения могут существовать 
определенные требования к существующей системе: 
• Лицензия на обновление может использоваться для преобразования  

программного обеспечения “старой версии X" в новую версию X+. 
• Обновление может быть необходимым из-за увеличения объема 

данных обрабатываемых в системе. 
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2.1.2 Установка автоматического менеджера лицензий  

Автоматический менеджер лицензий   устанавливается программой Setup. 
Установочное программное обеспечение Автоматического менеджера 
лицензий включено в CD программного обеспечения STEP 7. 

Вы можете установить Автоматический менеджер лицензий при установке  
S7-GRAPH или позднее. 

 
 Замечания 

• Для подробной информации о установке Автоматического менеджера 
лицензий, справьтесь пожалуйста, в файле "Readme.wri" 

• Интерактивная помощь к Автоматическому менеджеру лицензий.  

  

Последующая установка ключа лицензии 
Если Вы запустили программное обеспечение S7-GRAPH, а ключ лицензии 
не доступен, появляется предупреждающее сообщение об этом. 

  
 Замечания 

• Вы можете использовать стандартное программное обеспечение без 
ключа лицензии для самостоятельного изучения интерфейса и функций. 

• Тем не менее, лицензия необходима и обязательна для полного, 
неограниченного использования программного обеспечения в 
соответствии с условиями лицензии  

• Если Вы не установили ключ лицензии, предупреждения об этом будут 
выдаваться Вам с регулярным интервалом. 

  

Вы можете установить ключ лицензии впоследствии следующими методами: 

• Установите ключ лицензии с дискеты 

• Установка ключа лицензии загружается через Internet. В этом случае ключ 
лицензии сначала должен быть предварительно заказан. 

• Использование ключа переносимой лицензии  возможно в сети 

Для более подробной информации о установке ключа лицензии справьтесь в 
интерактивной справке к Автоматическому менеджеру лицензий. Получить 
справку, нажмите F1 или выберите команду меню Help > Help on License 
Manager [Помощь > Помощь по менеджеру лицензий]. 

 
 Замечания 

• В Windows 2000/XP, лицензионный ключ авторизации может работать 
только если он установлен на локальном жестком диске и имеет доступ 
для записи. 

• Переносимую лицензию можно также использовать в сети ("удаленное" 
использование). 
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2.1.3 Руководство по работе с ключом лицензий 

  

!  
Предупреждение 
Пожалуйста запомните информацию о работе с ключом лицензии, 
приведенную в интерактивной справке и файле Readme.wri к 
Автоматическому менеджеру лицензий. Если Вы не будете следовать этим 
правилам, ключ лицензии может быть утерян. 

Для доступа к интерактивной справке по Автоматическому менеджеру 
лицензий нажмите F1 для контекстно зависимой справки или выберите пункт 
меню Help > Help on License Manager [Помощь > Помощь по 
автоматическому менеджеру лицензий]. Этот раздел помощи содержит 
всю информацию, необходимую Вам для работы с ключом лицензий. 

 

2.2 Установка  

2.2.1 Установка S7-GRAPH  

S7-GRAPH имеет программу установки (Setup), которая автоматически 
устанавливает пакет. Запросы в диалоговых экранах ведут Вас шаг за шагом 
через процесс установки. Программа установки запускается как обычная 
программа установки  Windows. 

Требования к установке 
• Операционная система Microsoft Windows 2000/XP  

• Стандартный пакет SIMATIC STEP 7 (о требуемой версии, справьтесь в 
файле Readme.wri). 

• PC или программатор оснащен как описано в файле readme file 

Программатор (PG) это персональный компьютер, сконструированный 
специально для работы в промышленных условиях. Он полностью оснащен 
для программирования программируемых контроллеров SIMATIC.  

• Пространство на диске: 
Справьтесь в файле "Readme" о необходимом на жестком диске 
свободном пространстве. 

• Интерфейс MPI (дополнительно): 
Вам требуется интерфейс MPI между программатором (или PC) и PLC, 
только в том случае, если Вы желаете установить связь с PLC через MPI. 
Для такого соединения Вам необходимо одно из двух: 

- Кабель PC/MPI подключен к коммуникационному порту Вашего 
устройства или 

- Карта MPI устновлена в Вашем устройстве.  

Карта MPI встроена в программатор. 
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• Внешний программатор (дополнительно): 
Внешний программатор требуется только в том случае, если Вы хотите 
программировать EPROM, используя Ваш PC. 

2.2.2 Запуск программы установки 

Подготовка к установке 
До начала установки должен быть запущен Windows. 

Для установки с CD-ROM, вставьте CD-ROM в привод Вашего PC. 

Запуск программы установки 
Для установки программного обеспечения: 

1. В Windows, откройте диалог для установки/удаления программ двойным 
щелчком на иконке "Add/Remove Programs" в "Control Panel". 

2. Шаг за шагом выполните инструкции установки. 

Программа, шаг за шагом, руководит Вами при установке. Вы можете перейти 
к следующему шагу или вернуться  к предыдущему. 

В процессе установки, Вам будут предложены вопросы для выбора 
вариантов. Пожалуйста прочитайте следующие заметки, чтобы получить 
информацию, необходимую для данных диалоговых окон. 

Если Вы уже имеете установленную версию S7-GRAPH... 
Если программа установки обнаруживает установленный на Вашем 
компьютере S7-GRAPH, появляется сообщение и Вы имеете следующие 
возможности: 

• Прекратить установку (в этом случае Вы должны деинсталлировать 
старую версию S7-GRAPH в Windows и после этого запустить установку 
снова) или  

• Продолжить установку и перекрыть старую версию новой. 

В целях «чистого» управления данными, следует деинсталлировать старую 
версию перед установкой новой. Простое перекрытие старой версии имеет 
тот недостаток, что при последующей деинсталляции остаются части, не 
удаленные при установке методом перекрытия. 
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2.2.3 Замечания к установке 

Установка лицензионного ключа 
В процессе установки программа проверяет, установлен ли на жестком диске  
соответствующий лицензионный ключ. Если правильный лицензионный ключ 
не обнаруживается, выдается сообщение,  что программное обеспечение 
может быть использовано только с показанным лицензионным ключом. Если 
Вы хотите, Вы можете установить лицензионный ключ немедленно или 
продолжить установку и установить ключ позже. Если Вы хотите установить 
лицензионный ключ сразу, вставьте авторизационную дискету, когда это 
будет предложено. 

Ошибки при установке 
Следующие ошибки при установке ведут к ее отмене: 

• Если сразу после запуска Setup возникает ошибка инициализации, 
наиболее вероятная причина, что Setup запущен не под Windows. 

• Не достаточно пространства на диске: Вы должны иметь свободное 
пространство на жестком диске достаточное для выбранного типа 
установки (см. readme). 

• Дефекты CD/дискеты: Если Вы обнаруживаете, что CD/дискета - 
дефектны, пожалуйста обратитесь к своему дистрибютеру Сименса или в 
офис продаж. 

• Если Вы делаете ошибку: Начните установку снова и выполняйте 
инструкции тщательнее. 

Завершение установки 
Появляется экран сообщения об успешной установке.  

Если в процессе установки были сделаны изменения в файлах DOS, Вы 
получите запрос о перезапуске Windows. После рестарта Вы должны 
перезапустить и S7-GRAPH. 

С другом случае можно запустить S7-GRAPH сразу после установки. 

2.2.4 Деинсталляция S7-GRAPH  

Для деинсталляции программного обеспечения используется обычный для 
Windows способ: 

1. Откройте в Windows диалог для установки/деинсталляции программ 
двойным щелчком на иконке "Add/Remove Programs [Добавить/удалить 
программы]" в "Control Panel". 

2. Выберите запись для S7-GRAPH в списке установленных программ. 
Нажмите кнопку "Add/Remove [Добавить/удалить программы]" для 
деинсталляции программы. 

В появившемся диалоге "Remove Released File", нажмите кнопку "No", если 
Вы неуверенны, хотите ли Вы удалять данный файл. 
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3 Разработка системы 
последовательного управления на 
примере сверлильного станка 

Приглашаем в пример для новичков S7-GRAPH  
Потратив один час для работы с примером для начинающих, Вы узнаете, как 
создать последовательную систему управления для автоматизации 
сверлильного станка, описанную здесь. 

  
Вы сначала узнаете, как эффективно спроектировать последовательную 
систему управления и далее шаг за шагом выполните в SIMATIC Manager 
Менеджере и в S7- GRAPH задачи, необходимые для:  

• создания системы последовательного управления,  

• загрузки ее в CPU и 

• проверки. 

Правильный пример программы поставляется с S7-GRAPH, как проект, 
названный "ZEn02_01_S7GRAPH_Drill". 
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Требования 
 Чтобы запрограммировать и проверить пример "сверлильный станок", Вам 
потребуется следующая аппаратура и программное обеспечение: 

• Программатор или PC с  

-  стандартным пакетом STEP 7 и дополнительным пакетом 
S7-GRAPH  

-  соединением MPI с программируемым логическим контроллером 

• Программируемый логический контроллер (в нашем примере S7-300) 
содержащий: стандартную рейку, источник питания 24V, CPU 314, и 
модуль входов/выходов (8DI + 8DO) 

• В качестве замены PLC можно использовать дополнительный пакет S7 
"PLC Simulation" 

Последовательность создания системы последовательного управления 
 Блок схема иллюстрирует последовательность создания системы 
последовательного управления для примера сверлильного станка: 

  

Создание символ. табл.

Задание структуры секвенсора
и определение сигналов

Создаем проекта для сверлен. 
в SIMATIC Manager

Создание секвенсора
• Создание и открытие FB1 

S7 Graph в SIMATIC Manager
• Программа секвенсора

Программа OB1 с вызовом FB1 и 
соответствующим экземпляром

Загрузка примера программы (DB1, ,
FB1, OB1) в CPU в SIMATIC 
Manager и проверка секвенсора

Символьное
программирование

да

нет

системы

DB (DB1)
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3.1 Технологическая задача и функциональная 
диаграмма 

Задача 
Требуется запрограммировать последовательную систему управления, чтобы 
автоматизировать сверлильный станок. Работу сверлильного станка 
показывают технологический чертеж и последовательность процесса в виде 
функциональной диаграммы. 

Технологический чертеж сверлильного станка 
Сверлильный станок имеет следующие элементы: 

• Мотор сверла с сигналами обратной связи для включенного и 
выключенного состояния 

• Кнопка пуска и переключатель охлаждения 

• Насос охлаждения с сигналом обратной связи о достижении давления 
охладителя  

• Устройство зажима с сигналом обратной связи о достижении усилия 
зажима 

• Каретка  перемещения вверх и вниз сверла с ограничивающими ключами 

 

 

Подъем сверла 
Мотор сверла включен 
Сигналы обратной связи: 

- Сверло включено 
- Сверло выключено 

Насос охлаждения включен 
Сигнал обратной связи 
Достигнуто давление 

Пуск 

Сигнал обратной связи: 
Достигнуто заданное усилие зажима 

Верхний концевик 

Включение охлаждения 

Мотор сверла 

Каретка 

Устройство зажима Насос охлаждения 

Опускание сверла 

Нижний концевик 

 



Разработка системы последовательного управления на примере сверлильного станка 

 S7-GRAPH для S7-300/400 Программирование систем последовательного управления 
3-4 A5E00290656-01 

Начальное состояние 
Начальное состояние сверлильного станка определено следующим образом: 

• Мотор сверла и насос охлаждения выключены 

• Каретка сверла в верхней позиции  

• В устройстве зажима нет заготовки 

Функциональная диаграмма – Последовательность сверления 
Последовательность сверления может быть разбита на следующие разделы: 

• Установка заготовки (вручную) 

• Если необходимо, устанавливается ключ охлаждения (в зависимости от 
материала) 

• Запуск установки кнопкой пуска (мотор сверла включается) 

• Зажим заготовки с заданным давлением 

• Запуск мотора охлаждения (если выбрано охлаждение) 

• Опускание сверла и каретки в нижнюю целевую позицию (сверление) 

• Выдержка 0.5 сек в нижней целевой позиции (сверление) 

• Подъем сверла с кареткой в верхнюю целевую позицию  

• Освобождение заготовки, выключение мотора и насоса охлаждения 

• Удаление заготовки (вручную) 

 

Мотор 
Вкл. 

Выкл. 

Каретка 
вверх 

вниз 

Элемент Состояние 

Зажим Вкл. 

Выкл. 

Пуск 
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3.2 Выбор структуры секвенсора 

До создания программы секвенсора, Вы должны выполнить концептуальную 
стадию разработки, разбив операцию сверления на отдельные шаги. Основой 
для разработки концепции служат технологический чертеж и диаграмма. 

Разделение процесса сверления на отдельные шаги – Структура секвенсора 
Процесс сверления описывается S7-GRAPH в виде секвенсора. Секвенсор 
представляет последовательность простых шагов и условий, которые 
управляют переходами от одного простого шага к следующему. Чтобы 
определить структуру секвенсора, выполните следующее: 

1. Разбейте процесс сверления на шаги и определите порядок шагов (напри-
мер, "шаг S2 следует за S1" или "за шагом S3 следует или шаг S4 или S7"). 

2. Определите действия, которые должны выполняться для каждого шага 
(например, на шаге S1 действие "Подготовка сверления" или на шаге S3 
действие  "Выключение мотора сверла"). 

3. Далее для каждого шага решите, какие условия должны выполняться, 
чтобы процесс мог перейти к следующему шагу (например, для T1 условие 
"Станок включен – нажата кнопка пуска" или для T5 условие "Сверло в 
нижней позиции"). 

 

T2 
S2 

T8 

T3 
T7 

S3 

S1 

T4 

T1 

T6 

S7 

S4 

Станок готов  (начальный шаг) 

Зажим заготовки 

Включение мотора сверла 

Включение насоса охладителя 

Опу скание сверла (начало сверления) 

Начала программы сверления 
(нажата кнопка пу ска) 

Заготовка зажата с  заданным 
усилием 

Мотор сверла запущен с заданной 
скоростью (без охлаждения) 

Достигну то давление охладителя  

Сверло в  нижней позиции 

Мотор сверла запущен с  заданной 
скоростью (с  охлаждением) 

S5 

S6 
T5 

T6 
S1 

Подъем сверла 

Отпу скание заготовки, выключение 
motorсверла и насоса 

Сверло в  верхней позиции 

Заготовка освобождена, насос  
охладителя и мотор сверла   
выключены. Пау за 500 мс 

S = шаг 
T = переход 

Монитор зажима 
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3.3 Определение сигналов системы 

Когда Вы разделите операцию сверления на отдельные шаги, Вы должны 
определить входные и выходные параметры для каждого шага. Основой для 
проектирования служат технологический чертеж и функциональная 
диаграмма. 

Определение входов и выходов 
Перепишите входы и выходы сверлильного станка в виде таблицы.  

Если Вы хотите программировать в символьном виде, введите 
соответствующие символьные имена (например, вход I 0.4 "Cl_press_ok") для 
абсолютных входов и выходов и любые комментарии, которые делают Вашу 
программу проще для понимания (например "Достигнуто требуемое усилие 
зажима заготовки"). 

Для примера сверлильного станка, принято, что ключи и контакторы 
управляются через входы и выходы цифрового вход-выходного модуля 
программируемого контроллера S7-300. Вход-выходной модуль имеет 8 
входов и 8 выходов. По умолчанию входы и выходы для модуля, 
вставленного в 4 слот, имеют адреса: от I 0.0 до I 0.7 и от Q 0.0 до Q 0.7. 

 
Абсолютные 
адреса 

Символьные  
адреса 

Пояснение 
 

Входы в программе (I)  
I 0.0 Dr_mot_running Сигнал обратной связи о вращении мотора 

сверла с заданной скоростью  
I 0.1 Dr_mot_stopped Сигнал обратной связи о останове мотора сверла 
I 0.2 Drill_down Нижний концевик сверла 
I 0.3 Drill_up Верхний концевик сверла  
I 0.4 Cl_press_ok Сигнал обратной связи о достижении заданного 

усилия зажима заготовки  
I 0.5 Coolant_sel Включение охлаждения (в зависимости от 

заготовки) 
I 0.6 Cool_press_ok Сигнал обратной связи о достижении заданного 

давления охладителя   
I 0.7 Start_button Кнопка включения 
Выходы в программе (Q)  
Q 0.0 Dr_mot_on Включение мотора сверла 
Q 0.1 Cool_pump_on Включение насоса охладителя (в зависимости от 

заготовки) 
Q 0.2 Lower_drill Опускание сверла и каретки до нижней позиции  
Q 0.3 Raise_drill Подъем сверла и каретки до верхней позиции  
Q 0.4 Clamp_workp Зажим заготовки до заданного усилия 
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3.4 Создание проекта в SIMATIC Manager 

Создание проекта  
Проекты для систем последовательного управления не отличаются от других 
проектов STEP 7. 

Для создания нового проекта в SIMATIC Manager, выполните описанные ниже 
шаги: 

1. Выберите команду меню File > New [Файл > Новый].  

2. Назовите проект "Drill". 

Вставка программы S7  
В этом примере, конфигурация аппаратуры не требуется, так как 
используется адресация вход-выходного модуля в слоте 4 по умолчанию. 
Следовательно, Вы можете в SIMATIC Manager непосредственно вставить 
программу S7 в папку проекта. Программа S7 служит папкой для блоков 
программы пользователя, исходных файлов и символики. Выполните 
следующее: 

1. Выберите проект "Drill". 

2. Выберите команду меню Insert > Program > S7 Program [Вставить > 
Программа > Программа S7]. 

3. Назовите программу S7 "Drill Program". 

Папки для исходных файлов, блоков и символика создаются автоматически 
при вставке программы S7. В папке блоков создается также пустой OB1. 
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3.5 Создание таблицы символов 

Программируя в  STEP 7, Вы работаете с такими адресами как сигналы на 
входах и выходах, меркеры, счетчики, таймеры, блоки данных и 
функциональные блоки. Вы имеете доступ к этим адресам в Вашей 
программе в абсолютном виде (например, I1.1, M2.0, FB21). 

Вы можете сделать программу значительно яснее и проще для чтения, 
используя вместо абсолютных адресов символы (например, Motor_A_on). 
Чтобы использовать символы, Вы должны ввести имя, абсолютный адрес, 
тип данных и комментарий для каждого используемого адреса. 

Как только Вы определили символ, он может использоваться всюду в 
пользовательской программе программируемого модуля. 

Создание таблицы символов  
Если Вы хотите писать Вашу пользовательскую программу символьные 
адреса, желательно создать таблицу символов сейчас.  

1. Откройте символьную таблицу в папке "Drill Program" двойным щелчком на 
"Symbols". 

2. Отредактируйте таблицу как показано ниже.  

3. Сохраните символьную таблицу, используя команду меню Table > Save 
[Таблица > Сохранить]. 

Строки с 1 по 14 используются для символьного представления входов и 
выходов. Записи с 15 по 18 дают символьное представление блоков.  
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3.6 Создание FB S7-GRAPH и программирование 
секвенсора 

Создание FB на языке S7-GRAPH  
FB на языке S7-GRAPH должен содержать секвенсор. Для создания FB 
S7-GRAPH, выполните следующее: 

1. Откройте в SIMATIC Manager папку "Blocks" в "Drill Program". 

2. Выберите команду меню Insert > S7 Block > Function Block [Вставить > Блок 
S7 > Функциональный блок]. 

3. Выберите в диалоге "Properties [Свойства]" в качестве языка "S7-GRAPH".  

Результат: В папке "Blocks" создан пустой FB с номером по умолчанию 1. 

Программирование секвенсора  
После запуска редактора S7-GRAPH двойным щелчком на FB1 система 
вставляет первый шаг (начальный шаг) и первый переход. Структуру 
желательно создавать при уровне отображения "Sequencer". Для отображе-
ния условий и действий, вызовите команду меню View > Display With > 
Conditions and Actions [Вид > Показывать с…  > Условия и действия]. 

Используя мышь и палитру инструментов "Sequencer", расположенную слева, 
Вы можете разместить все требуемые шаги и переходы, альтернативную 
ветвь и скачок с конца секвенсора к его началу. Есть два способа сделать 
это, и оба показаны здесь. 

Способ 1: "Прямой"  
1. Выделите переход 1 и нажимайте мышью кнопку  

  insert step + transition [вставить шаг и переход] 
пока Вы не получите шаг и переход 6. 

2. Выделите шаг 3 и нажмите кнопку 

  open alternative branch [открыть альтернативную ветвь].  
Открывается альтернативная ветвь для обслуживания охлаждения. Ветвь 
начинается с перехода 7.  

3. Выберите мышью кнопку  

   insert step + transition [вставить шаг и переход],  
и вставьте шаг 7 (S7) и переход 8 (T8).  

4. Выберите кнопку 

  close alternative branch [закрыть альтернативную ветвь] 
и выберите затем переход 3. 

5. Теперь завершите структуру секвенсора, выбрав сначала переход 6 и 
нажав на кнопку  

   insert jump [вставить скачок], 
а затем выбрав шаг 1. 
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Способ 2: "Перетаскивание" 
1. Возвратитесь в SIMATIC Manager и создайте функциональный блок FB2 в 

папке "Blocks" как описано выше. Опять выберите в качестве исходного 
языка "GRAPH". 

2. Запустите редактор S7-GRAPH двойным щелчком на FB2 в папке "Blocks". 

3. Выберите команду меню Insert > Drag-and-Drop [Вставить > 
Перетащить]. 

4. Используя мышь, выберите кнопку 

  insert step + transition [вставить шаг и переход] 
и затем щелкайте на последнем появляющемся переходе, пока не 
получите шаг и переход 6. 

5. Выберите кнопку  

   open alternative branch[открыть альтернативную ветвь] 
и откройте альтернативную ветвь для охлаждения щелчком на шаге 3. 
Ветвь открывается переходом 7.  

6. Используя мышь, выберите кнопку  

  insert step + transition [вставить шаг и переход],  
для вставки шага 7 (S7) и перехода 8 (T8).  

7. Выберите кнопку  

   close alternative branch [закрыть альтернативную ветвь] 
и выберите сначала переход 8, а затем переход 3. 

8. Теперь завершите структуру секвенсора, используя кнопку  

 insert jump [вставить скачок] 
и выбрав сначала переход 6 и затем шаг 1. 

 
 Замечание 

Закройте FB2 до программирования действий шагов. Вы создали этот FB 
только для того, чтобы ознакомиться со вторым способом создания структуры 
секвенсора. При закрытии FB, ответьте на все вопросы "No". В дальнейшем 
Вы будете работать только с FB1. 
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3.7 Программирование действий шага   

Существует также два способа для программирования шагов и переходов: 
прямой и перетаскивание. Процедура, описанная ниже, предполагает, что 
Вы выбрали команду меню Insert > Drag-and-Drop [Вставить> 
Перетаскивание]:  

1. Выберите команду меню Insert > Action [Вставить > Действие].  
Результат: курсор мыши примет показанный ниже вид: 

 
2. Вставьте пустую строку действия, щелкая на поле действия. 

3. Введите действия. 

Действие состоит из команды и адреса операнда. Для программы сверления, 
в шагах необходимы четыре различных команды: 

• S Установить выход 

• R Сбросить выход 

• N Установка без сохранения: Пока шаг активен, операнд 
устанавливается в 1. 

• D Задержка: Операнд устанавливается в 1 спустя определенное 
время после активации шага и сбрасывается при деактивации шага. 

3.8 Программирование переходов 

Логические команды "нормально разомкнутый контакт", "нормально 
замкнутый контакт" и "компаратор" используются в переходах для условий, 
разрешающих шаг. Для программирования переходов: 

1. Установите вид "LAD" и нажимайте соответствующие кнопки в панели 
инструментов "LAD/FBD" 

  вставка нормально открытого контакта 

  вставка нормально закрытого контакта  

  вставка компаратора 

2. Позиционируйте символы в соответствующие точки щелчком на линии 
перехода. В любой момент Вы можете выйти из режима вставки, нажав 
клавишу ESC. 

3. Введите адреса. Щелкните на метке - заполнителе "??.? " требуемого 
текстового поля. Затем введите абсолютный или символьный адрес 
(например, I 0.7, "Start_switch"). 

4. Если требуется, Вы можете ввести комментарии к секвенсору. В 
представлении "sequencer", поле комментария располагается в верхнем 
левом углу и может быть открыто щелчком мыши на нем. 
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Следующий рисунок показывает законченный секвенсор. 
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При программировании сравнения (компараторов), Вы можете использовать 
вместо адресов системную информацию о шагах. Используются следующие 
обозначения: 

• Имя_шага.T: текущее или последнее время активности шага 

• Имя_шага.U: текущее или последнее время активности шага с вычетом 
времени нарушений 
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3.9 Программирование мониторинга 

Для программирования мониторинга: 

1. Дважды щелкните на шаге 2 для замены вида отображения "sequencer 
[секвенсор]" на вид "single step [отдельный шаг]". 

2. Выбрав в палитре инструментов "LAD/FBD" кнопку 

 вставьте компаратор  

3. Разместите компаратор в соответствующей позиции строки супервизора и 
введите необходимое время мониторинга. 
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3.10 Выбор стандартного функционального блока 

Выполнение FB S7-GRAPH  
Возможны два варианта для создания FB S7-GRAPH. 

• Полный код: 
Для каждого FB S7-GRAPH весь требуемый код включается в FB. Если Вы 
имеете различные FB S7-GRAPH, это приводит к значительному 
увеличению объема требуемой для программы памяти. 

• Использование стандартной FC: 
Для сокращения требований к памяти, S7-GRAPH имеет альтернативное 
решение: Использование стандартной FC, содержащей основную часть 
кода для всех FB. Эта FC автоматически копируется в Ваш проект при 
выборе соответствующей опции. FB созданные по этому методу будут 
значительно меньше.  

Для нашего примера используйте настройку компилятора "Full code [Полный 
код]".  

Наиболее подходящая FC зависит от характеристик Вашего CPU. Выберите 
одну из следующих стандартных FC: 
 

Номер FC  Функционирование 
FC72 По умолчанию, Вы работаете с FC72. Помните, что Ваш CPU должен быть способен к 

обработке блоков, размером больше 8 килобайт.  
FC70/FC71 Эти две FC, размером меньше 8 килобайт, могут быть загружены в небольшой 

центральный процессор. FC70 использует диагностические возможности SFC17/18 и 
может быть использована только на CPU, имеющих эти функции. Если Ваш CPU не 
имеет этих функций, Вы должны использовать FC71 и не имеете возможностей 
диагностики.  
Если Вы хотите проверить, поддерживает или нет Ваш CPU эти SFC, выберите в 
SIMATIC Manager команду меню PLC > Obtainable Nodes [PLC > Доступные узлы] 
или нажмите соответствующую кнопку в панели инструментов. Откройте папку 
"Blocks" а программе S7. 

FC73 Этот блок занимает менее 8 кбайт памяти и может выполняться на всех CPU.  
Использование этого FC значительно уменьшает требования к объему памяти для 
FB S7-GRAPH. Вы должны также выбрать опцию "Interface Description: Memory 
minimized [Описание Интерфейса: минимизация памяти]" в установках блока.  
Однако действует следующее ограничение: Созданные блоки не имеют возможности 
диагностики 
Когда Вы контролируете последовательную систему управления, Вы будете видеть, 
что состояние отображается только для выбранного активного элемента. 
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Установка свойств выполнения 
Выберите команду меню Options > Block Settings  [Возможности > 
Установки блока] и установите на закладке Compile/Save 
[Компиляция/Сохранение] как FB S7-GRAPH должен работать со 
стандартными FC. Введите номер FC в соответствии с возможностями 
Вашего CPU. 

Блок автоматически копируется в пользовательский проект, если Вы выбрали 
FC70/71, FC72 или FC73 и функции  с таким номером нет в Вашем проекте. 
Если Вы хотите использовать другой номер для стандартного блока, Вы 
должны копировать и перенумеровать его самостоятельно. 

3.11 Сохранение и закрытие секвенсора 

Когда Вы сохраняете и закрываете секвенсор, он автоматически 
компилируется. 

1. Выберите команду меню File > Save [Файл> Сохранить]. 

Результат: открывается диалоговое окно "Select Instance DB [Выбрать 
экземпляр DB]" с заданным по умолчанию экземпляром DB (DB1). 

2. Подтвердите параметры настройки, нажав "OK". 

Результат: Экземпляр блока данных автоматически создается в папке 
"Blocks". 

 
 Заметьте 

Предупреждение "S1 without content [S1 без содержания]" в результатах 
компиляции означает, что в шаге 1 не запрограммировано никакого действия. 

 

3. Чтобы закрыть программу секвенсора, выберите команду меню File > 
Close [Файл > Закрыть]. 
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3.12 Подключение секвенсора к программе STEP 7  

Программирование OB1 
Программа последовательного управления для сверления вызывается в 
организационном блоке OB1. Вы можете создать OB1 в LAD, FBD, STL или 
SCL (здесь он создан на LAD). Запрограммируйте OB1, как показано на 
следующей диаграмме. Выполните следующее: 

1. Откройте в SIMATIC Manager папку "Blocks" в программе S7 "Drill Program". 

2. Запустите редактор LAD/STL/FBD двойным щелчком на OB1.  

3. Через меню команд View [Вид], выберите язык программирования LAD. 

4. Выберите сегмент 1 и вставьте вызов секвенсора, двойным щелчком на 
FB1 (Seq_drill) в каталоге элементов. 

5. Напечатайте над боксом для FB1имя соответствующего экземплярного 
блока данных (IDB_Seq_drill). 

6. Выберите входной параметр INIT_SQ, вставьте нормально открытый 
элемент в панели инструментов "LAD" и подпишите его M0.0 ("INIT_SQ"). 
Используя этот параметр,  Вы сможете в интерактивном (online) режиме 
устанавливать секвенсор в начальное состояние (в примере шаг 1). 

7. Выберите команду меню File > Save [Файл > Сохранить] и закройте 
организационный блок командой меню File > Close [Файл > Закрыть]. 

 
 Замечание 

Все другие параметры блока можно проигнорировать для этого примера. 
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3.13 Загрузка программы в CPU и проверка секвенсора 

Загрузка пользовательской программы 
Чтобы загрузить программу в CPU, необходимо в SIMATIC Manager загрузить 
все ее блоки (DB1, FB1, OB1, FC70/71, FC72 и/или FC73) в CPU 
программируемого контроллера. Выполните следующее:  

1. Откройте в SIMATIC Manager программу S7 "Drill Program" и выберите 
папку "Blocks". 

2. Выберите команду меню PLC > Download [PLC > Загрузить]. 

 
 Предупреждение 

Лучше загружать блоки S7-GRAPH в режиме STOP, поскольку при 
последующей загрузке экземпляра DB, секвенсор автоматически 
устанавливается в начальное состояние. 

Вы должны загружать блоки S7-GRAPH в режиме RUN-P только, если 
секвенсор находится в начальном состоянии или состоянии OFF. Если Вы 
загружаете блоки секвенсора в другом состоянии, например, перезаписывая 
старый блок, могут возникнуть проблемы синхронизации секвенсора с 
процессом. 

Проверка пользовательской программы  
Для проверки пользовательской программы, Вы должны иметь интерактивное 
(online) соединение с CPU. 

1. Откройте в SIMATIC Manager окно проекта. 

2. Откройте секвенсор, дважды щелкнув на FB1.  

3. Выберите команду меню Debug > Monitor [Отладка > Наблюдение]. 

Результат: Отображается состояние программы (активен начальный 
шаг). Активные шаги отображаются цветом. 

 
 Предупреждение 

Контроль времени запрограммирован в шаге 2. Если время активности шага 
превышает сконфигурированное в условии супервизора время наблюдения 
(500 мс), система обнаруживает ошибку супервизора и шаг с ошибкой 
подсвечивается красным. Если появляется ошибка, Вы должны сначала 
удовлетворить условия следующего перехода. Используя функцию PG 
Debug > Control Sequencer [Отладка > Управление секвенсором] Вы 
можете ввести квитирование (см. также "Управление секвенсором"). 

Это не применимо к пальчиковому режиму, так как условие, разрешающее 
шаг, должно быть удовлетворено, и квитирование получено в пределах 
одного цикла. 

 



Разработка системы последовательного управления на примере сверлильного станка  

S7-GRAPH для S7-300/400 Программирование систем последовательного управления 
A5E00290656-01 3-19 

3.14 Проверка: Управление секвенсором 

Управление секвенсором это тестовая функция, с которой Вы можете 
проверить секвенсор S7-GRAPH во всех режимах. Все установки и вводы 
диалогового окна имеют тот же эффект, что и выбор соответствующих 
параметров FB.  

Вводы в диалоговом окне "Control Sequencer [Управление секвенсором]" 
могут отличаться от использованных при компиляции секвенсора установок. 
Установки диалогового окна имеют приоритет. 

Диалоговое окно "Control Sequencer [Управление секвенсором]"  
Диалоговое окно "Control Sequencer [Управление секвенсором]" используется 
как для отображения текущих установок, так и для ввода установок для 
изменения текущего состояния.  

Если Вы квитируете ошибку, инициируете секвенсор, или хотите переключить 
шаг в ручном режиме, вызовите диалоговое окно командой меню Debug > 
Control Sequencer [Отладка > Управление секвенсором]. 

Квитирование 
Если выбрана опция "Acknowledge errors [Квитирование ошибок]", Вы 
квитируете ждущее обработки сообщение об ошибке кнопкой "Acknowledge 
[Квитирование]". Этим способом, Вы можете квитировать вызванное 
нарушение, например, превышение  сконфигурированного контрольного 
времени в шаге 2.  

Однако обратите внимание, что прежде, чем Вы признаете ошибку, Вы 
должны удостовериться, что диспетчерское управление или условия 
супервизора или самоблокировки, которые вызвали ошибку, больше не 
выполняются. 

После того, как произошла ошибка, Вы можете разрешить следующий шаг в 
секвенсоре, удовлетворяя условия, разрешающие шаг, потому что условия, 
разрешающие следующий шаг, имеют приоритет над супервизором в цикле, в 
котором Вы квитируете. Однако квитирование ошибки обязательно. 

Если ошибка была вызвана потому, что время активации без нарушений 
stepname. U превысило заданное контрольное время, Вы можете 
переключить шаг секвенсора, нажав кнопку "Acknowledge [Квитирование]". 

Это возможно, потому что переменная Step name. U устанавливается в "0", 
когда Вы квитируете. 

Инициализация 
Кнопкой "Initialize [Инициализировать]" Вы можете полностью перезапустить 
секвенсор с шага, заданного начальным. 
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Установка режима 
Отметьте бокс выбора, чтобы установить нужный режим секвенсора 

Вы можете, например, запустить секвенсор в ручном режиме вместо 
автоматического. В ручном режиме, Вы можете активировать или 
деактивировать любой шаг. Следуйте за шагами, приведенными ниже: 

1. Введите номер шага, который Вы хотите обработать, в поле "Step number 
[Номер шага]" или просто щелкните на требуемом шаге. 

2. Выберите действие, которое Вы хотите выполнить с шагом: 

- Активировать Выбранный шаг активируется, даже если 
предшествующий переход не разрешен. 

- Деактивировать Выбранный шаг деактивируется. 

Заметьте, что прежде чем активировать шаг, Вы должны деактивировать 
текущий активный шаг, поскольку только один шаг может быть одновременно 
активен в линейной последовательности. Другими словами, Вы сможете 
активировать шаг только тогда, когда деактивируете текущий активный шаг. 

Когда Вы устанавливаете новый режим, исходный режим выделен жирным. 
Когда Вы управляете секвенсором в ручном режиме, Вы можете вернуться в 
автоматический, закрыв окно "Control Sequencer [Управление секвенсором]". 

3.15 Изменение секвенсора 

Часто, первоначальная программа должна изменяться и модифицироваться. 
Это применимо и к нашему примеру. Сконфигурированное контрольное 
время шага 2 слишком мало и программа зависает при этом шаге. 
Следующий раздел показывает, как сделать требуемые изменения. Они 
выполняются сначала в автономном (offline) режиме. 

Изменение контрольного времени 
Сконфигурированное контрольное время шага 2 равно 500 мс. Чтобы 
увеличить время установки переменной "Cl_press_ok", измените контрольное 
время на  5 с,  как описано ниже: 

1. Дважды щелкните на 2 для изменения вида отображения "sequencer" на 
вид "single step [отдельный шаг]". 

2. Закройте контроль состояния, выбрав команду меню Debug > Monitor 

[Отладка > Монитор] или нажав кнопку:   . 

3. Введите контрольное время 5 с. 

4. Сохраните секвенсор командой меню File > Save [Файл > Сохранить], при 
этом секвенсор будет перекомпилирован. 
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Загрузка измененного секвенсора 
Как только Вы скомпилировали секвенсор, Вы должны загрузить ее в CPU. Вы 
можете загрузить секвенсор в SIMATIC Manager или в редакторе S7-GRAPH. 
В редакторе S7-GRAPH, выполните следующее:  

1. С открытым FB, выберите команду меню PLC > Download  [PLC> 

Загрузка] или нажмите кнопку Download [Загрузка] . Появится 
диалоговое окно "Download [Загрузка]". 

2. Примите значения по умолчанию, нажимая "OK". 

3. Подтвердите перезапись существующих блоков. 

Включение экземпляра DB 
Если Вы не очистили установленное по умолчанию свойство "Include Instance 
DB [Включая экземпляр DB]", S7- GRAPH проверяет, был ли экземпляр DB, 
изменен, с момента последней загрузки и должен ли, он быть заменен. 
Разрешается выбор опции "Download with Instance DB [Загрузка с 
экземпляром DB]" в диалоговом окне "Download [Загрузка]". 

Иначе, S7- GRAPH не проверяет экземпляр DB и предоставляет Вам решить, 
надо ли загрузить образец DB снова. Опция "Download with Instance DB 
[Загрузка с экземпляром DB]" в диалоговом окне "Download" не выбирается. 

Перезапуск состояния 
Чтобы снова обеспечить способность контроля или управления секвенсором, 
перезапустите контроль состояния, выбрав команду меню Debug > Monitor  
[Отладка> Монитор] или выбрав кнопку Monitor   
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4 Работа с S7-GRAPH 

4.1 Запуск S7-GRAPH 

Требования к выполнению S7-GRAPH 
• На Вашем PC/программаторе установлен стандартный пакет STEP 7. 

• На Вашем PC/программаторе установлен S7-GRAPH. 

• Вы имеете установленную авторизацию S7-GRAPH. 

Запуск S7-GRAPH 
Имеются два способа запуска S7-GRAPH: 

• Запуск через Windows: 
Запустите S7-GRAPH через кнопку "Start" в панели задач Windows.  
S7-GRAPH находятся по пути Simatic > STEP 7 > S7-GRAPH - 
Programming Sequential Control Systems.  

• Запуск через SIMATIC Manager 
В SIMATIC Manager дважды щелкните на FB или на исходном файле 
S7-GRAPH.  
Открывается S7-GRAPH, отражающий выбранный блок в представлении, 
назначенном по умолчанию. 
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4.2  Пользовательский интерфейс S7-GRAPH  

Элементы пользовательского интерфейса S7-GRAPH  
Пользовательский интерфейс разделен на три сектора: 

• Рабочая область (2) показывает редактируемый секвенсор. Здесь Вы 
определяете структуру секвенсора или программируете отдельные 
действия и условия. 

• Обзорное окно (5) обеспечивает общий обзор системы 
последовательного управления, параметров блока и переменных, также 
как окружение функционального блока в программе S7.  

• Детальное окно (6) предоставляет специфическую информацию, 
необходимую на отдельных этапах программирования, например 
сообщения компилятора или информацию о адресации экземпляров. 

  

Этот раздел описывает элементы пользовательского интерфейса  
обозначенные на рисунке. 

(1) Панели инструментов  

(2) Рабочая область  

(3) Строка меню  

(4) Строка заголовка  

(5) Окно обзора  

(6) Детальное окно  

(7) Строка состояния  
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Панели инструментов 
Панели инструментов  содержат кнопки, которыми Вы можете запустить часто 
требующиеся и постоянно необходимые команды меню.  

Имена панелей инструментов в S7-GRAPH отображаются, когда панели 
инструментов перемещаются в пределах главного окна. 

 
Имя  Содержание  
Standard 
[Стандартная] 

Функции обработки файлов (открыть, сохранить и т.д.) и для 
редактирования (копирование, вставка и т.д.). 

View [Вид] Содержит иконки для выбора различных видов отображения 
(например, как отображать FB S7-GRAPH, отображение символьных 
имен и т.д.). 

Sequencer 
[Секвенсор] 

Содержит кнопки для редактирования секвенсора (например, 
вставка пары шаг-переход). 

LAD/FBD  Содержит кнопки для вставки элементов контактного плана или 
блочной диаграммы (например, схему сравнения). 

Рабочая область 
Рабочая область  это окно в S7-GRAPH в котором отображается и может 
редактироваться секвенсор из FB или исходного файла S7-GRAPH. 

В пределах главного окна S7-GRAPH Вы можете одновременно открыть 
несколько различных окон, расположенных каскадом, делящих окно на части 
или перекрывающихся. 

Строка меню 
Как и любое приложение Windows, S7-GRAPH имеет строку меню  
расположенную под строкой заголовка главного окна. Отображение команд 
меню зависит от контекста. Команды меню могут быть как активными 
(черными), так и пассивными (серые) в зависимости от того, может или нет 
данная команда быть применена к выбранному объекту. 

Строка заголовка 
Строка заголовка  на верхнем крае окна содержит стандартные кнопки 
Windows и следующую информацию: 

• Заголовок программного обеспечения 

• Номер открытого FB и DB или имя и номер открытого исходного файла  

• Отображаемый элемент 

• Путь блока или исходного файла  
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Обзорное окно 

Это окно по умолчанию прикрепляется к левому краю  рабочего окна. Однако 
Вы можете прикрепить и к правому, верхнему или нижнему краям окна.  

Окно содержит три закладки: 

Закладка "Graphics [Графика]"  

 

На этой закладке отображаются отдельные секвенсоры и постоянные 
инструкции в текстуальном виде. Если требуется, Вы можете добавить 
графические детали, например, структуру последовательности или 
специфические операции. 

Здесь вы можете копировать, вырезать и вставлять полные 
последовательности или их элементы. Элемент структуры секвенсора, 
выбранный на закладке "Graphics", отображается для редактирования в 
рабочем окне. 
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Закладка "Sequences [Секвенсоры]"  

 

Эта закладка показывает все секвенсоры в хорошо обозримом виде. Этот вид 
отображения особенно полезен для наблюдения состояния. 

Здесь, также, Вы можете выбрать элемент для редактирования в рабочем 
окне. Непосредственно на закладке "Sequences [Последовательности]" Вы не 
можете редактировать последовательность. 

Закладка "Variables [Переменные]" 
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Показывает объявление переменных в разделах IN, OUT, IN_OUT, STAT и 
TEMP и дополнительные программные элементы: символы из символьной 
таблицы, запрограммированные ранее блоки из папки блоков и блоки 
библиотек. Дополнительные папки отображают шаги и переходы – включение 
этих компонентов функционального блока S7-GRAPH позволяет 
использовать их в программе как адреса. 

На этой закладке Вы можете изменить набор параметров, системные 
параметры могут удаляться, но не могут редактироваться. Но это возможно 
для Ваших собственных параметров. 

Если Вы хотите использовать параметры или программные элементы в 
секвенсоре, Вы можете перетащить их из окна объявления переменных в 
секвенсор, используя мышь и располагая в требуемом месте. 

Изменения, которые Вы делаете с параметрами в окне объявления 
переменных, автоматически отслеживаются в секвенсоре, так чтобы не 
возникало противоречий. 

С использованием клавиши F1, доступна подробная помощь о объявлении 
переменных в декларационном окне. 

Для более детальной информации об объявлении переменных и 
программных элементов, справьтесь в окне "Details [Детали]" (закладка 
Variables [Переменные]). Вы можете открыть это окно командой меню View > 
Details [Вид > Детали]. 

Окно "Details [Детали]"  
Окно "Details [Детали]" показано на нижнем краю экрана и имеет следующие 
закладки: 

  

Compile/Decompile Messages [Сообщения компиляции и декомпиляции]  
Закладка используется для отображения ошибок и предупреждений, которые 
встречаются, например, при компиляции секвенсора.  

Variables [Переменные] 
Содержание этой закладки зависит от выбора, сделанного на закладке 
"Variables [Переменные]" обзорного окна. Здесь Вы можете увидеть 
подробную информацию о: 

• Переменных  

• Символах из символьной таблицы 
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• Запрограммированных блоках из папки блоков  

• Блоках из библиотек 

• Шагах и переходах FB S7-GRAPH  

На этой странице Вы можете объявить новые переменные командой меню 
Insert > Declaration Line [Вставить > Строка описания].  

Если Вы хотите использовать в секвенсоре переменную, параметр блока или 
элемент программы, Вы может использовать перетаскивание с помощью  
мыши из окна объявления переменных в секвенсор. 

Addresses [Адреса] 
Эта закладка содержит список используемых в блоке адресов, их 
расположение, символ и тип данных. При мониторинге, если установлено 
отображение "Single Step [Отдельный шаг]" или "Permanent Instructions 
[Постоянные инструкции]", закладка отображает дополнительную колонку с 
текущим состоянием адресов при выполнении программы. 

Будет или нет она показываться, зависит от настроек рабочей области. 

 
Настройки рабочей области Отображаемые адреса 
Секвенсор Адреса в программе 
Отображение отдельного шага Адреса в шаге и соответствующем переходе 
Постоянные инструкции Адреса, используемые в постоянных инструкциях 

Forward cross references [Перекрестные ссылки вперед] 
Показывают использование программой пользователя адресов в областях 
памяти Q, M, T, и C. 

Верхняя таблица перекрестных ссылок показывают все адреса, необходимые 
для текущего блока и оцениваемые в других точках программы  

Backward cross references [Обратные перекрестные ссылки]  
Нижняя таблица перекрестных ссылок показывают все адреса, необходимые 
в других точках программы  и оцениваемые в текущем блоке 
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Строка состояния 
Строка состояния  расположена на нижнем крае главного окна S7-GRAPH. 
Выбрав команду меню View > Status Bar [Вид > Строка состояния], Вы 
можете отобразить или скрыть строку состояния. 

В левой части строки состояния Вы можете увидеть информацию о 
выбранной команде меню. Правая часть строки состояния строки состояния 
содержит следующую информацию: 

Следующие символы показывают различные состояния соединения и 
рабочие состояния: 
 
Символ Отображает Описание Для 

  Offline Вы редактируете блок, хранящийся в 
PG/PC. 

S7-300 и 
S7-400 
 

 DISCONNECTED Соединение с PLC отсутствует. S7-300 и 
S7-400 
 

  CONNECTED Вы редактируете блок, находящийся в  
PLC (SIMATIC S7). 

S7-300 
 
 

 RUN/RUN-P Состояние модуля  S7-400 
 

 STOP Состояние модуля  S7-400 
 

 HALT Состояние модуля  

 FRCE Активное задание FОRCE. S7-400 

 

На цветном фоне в строке состояния показано следующее: 

 
Отображение  Цвет 
FRCE Желтый 
STOP Красный 
HALT Желтый 
Disconnected Белый 
RUN/RUN-P с "Sequence Control" и "Enable 
Monitoring" 

Бегущая зеленая полоса с 
надписью: 
• "AUTO", автоматический 

режим 
• "MAN", ручной режим  
• "TAP", для режима с 

подталкиванием  
• "TOP", для режима «автомат 

или переключение к 
следующему шагу» 
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Групповая ошибка 
Красная полоска показывает, что произошла  групповая ошибка. 

Abs/Sym [Абсолютная/символьная] 
Приоритет адресации, устанавливаемый в свойствах папки блоков.  

Приоритет адресации определяет, какие адреса, абсолютные или 
символьные, остаются в Вашей программе, если Вы внесли изменения в 
таблицу символов. 

Ins/OVR/Rd [Вставка/Перекрытие/Чтение] 
• Insert/Overwrite [Вставить/Перекрыть] 

Режим ввода при редактировании 

• Read 
Блок или исходный файл доступен только для чтения. 

Chg/Chg. Interface [Изменение/Изменение интерфейса] 
Показывает, что блок был изменен, и был ли изменен интерфейс. 

4.3 Настройки рабочей области 

S7-GRAPH предоставляет различные режимы отображения и настройки 
рабочей области и пользовательского интерфейса. Некоторые из этих 
установок сохраняются с блоком, который Вы редактируете.  

S7-GRAPH предоставляет Вам различные уровни отображения, которые Вы 
можете выбрать в меню View [Вид]: 

• Sequencer [Секвенсор] 

• Single-Step Display [Отображение отдельного шага] 

• Permanent Instructions [Постоянные инструкции] 

Секвенсор  

 
В представлении "Sequencer [Секвенсор]", отображается один из 
секвенсоров, содержащихся в FB. Если имеется несколько секвенсоров, Вы 
можете переключиться от одного к другому, выбрав закладку "Graphic 
[Графика]" в окне обзора.  

Этот уровень отображения может использоваться для конфигурирования 
секвенсора. На этом уровне Вы можете задать структуру секвенсора и 
выбрать номера, имена и комментарии для шагов и переходов. 

Вы можете вызвать команду меню View > Display With > Conditions and 
Actions [Вид > Показывать > Условия и действия] для отображения 
содержания сконфигурированных шагов и переходов. 
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Отображаются следующие элементы: 

• Комментарий блока 

• Расположение шагов, переходов, ветвей 

• Вы можете отобразить дополнительно содержание шагов и переходов 

• В зависимости от масштаба, отображаются имена шагов и переходов  

Отображение отдельного шага 

 
Уровень отображения одного шага всегда показывает только одну пару шаг-
переход. На этом уровне отображения могут программироваться все детали, 
а именно:  

• Действие: Действие выполняемое в пределах шага 

• Супервизор: Условия контроля отображаемого шага 

• Блокировка: Условия блокировки отображаемого  

• Переход: Условия для переключения с текущего шага к следующему 

• Комментарий шага 

• Номера и имена отображаемой пары шаг-переход  

• Расширение имени 

• Список символьных адресов 

 
 Замечание 

Вы может использовать команду меню Edit > Go To [Редактировать > 
Перейти] для отображения другого шага без переключения к другому виду 
отображения. 

Используйте клавиши курсора для перехода к следующему или предыдущему 
шагу. 

Постоянные инструкции 

 
При уровне отображения постоянных инструкций , Вы можете 
запрограммировать следующее:  

• Постоянные инструкции, предшествующие секвенсору  

• Постоянные инструкции, следующие за секвенсором 
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Установка уровня отображения 
Для установки уровня отображения: 

1. Откройте меню View [Вид]. 

2. Выберите уровень отображения, соответствующий текущим задачам: 

• Sequencer [Секвенсор] для создания структуры  

• Single step [Отдельный шаг ] для программирования отдельных шагов и 
переходов. 

• Permanent instructions [Постоянные инструкции] для 
программирования постоянных условий и постоянного вызова блоков  

Уровень отображения по умолчанию 
FB S7-GRAPH всегда открывается с уровнем отображения, назначенным по 
умолчанию. Вы выбираете настройки по умолчанию командой меню Options 
> Application Settings [Возможности > Настройки приложения] на 
закладке "General [Общее]". 

В разделе "New Window [Новое окно]" выберите уровень отображения, в 
котором Вы хотите открывать FB S7-GRAPH.  

4.4 Настройки уровня отображения, цветов и шрифтов 

Настройки уровня отображения  
Вы можете приспособить уровень отображения, назначенный по умолчанию, 
к Вашим потребностям. S7-GRAPH предусматривает следующие 
возможности: 

• Увеличение и уменьшение  

• Масштаб текущего отображения 

• Функция петли для масштабирования  

• Кнопки для работы с окнами 

• Отображение и срытие выбранных областей  

• Установки отображения по умолчанию для конкретных областей  

Изменение масштаба  
Выберите команды меню View > Zoom In [Вид > Увеличить] или Zoom Out 
[Уменьшить] для изменения размера отображения. 
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Выбор масштаба текущего отображения 
Вы можете приспособить размер текущего отображения в соответствии с 
содержанием, выбрав команду меню View > Zoom Factor [Вид > 
Масштабный коэффициент]..  

Если Вы выбрали масштаб отображения таким, что размер текста слишком 
мал для разборчивого чтения, имена шагов и переходов более не 
отображаются и выводятся только номера шагов и переходов. Тем не менее 
Вы имеете возможность отобразить имена шагов и переходов, наведя на шаг 
или переход курсор мыши.  

Если Вы хотите избежать этого, Вы можете установить минимальный 
масштаб для различных видов так, чтобы надписи оставались читаемыми. 

Вы также можете в любой момент вернуть предыдущий масштаб.  

Функция лассо для масштабирования 
Для увеличения размера заданной области. Вы можете также использовать 
функцию лассо. Выберите команду меню View > Enlarge Active Area [Вид > 
Расширить активную область]. Затем выделите мышью прямоугольную 
область, которую Вы хотите увеличить. Теперь в рабочей области S7-GRAPH 
будет показана только выделенная область. 

Кнопки для работы с окнами 
S7-GRAPH предоставляет Вам кнопки для отображения и скрытия окон 
"Details [Детали]" и "Overview [Обзор]". Это позволяет Вам настроить рабочий 
стол в соответствии с Вашими требованиями.  

Отображение скрытых областей 
Независимо от отображения отдельных шагов и переходов, S7-GRAPH 
предусматривает дальнейшие возможности настройки рабочего 
пространства. Выберите требуемые команды в меню View [Вид]:  

• Для отображения поля комментария: View > Display With > Comments 
[Вид > Показывать > Комментарии] 

• Для отображения адресов в символьном представлении: View > Display 
With > Symbols [Вид > Показывать > Символы] 

• Для отображения условий и действий: View > Display With > Conditions 
and Actions [Вид > Показывать > Условия и действия] 

• Для отображения списка символов для выбора адресов при 
редактировании действий: View > Display With > Symbol List [Вид > 
Показывать > Список символов] 

Отображение по умолчанию дополнительных элементов 
Когда блок открывается, как часть установок по умолчанию, могут быть 
показаны дополнительные элементы. Вы выбираете установки по умолчанию 
командой меню Options > Application Settings [Возможности > Установки 
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приложения] на закладке "General". Выберите варианты отображения, 
которые будут действовать по умолчанию: 

• Для отображения комментария блока или комментариев шагов: "Display 
With: Comments [Показывать: Комментарии]". 

• Для отображения адресов в символьном представлении: "Display With: 
Symbols [Показывать: Символы]". 

• Вы можете отображать условия и действия командой View > Display With 
> Conditions and Actions [Вид > Отображать > Условия и действия]. 

 Настройка цветов и шрифтов 
Graph 7 позволяет Вам также настроить отображение отдельных элементов. 
К ним относятся установки цветов, шрифтов линий и адресов LAD/FBD. 

Изменение настроек 
Вы можете сделать все требуемые настройки на закладке "Editor [Редактор]". 
Вы можете отобразить эту закладку  командой меню Options > Application 
Settings [Возможности > Настройки приложения]. Когда Вы закрываете 
редактор (когда Вы покидаете функцию настройки), любые сделанные Вами 
изменения сохраняются. 

Цвет 
Вы можете выбрать цвета следующих элементов: 
 
Элемент Режим проектирования Режим мониторинга 
Выбранный элемент  Выбранный элемент   
Шаг активен/переход 
пригоден 

 Элементы 

Шаг не активен  Не активный шаг 

Ошибка Ошибка ввода оператора Шаг с ошибкой 
Выполняется LAD/FBD   Выполнение условий в 

переходе, супервизоре, 
блокировке и постоянных 
инструкциях  

Не выполняется LAD/FBD   Не выполнение условий в 
переходе, супервизоре, 
блокировке и постоянных 
инструкциях  

LAD/FBD не 
обрабатывается  

 Не вычисляющиеся 
переходы, супервизоры или 
блокировки 

Точка синхронизации  Точки синхронизации  

Шрифт 
Вы можете изменить шрифт следующих элементов: 
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Область Разъяснение 
Номер шага/перехода Номера шагов/переходов 
Имя шагов/переходов  Имя шагов/переходов 
LAD/FBD Адреса LAD/FBD  
Расширенное имя Заголовок таблицы действий 
Действия Содержание таблицы действий 
Комментарии Содержание полей комментариев 

Линии 
Вы можете изменить стиль линии (толщину) для следующих типов линий: 
 
Стиль линии Разъяснение 
Нормальный Применимо ко всем линиям секвенсора  
Чувствительный Линия, к которой может быть добавлен текущий 

выделенный элемент Graph. 

Адресация в LAD и строках действий 
Вы можете задать максимальное число символов, применимых для адресов 
LAD/FBD или в строке действий. Вы можете ограничить адрес одной строкой 
в программном представлении.  

Совет: Если адреса в LAD/FBD или в строке действий не могут быть 
показаны полностью в отдельных представлениях, Вы можете отобразить 
полное имя как всплывающую подсказку, наведя курсор мыши на 
соответствующий адрес или действие. 

Вы можете также определить, должны ли выравниваться адреса LAD/FBD 
вправо или влево. 

4.5 Инструменты редактирования секвенсора  

4.5.1 Отображение и расположение панели инструментов  

Отображение и скрытие панели инструментов  
Выберите команду меню View > Toolbars [Вид > Панели инструментов]. В 
открывшемся диалоговом окне, Вы можете отметить, какие панели 
инструментов Вы хотите отобразить. 

Размещение панелей инструментов  
Панели инструментов могут быть расположены в любом месте в пределах 
главного окна S7-GRAPH. Вы перетаскиваете панели в нужное место. 

1. Щелкните на серой области в панели инструментов, в которой 
расположены кнопки и удерживайте нажатой кнопку мыши.  
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2. Перетащите панель инструментов мышью в требуемую позицию экрана. 

Отображение кнопок и панелей инструментов 
Отображение кнопок и панелей инструментов зависит от контекста. При этом: 

• Разрешенные черным. 

• Запрещенные кнопки показаны серым. 

4.5.2 Редактирование секвенсора с панелью инструментов  

Insert > Drag-and-Drop [Вставить > Перетаскивание] или Insert > Direct 
[Вставить > Прямой]. 

• В режиме редактирования "Drag and Drop [Перетаскивание]" Вы 
перетаскиваете иконку из панели инструментов в требуемую позицию. 

• При прямом способе Вы размещаете изображение в выбранной точке. 

Режим редактирования "Drag and Drop [Перетаскивание]"  
Когда Вы работаете в режиме редактирования "Drag and Drop 
[Перетаскивание]", Вы добавляете изображения следующим образом: 

1. Щелкните в панели инструментов на иконке или выберите элемент через 
команду меню Insert [Вставить]. 

Результат: Указатель курсора мыши принимает вид соответствующей 
иконки. 

2. Теперь щелкните на позиции, в которую Вы хотите вставить элемент. Если 
курсор мыши принимает вид знака "запрета" (окружность с наклонной 
чертой), значит элемент нельзя вставить в данную точку. Каждый щелчок 
вставляет следующий элемент.  

3. После того как Вы вставите все требующиеся элементы, щелкните снова в 
панели инструментов или выберите снова команду меню Insert [Вставить] 
для завершения действия. 

Режим редактирования "Direct [Непосредственный]" 
Если Вы находитесь в  режиме редактирования "Direct [Непосредственный]", 
Вы вставляете изображения следующим образом: 

1. Выделите элемент, после которого Вы хотите вставить новый элемент. 

2. Щелкните в панели инструментов или выберите элемент в меню Insert 
[Вставить].  

3. Чтобы добавить еще элементы в ту же позицию, снова щелкните на кнопке 
или выберите элемент в меню Insert [Вставить].  
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4.5.3 Навигация в секвенсоре 

Чтобы обеспечить навигацию в секвенсоре, Вы можете использовать не 
только клавиши курсора, но и функцию меню Edit > Go To [Редактировать > 
Перейти]. Эта функция облегчает управление в больших секвенсорах и в 
процессе отладки. 

Отображение заданного шага или перехода  
Командой меню Edit > Go To > Step / Transition [Редактировать > Перейти 
> Шаг/Переход], Вы можете перейти к заданной паре шаг-переход. Вы 
можете задать как номер, так и имя. 

Поиск использований адреса  
Вы имеете различные возможности отображения программных реализаций 
выбранных адресов: 

• Функция Go To > Instance [Перейти > Использования] отображает в 
таблице все использования выбранного адреса во всей программе S7. 
Таблица содержит следующую информацию: 

- Block: Показывает блок, в котором используется адрес  

- Type: Индикатор доступа для чтения (R) и/или записи (W). 

- Language/details: Информация на определенном языке  

• После двойного щелчка на глобальном адресе, программа S7 формирует 
поиск других использований «противоположных» включений адресов, то 
есть, если адрес для чтения, ищутся места для записи, и наоборот.  

• Команда меню Go To > Previous local instance / Next local instance 
[Перейти > Предыдущее локальное использование / Следующее 
локальное использование] показывает все включения локального 
адреса в блок S7-GRAPH. 

Отображение следующей или предыдущей ошибки 
Если показано окно сообщений об ошибках компиляции, вызовите команду 
меню Edit > Go To > Next Error [Редактировать > Перейти > Следующая 
ошибка] и Edit > Go To > Previous Error [Редактировать > Перейти > 
Предыдущая ошибка] для перехода к месту ошибки. При этом S7-GRAPH 
переключается к месту ошибки в секвенсоре и показывает сообщение об 
ошибке в строке состояния. 



 

S7-GRAPH для S7-300/400 Программирование систем последовательного управления 
A5E00290656-01 5-1 

5 Создание проекта 

Эта глава разъясняет, как создать и открыть Ваш проект. Глава также 
разъясняет критерии выбора работы с FB или исходным файлом в 
S7-GRAPH. 

Шаги в создании проекта 
Вся информация о системе последовательного управления хранится в 
проекте STEP 7.  

 

5.1 Создание проекта в SIMATIC Manager 

До создания секвенсора в S7-GRAPH Вы должны создать проект  и 
программу S7 в этом проекте. Все блоки последовательного управления 
будут храниться в этой папке. 

Создание нового проекта  
Для создания нового проекта в SIMATIC Manager выберите команду меню File 
> New [Файл > Новый]. Начиная с версии V4x, STEP 7 предусматривает 
различные виды мастеров, которые помогают Вам в создании целой 
структуры проекта. Выберите метод, которым Вы предпочитаете создавать 
проект. 

Вставка программы S7 в проект 
Создайте программу S7 в SIMATIC Manager, используя команду меню Insert > 
Program > S7 Program [Вставить > Программа > Программа S7]. Система 
автоматически генерирует иерархию папок для исходных файлов, блоков и 
символьной таблицы. В папке блоков создается пустой OB1. 

Создание проекта в SIMATIC Manager и 
вставка Вашей программы S7 

Открыть блок для программирования секвенсора) 

Создание исходного файла S7 
Graph   

Создание FB S7 Graph 
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5.2 Функциональный блок или исходный файл 
S7-GRAPH? 

До начала создания секвенсора, Вы должны решить, какой тип блока Вы 
хотите программировать. Вы может создать секвенсор как FB или как 
исходный файл S7-GRAPH.  

Различия между FB и исходным файлом S7-GRAPH  
Когда Вы сохраняете FB, S7-GRAPH выполняет и подразумевающуюся 
компиляцию блока, то есть проверку синтаксиса создаваемого Вами 
секвенсора. Сохраненным и загруженным в CPU могут быть только FB 
S7-GRAPH, не имеющие ошибок. Невозможно закрыть FB, содержащий 
ошибки. 

Если Вы не можете отладить программу немедленно, Вы можете сохранить 
FB S7-GRAPH как исходный файл, или Вы можете с самого начала создать  
исходный файл  S7-GRAPH вместо FB S7-GRAPH. В отличие от FB 
S7-GRAPH, Вы можете в любой момент сохранить исходный файл 
S7-GRAPH, содержащий ошибки. 

 Замечание 
Если Вы считаете, что не сможете запрограммировать секвенсор за один 
прием, сначала сохраните данные в исходном файле S7-GRAPH или начните 
с создания исходного файла S7-GRAPH. 

5.3 Функциональный блок S7-GRAPH  

Вы можете создать FB S7-GRAPH  как в SIMATIC Manager, так и 
непосредственно в S7-GRAPH, следующим образом: 

• В S7-GRAPH выберите команду меню  File > New [Файл > Новый], чтобы 
создать новый функциональный блок на языке S7-GRAPH. 

• В SIMATIC Manager выберите команду меню Insert > S7 Block > Function 
Block [Вставить > Блок S7 > Функциональный блок], чтобы создать 
новый функциональный блок. При этом Вы должны выбрать язык 
S7-GRAPH. 

Правила создания FB S7-GRAPH  
FB S7-GRAPH хранится в папке блоков. Применимы следующие правила:  

• Вы можете программировать секвенсор с абсолютными и символьными 
адресами. 

• FB отображается в зависимости от места хранения: 

- автономно (оffline): Отображается FB, хранящийся на Вашем 
программаторе, включая символы и комментарии. 

- интерактивно (online): Отображается FB из CPU, включая символы и 
комментарии, хранящиеся на программаторе (если он существует). 
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- интерактивно (online) без структуры проекта: Отображается FB из 
CPU, (представление "Accessible Nodes [Доступные узлы]" в 
диалоговом окне "Open") подобно FB STEP 7, другими словами,  без 
символов и комментариев. 

5.4 Исходный файл S7-GRAPH  

Вы можете создать исходные файлы как в SIMATIC Manager, так и в 
S7-GRAPH или других редакторах с последующим импортом в проект S7. 
Запомните описание синтаксиса. 

Правила создания и вызова исходного файла S7-GRAPH 
Исходный файл S7-GRAPH хранится в папке "Sources". Применимы 
следующие правила:  

1. Пустой исходный файл S7-GRAPH можно создать в SIMATIC Manager или 
импортировать в открытый проект.  

2. Исходный файл S7-GRAPH  можно также сгенерировать из открытого FB 
S7-GRAPH. 

3. Существующий исходный файл S7-GRAPH можно открыть как в SIMATIC 
Manager так и в редакторе S7-GRAPH. При этом он отображается в 
редакторе S7-GRAPH и может быть отредактирован. 

4. Исходный файл проекта можно редактировать только автономно (offline). 

5.5 Открытие FB или исходного файла S7-GRAPH  

Вы можете открыть FB или исходный файл S7-GRAPH, как в 
SIMATIC Manager, так и в S7-GRAPH.  

 
 Замечание 

Новый FB, создаваемый в S7-GRAPH, открывается непосредственно. 

Открытие в SIMATIC Manager 
В SIMATIC Manager выполните следующее: 

• Выберите требуемый объект в папке блоков или исходных файлов и 
дважды щелкните на нем, чтобы его открыть. 

Открытие в редакторе S7-GRAPH  
В редакторе S7-GRAPH выполните следующее: 

1. Выберите команду меню File > Open [Файл > Открыть] или щелкните на 
соответствующей кнопке. 
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2. В открывшемся диалоговом окне выберите блок или исходный файл, 
который Вы хотите открыть. Решите, хотите ли Вы открыть блок автономно 
(offline) из памяти программатора или непосредственно из  CPU (online). 
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6 Программирование структуры 
секвенсора 

Следующий раздел разъясняет правила и элементы для создания 
секвенсора.  

 

Основа системы последовательного управления заключена в FB S7-GRAPH 
(1). Он содержит:  

• Программу для пошагового выполнения управления секвенсорами (4). 

• Постоянные инструкции (3)(5), которые имеют значение для всех 
секвенсоров FB (и отображаются в отдельном окне) 

• Комментарий (2), в котором Вы описываете блок в целом. 

Как работать с FB S7-GRAPH  
Порядок, в котором Вы выполняете проектирование, не имеет 
принципиального значения. Приведенный ниже порядок, является примерной 
рекомендацией. 
 
Шаг Задача 
1 Определить структуру секвенсора из элементов S7-GRAPH  
2 Запрограммировать постоянные инструкции (не обязательно) 
3 Добавить комментарий к FB S7-GRAPH в поле для комментария к блоку (не 

обязательно) 
4 Редактировать, по одному, шаги и переходы, созданные в п. 1 
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6.1 Секвенсор - Принципы 

Секвенсор содержит ряд шагов и переходов, которые активируются в 
определенном порядке в зависимости от условий, разрешающих шаг.  

Как выполняется секвенсор   
 

Секвенсор всегда выполняется начиная с 
• с начального шага 
• нескольких начальных шагов, расположенных в некоторых точках секвенсора  
Пока действия шага выполняются, он активен. Если различные шаги выполняются 
одновременно, все они – активные шаги. 

  
Активный шаг покидается когда 
• устранены или подтверждены любые активные нарушения  
• и разрешен переход к следующему шагу 

 
Шаг, следующий за разрешенным переходом, становится активным. 
 

Завершение секвенсора это 
• скачок к любому шагу в данном секвенсоре или к другому секвенсору в этом FB. 

Это обеспечивает циклическую работу секвенсора. 
• Конец ветви. Последовательность шагов останавливается, если достигнут останов ветви. 

Шаг 
Задача управления разбивается на отдельные шаги. Действия, которые 
формулируются для шагов, выполняются Действия, сформулированные в 
шагах выполняются контроллером в определенном состоянии (например, 
управления выходами или активации и деактивации шагов). 

Активный шаг 
Активный шаг, это шаг действия которого выполняются в данное время.  

Шаг активируется в следующих случаях:  

• Условия предыдущего переходы выполняются или  

• Шаг определен как начальный и секвенсор инициализируется или 

• Когда он вызывается действиями, зависящими от событий. 
 

 Замечание 
Избегайте использовать скачок от перехода к непосредственно 
предшествующему шагу. 

Чтобы сделать команду скачка возможной, вставьте пустой  шаг и переход 
без условий. 
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6.2 Структуры секвенсора 

Простейшая структура секвенсора  - линейная последовательность шагов и 
переходов без ветвления.  

Линейный секвенсор начинается с шага и завершается переходом, который 
может быть дополнен скачком к другому шагу или окончанием ветви. 

Линейный секвенсор может быть расширен различными способами: 

• Ветвление (альтернативное, параллельное), 

• Скачок к любому шагу, 

• Функционирование других секвенсоров, или зависит от первого, или 
полностью независимо. 

• Постоянные инструкции расположенные до или после секвенсора.  

Примеры структур секвенсора 
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(1) S7 Graph FB с линейным секвенсором 
(2) S7 Graph FB с секвенсором с альтернативными и параллельными ветвями
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(3) S7 Graph FB с двумя секвенсорами 
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6.3 Правила для структуры секвенсора 

 Структура секвенсора должна удовлетворять следующим правилам:  

• FB S7-GRAPH может содержать до 250 шагов или 250 переходов. Шаги и 
переходы вставляются только парами. 

• Когда вызывается FB S7-GRAPH, секвенсор стартует 

- с первого шага секвенсора или  

- с начального шага.  

• Секвенсор может содержать максимум 256 ветвей, в том числе  

- до 125 альтернативных ветвей или 

- до 249 параллельных ветвей. 

Практически нецелесообразно создавать более чем 20 - 30 ветвей (в 
зависимости от CPU) поскольку это влияет на время выполнения 
программы. 

• Ветка может быть замкнута только на ветку, которая расположена слева 
от замыкаемой ветви. 

• Скачки могут быть установлены после перехода в конце ветви. Они ведут 
к соединению с предыдущим шагом в той же последовательности или в 
другой последовательности в том же FB. 

• Останов секвенсора может быть добавлен после перехода в конце ветви 
в конце ветви и запрещает выполнение этой ветви. 

• Постоянные инструкции могут быть определены до или после секвенсора 
в специальных полях. Они вызываются однократно в каждом цикле. 

6.4 Элементы секвенсора 

Следующий список показывает элементы, которые можно использовать в 
секвенсоре и соответствующие им кнопки в панели инструментов "Sequencer 
[Секвенсор]",  с помощью которых можно создать эти элементы: 

 Шаг + Переход 

 Скачок  

 Открыть альтернативную ветвь  

 Закрыть альтернативную ветвь  

 Открыть параллельную ветвь  

 Закрыть параллельную ветвь Simultaneous Branch  

 Конец ветви  

 Вставить секвенсор  

Программировать структуру секвенсора следует на уровне отображения 
"Секвенсор" . 
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6.5 Пара шаг/переход и начальный шаг  

 Пара шаг/переход  
По умолчанию, FB S7-GRAPH всегда содержит одну пару шаг/переход к 
которой Вы можете добавить дополнительные пары. 

Шаги и переходы вставляются в секвенсор только парно. 

Когда Вы вставляете шаги и переходы им автоматически присваивается 
номер. Для лучшего обзора Вы можете позднее перенумеровать шаги и 
переходы позже в пределах определенного диапазона, чтобы нумерация 
была последовательной. 

Начальный шаг  
Начальный шаг это шаг секвенсора, который становится активным без 
предварительного опроса условий, когда FB S7-GRAPH запускается в первый 
раз. Начальный шаг не обязательно первый шаг секвенсора. 

Когда секвенсор выполняется циклически, этот шаг, как и любой другой шаг, 
становится активным, только когда выполняются условия предшествующего 
перехода. 

При значении параметра FB INIT_SQ = 1 секвенсор может быть 
инициализирован. Другими словами, секвенсор запускается с начального 
шага. 
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6.6 Скачок 

Скачок  это переход к другому шагу в данном или другом секвенсоре в 
пределах одного FB. 

Скачок всегда следует за переходом и закрывает секвенсор или путь ветви к 
данной точке. 

В отличие от окончания ветви, скачок обеспечивает повторение выполнения 
секвенсора или его части. 

Скачок (1) и точка его назначения (2) графически отображаются как стрелка, 
но само соединение не изображается. 

 

 
 Предупреждение 

Скачок к параллельной ветви не допускается. 
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6.7 Альтернативное ветвление  

Альтернативное ветвление состоит из двух или более параллельных 
подветвей (максимум 125). Каждая частная альтернативная ветвь начинается 
с перехода. Выполняется только та ветвь переход которой включается 
первым. Альтернативная ветвь соответствует, таким образом, логике ИЛИ, в 
которой активен только один путь. 

Каждая частная альтернативная ветвь заканчивается переходом и может 
быть завершена окончанием ветви или скачком. 

 

Приоритеты в альтернативном ветвлении 
Если несколько переходов в начале альтернативных ветвей одновременно 
открыты, крайний левый из открытых переходов имеет приоритет. 
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6.8 Параллельное ветвление 

Параллельное ветвление содержит более одной параллельной ветви 
(максимум of 249) каждая из которых начинается с шага. Ветви выполняются 
одновременно. Параллельное ветвление соответствует обработке ветвей по 
логике И. 

Переход перед параллельным ветвлением (на рисунке T1 и T7) активирует 
первый шаг во всех отдельных параллельных ветвях.  

Каждый путь в параллельном ветвлении заканчивается шагом, который 
подключен к общему финальному переходу. 

Этот финальный переход разрешает следующий шаг, только когда все 
активные параллельные ветви выполнены, то есть активны последние шаги 
во всех параллельных ветвях. 

 

1 2 3

➀ : Параллельная подветвь 1
➁ : Параллельная подветвь

 

2
➂ : Параллельная подветвь 3   
с другими параллельными ветвями
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6.9 Конец ветви 

Конец ветви в конце линейного секвенсора (1) или в конце альтернативной 
ветви (2) завершает секвенсор. Секвенсор не выполняется циклически. 

Конец ветви в конце параллельной ветви (3) заканчивает только один путь 
параллельного ветвления. Выполнение других путей параллельного 
ветвления продолжается. 

Конец ветви всегда следует за переходом. 

 

 
 Предупреждение 

Если все пути секвенсора завершаются концом ветви, секвенсор может быть 
перезапущен только с использованием параметра  INIT_SQ. 

 

6.10 Новый секвенсор 

FB S7-GRAPH может содержать несколько секвенсоров. 

Каждый секвенсор может  

1. выполняться независимо от других секвенсоров, одновременно с ними.  

2. использовать скачки для продолжения для продолжения или соединения 
ветвей в различных секвенсорах. Это позволяет Вам представить 
технически сложные функции в одном блоке, обеспечивая ясную структуру 
программы.  

В каждом секвенсоре, начальный шаг это первый активный шаг. 
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6.11 Постоянные инструкции 

Постоянные инструкции  это условия (1) и вызовы блоков (2) расположенные 
до или после секвенсора. Они выполняются однократно в каждом цикле 
независимо от состояния секвенсора.  

Вы можете запрограммировать любое количество постоянных инструкций в 
FB S7-GRAPH. Каждая постоянная инструкция имеет номер. 

Постоянные инструкции программируются в представлении "permanent 
instructions [постоянные инструкции]". 

 

Постоянные условия 
Условия, которые должны выполнять в более чем одной точке секвенсора 
могут быть запрограммированы централизованно однократно, как постоянные 
условия. Вы можете использовать элементы контактной схемы: нормально 
разомкнутые или замкнутые контакты, компараторы или элементы FBD: AND, 
OR, компараторы. В постоянном условии можно использовать до 32 
элементов LAD  или FBD. 

Результат вычисления условий сохраняется элементом «катушка» в LAD или 
присвоение в FBD, с возможностью использования триггерных функций (set и 
reset). Используемый адрес (например, меркер) можно опрашивать в 
переходах, блокировках и супервизорах. 
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Постоянные вызовы блока 
Блоки, созданные на отличных от S7-GRAPH языках программирования,  
могут быть вызваны с использованием постоянных инструкций или действий 
в FB S7-GRAPH. После того, как вызванный блок будет выполнен, 
продолжается выполнение FB S7-GRAPH. 

При использовании  вызова блоков, помните следующие моменты: 

• Вы можете вызывать следующие блоки: 

- Функции (FC) и функциональные блоки (FB) запрограммированные на  
STL, LAD, FBD или SCL и 

- Системные функции (SFC) и системные функциональные блоки (SFB). 

• Функциональным и системным функциональным блокам должны быть 
назначены при вызове экземплярные DB. 

• Блоки должны уже существовать в папке "Blocks [Блоки]" программы S7 к 
моменту использования их вызова. 

• Имена блоков можно использовать в абсолютном виде (например, FC1) 
или, если они объявлены в символьной таблице, символьно (например, 
Motor 1).· 

• При вызове блоков, Вы должны обеспечить формальные параметры 
вызываемого блока действительными значениями. 

6.12 Комментарий блока 

Каждый FB S7-GRAPH может содержать комментарий блока. Комментарий 
блока может содержать до 2048 символов. Он не влияет на выполнение 
программы. 

Комментарий блока отображается только при уровене предсталения 
"Sequencer [Секвенсор]". 

Ввод комментария блока  
Вы можете ввести комментарий блока если выбрана команда меню View > 
Display with > Comment [Показывать > Комментарий] (стоит отметка). 

1. Выберите уровень отображения "Sequencer [Секвенсор]". 

2. Введите комментарий блока непосредственно в текстовом поле, 
расположенном выше секвенсора. 
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7 Программирование условий и действий 
Этот раздел описывает, как наполнить содержанием структуру секвенсора. 
Вы можете ознакомиться с:  

• Действиями, их категориями и компонентами, а также как связать их с 
событиями  

• Условиями, где они применяются и как их компилировать. 

• Пути выхода из шага, когда возникает ошибка супервизора. 

• Использованием символьного программирования в S7-GRAPH. 

Открытие блоков соответствующим редактором: 
Блок, используемый в таблице действий шага, открывается в 
соответствующем редакторе при выборе и двойном щелчке на нем. Также 
возможно открыть блок в соответствующем редакторе выделением блока в 
таблице действий и выбором команды меню Edit > Open Block 
[Редактировать > Открыть блок]. 

Области для условий и действий 
При отображении на уровне отдельного шага отображаются почти все 
области в которых программируются действия и условия. 

 

T2

T1

S2

S1

Comment for ... 
FB i

Interlock 

Supervision 

S1
Step1

Step1

Step comment 

V

C

T1 
Trans1

Address Symbol Type Comment 

(1) 

(6)

(7)

(8)

(2) 

(3) 

(4) 

(5) 

(1)   Поле для комментария шага
(2)   Область для условий блокировки
(3)   Область для условий супервизора 
(4)   Символ для шага

(5)   Область для условий перехода
(6)   Пустая таблица действий
(7)   Символ для перехода 
(8)   Таблица символов для символьного  
программирования
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Шаги редактирования пары шаг/переход 
Как только Вы определили структуру секвенсора в FB S7-GRAPH, Вы можете 
начать программировать отдельные шаги и переходы.  

Порядок, в котором Вы работаете, не имеет большого значения. Порядок 
шагов, приведенный ниже, является только рекомендацией. 

 
Шаг Задача 
1 Программирование действий в таблице действий 
 2 Программирование условий в переходах, блокировках, супервизоре и 

постоянных инструкциях   
 3 Редактирование номеров и имен шагов и переходов или ввод 

комментариев к шагам 
 4 Редактирование раздела символьной таблицы STEP 7 для этого шага 
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7.1 Действия 

В шагах Вы программируете действия, которые, например, управляют 
входами, выходами и меркерами, активируют и деактивируют шаги 
секвенсора или вызывают блоки. Следовательно, действия содержат 
команды управления процессом. Эти действия выполняются в порядке 
“сверху - вниз”, если шаг активен. 

Вы можете содержание шага в таблице действий при уровне отображения 
“отдельный шаг". Вы можете также выбрать уровень отображения "секвенсор" 
и отобразить действия командой меню View > Display With > Conditions and 
Actions [Вид > Показывать с > Условия и действия]. 

Компоненты действий  
Действия состоят из:  

(1): Не обязательного события (например, S1) и команды (например, N) and  

(2): Адреса (например, M4.3) или присвоения (например A:=B+C). 

 

Категории действий 
Действия можно разделить на следующие категории: 

• Стандартные действия  

- С блокировкой и без 

• Действия, зависящие от событий 

- С блокировкой и без 

- Для активации и деактивации шагов 

• Счетчики, таймеры и арифметика в действиях 

Пустые шаги (Шаги без действий) 
Шаги, которые не содержат запрограммированных действий – пустые шаги . 
Пустые шаги обрабатываются аналогично активным. Последующий переход 
становится доступным. 

N

S1 N

M 4.2

M 4.3

S4

S0 R Q 4.4

Шаг активен

Порядок
выполнения

Step4
Step4

1 2
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7.2 Стандартные действия  

Стандартные действия с блокировкой и без 
Все стандартные действия могут комбинироваться с условием блокировки. 
Такие действия выполняются только тогда, когда разрешены условиями 
блокировки (добавляется символ C). 

Стандартные действия без блокировки выполняются, пока активен шаг. 

 
Команды 
 

Идентифика-
тор адреса 

Расположе-
ние адреса  

Значение: 
 

N[C] Q,I,M,D m.n На время, пока шаг активен [и разрешает 
блокировка], адрес установлен в 1.  

S[C] Q,I,M,D m.n Установка: Когда шаг активен [и разрешает 
блокировка], адрес устанавливается в 1 и 
остается установленным в 1 (фиксация) 

R[C] Q,I,M,D m.n Сброс: Когда шаг активен [и разрешает 
блокировка], адрес сбрасывается в 0 и 
остается сброшенным в 0 (фиксация) 

D[C] Q,I,M,D m.n Задержка включения: Через n секунд после 
активации, адрес получает сигнал 1 [если 
разрешает блокировка], пока шаг активен.  
Команда не выполняется, если шаг активен 
меньше времени, чем заданные n секунд 
(не фиксируется). 

 T#<const>  Константа времени  

L[C] Q,I,M,D m.n Ограниченный импульс: Если шаг активен 
[и разрешает блокировка], адрес устанавли-
вается в 1 на n секунд (без фиксации). 

 T#<const>  Константа времени  

CALL[C] FB, FC, SFB,  
SFC 

Номер 
блока 

Вызов блока: Пока шаг активен [и разреша-
ет блокировка], вызывается заданный блок. 

 

[ ] = необязательное добавление для блокировки; m = адрес байта; n = адрес 
бита; диапазон адресов: от 0.0 до 65535.7 

Адрес D: DBi.DBXm.n = блок данных номер i; DBXm.n = бит в DB;  

SFB/FB = Системный функциональный блок/функциональный блок; SFC/FC = 
Системная функция/функция 

Для CALL[C] FB/SFB, требуется экземплярный DB. 

 
 Заметьте 

Вы можете открыть вызываемый блок или его экземплярный DB, используя 
по щелчку правой кнопкой мыши команду Open Block [Открыть блок] или 
дважды щелкнув на блоке.  
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Константа времени 
Все действия, содержащие инструкции D или L требуют задания времени. 
Время программируется как константа с синтаксисом T#<const> и может 
быть скомбинировано как требуется. 

<const>= nD (n суток), nH (n часов), nM (n минут), nS (n секунд), nMS (n 
миллисекунд), где n = a - число (целое) 

Пример: T#2D3H: константа времени = 2 суток и 3 часа 

Пример: Таблица действий со стандартными действиями 

 

(1): Пока шаг активен выход Q1.0 установлен в 1. 

(2): Через 1 минуту и 20 секунд после активации шага и в случае, если шаг 
еще остается активным выходной сигнал Q1.1 устанавливается в 1. Если шаг 
более не активен, сигнал Q1.1 равен 0. 
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7.3 Действия, зависящие от событий  

События{XE “События”} 
Действия могут быть логически скомбинированы с событиями. Событие это 
изменение состояния шага, супервизора или блокировки или квитирование 
сообщения или установка регистрации. 

Если действия логически скомбинированы с событием, сигнал состояния 
события определяется по обнаружению фронта. Это означает, что инструк-
ции могут выполняться только в том цикле, в котором происходит событие.  

События и оценка сигналов 
Шаг 

• S1: Шаг активируется 

• S0: Шаг деактивируется 

 
Супервизор  

• V1: Появилась ошибка супервизора (неполадка) 

• V0: Прекратилась ошибка супервизора (нет неполадок) 

 
Блокировка  

• L0: Условие блокировки включено  

• L1: Условие блокировки выключено (например, неполадка) 

• C: Условия блокировки удовлетворены  

 
Сообщения и регистрация 

• A1: Сообщение квитировано 

• R1: Установлена регистрация 
(положительный фронт на входе REG_EF / REG_S) 

 

1

0
t

V1 V0

Неполадка
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Действия, зависящие от событий – с блокировкой и без 
Все стандартные действия, за исключением действий, содержащих команды 
D и L, можно логически комбинировать с событиями. 

 
Событие 
 

Команда 
 

Идентифика
тор адреса 

Расположе
ние адреса 

Значение: 
 

S1, V1, A1,  
R1 

N[C], R[C], S[C] 
CALL[C] 

Q,I,M,D,      
FB, FC, SFB,  
SFC 

m.n 
номер 
блока 

После обнаружения события [и если 
блокировка активна], применимо к 
следующему циклу: 
• Адрес однократно получает 

значение 1 (N) 
• Адрес однократно устанавливается 

в 1 (S) 
• Адрес однократно сбрасывается в 0 

(R)  
• Однократно вызывается блок 

(CALL) 
S0, V0, L0,  
L1 

N, R, S,   
CALL 

Q,I,M,D 
FB, FC, SFB,  
SFC 

m.n 
номер 
блока 

После обнаружения события, 
применимо к следующему циклу: 
• Адрес однократно получает 

значение 1 (N) 
• Адрес однократно устанавливается 

в 1 (S) 
• Адрес однократно сбрасывается в 0 

(R)  
• Однократно вызывается блок 

(CALL) 

 

m адрес байта; n = адрес бита; диапазон адресов: 0.0 … 65535.7 

Адрес D: DBi.DBXm.n = номер блока данных i; DBXm.n = бит в DB;  

SFBi / FBi = номер (системного) функционального блока i; SFCi / FCi = номер 
(системной) функции i 
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Действия, зависящие от событий – для активации и деактивации шагов 
Другие шаги можно активировать и деактивировать, используя команды ON и 
OFF. Эти инструкции всегда зависят от событий шага, другими словами, 
события определяют момент активации и деактивации шага. 

Эти команды можно комбинировать блокировкой. Действия выполняются 
только при выполненных условиях блокировки. 

 
Событие 
 

Команда 
 

Идентифика-
тор адреса 

Расположе
ние адреса 

Значение: 
 

S1, V1, A1,  
R1 

ON[C], OFF[C] S i Активация (ON) или деактивация шага 
(OFF) в зависимости от события [и 
блокировки]  

S1, V1  OFF[C] S_ALL  Деактивация всех шагов в зависимости 
от события [и блокировки]. Исключение 
– шаг, в котором выполняется это 
действие. 

S0, V0, L0,  
L1 

ON, OFF S i Активация (ON) или деактивация шага 
(OFF) в зависимости от события  

L1  OFF S_ALL  Деактивация всех шагов в зависимости 
от события. Исключение – шаг, в 
котором выполняется это действие. 

i: номер шага 

 
 Замечание 

Если шаг активируется и деактивируется в одном цикле, деактивация имеет 
более высокий приоритет. 

Пример: Таблица действий с действиями, зависящими от событий 

 

(1):  Когда шаг активен и условие блокировки выполнено, выход Q1.0 
сбрасывается в 0 и остается сброшенным. 

(2):  Когда появляется ошибка супервизора, все деактивируются все активные 
шаги, за исключением шаг S4, в котором находится эта команда. 

(3):  Если условие блокировки выполняется, вызывается указанный блок 
(FC10). 
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7.4 Счетчики, таймеры и арифметика в действиях  

Счетчики в действиях  
Все счетчики в действиях всегда зависят от событий, другими словами, 
события определяют момент активации команды. Вы также имеете 
возможность скомбинировать счетчик с блокировкой. Инструкции счетчика, 
скомбинированные с блокировкой (добавлена буква C), выполняются только 
в том случае, если условие блокировки выполняется в момент, когда 
происходит событие. Счетчик без блокировки выполняется, когда происходит 
событие. 

Счетчики в действиях ведут себя, как и в других языках программирования 
S7: Они не переполняются сверху и снизу и при значении счетчика равном 0 
бит счетчика также равен 0, а в другом случае 1. 

 
Событие 
 

Инструкция 
 

Идентифика-
тор адреса  

Размеще-
ние адреса 

Значение: 
 

S1, S0, L1,  
L0, V1, V0,  
A1, R1 

CS[C] C X Установка: Если происходит событие 
[и блокировка выполняется], в счетчик 
загружается начальное значение.  

  <начальное 
значение 
счетчика> 

 Начальное значение счетчика 

S1, S0, L1,  
L0, V1, V0,  
A1, R1 

CU[C] C X Счет вверх: Если происходит событие 
[и блокировка выполняется], значение 
счетчика увеличивается на "1". 

S1, S0, L1,  
L0, V1, V0,  
A1, R1 

CD[C] C X Счет вниз: Если происходит событие [и 
блокировка выполняется], значение 
счетчика уменьшается на "1".  

S1, S0, L1,  
L0, V1, V0,  
A1, R1 

CR[C] C X Сброс: Если происходит событие [и 
блокировка выполняется], значение 
счетчика сбрасывается в 0.  

 
[ ] = дополнительная возможность для блокировки; x = номер счетчика 

Начальное значение счетчика  
Все действия, содержащие инструкцию CS требуют начальное значение 
счетчика. начальное значение счетчика программируется с использованием 
следующего синтаксиса: 

<начальное значение счетчика> = IWy, QWy, MWy, LWy, DBWy, DIWy; 
переменная типа WORD; C#0... C#999 

Y = 0... 65534 
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Таймеры в действиях 
Все таймеры в действиях всегда зависят от событий, другими словами, 
события определяют момент активации команды. Вы также имеете 
возможность комбинировать таймеры с блокировкой. Инструкции таймера, 
скомбинированные с блокировкой, выполняются только тогда, когда в 
дополнение к событиям выполняются условия блокировки (дополнительная 
буква C). Таймеры без блокировки выполняются, когда возникает событие. 

 
Событие 
 

Инструкция 
 

Идентифика-
тор адреса  

Размеще-
ние адреса 

Значение: 
 

S1, S0, L1,  
L0, V1, V0,  
A1, R1 

TL[C] T X Расширенный импульс, сохраняемое 
поведение бита таймера (состояния 
таймера): Когда возникает событие, 
таймер стартует. Условие C относится 
только к точке старта таймера. Как 
только таймер стартует, он 
продолжает работу независимо от 
блокировки  и активности шага. В 
течение периода <time>, бит таймера 
установлен в "1", после чего он 
сбрасывается в "0". Запущенный 
таймер может рестартовать при 
возникновении события. Бит таймера 
остается установленным в "1", таймер 
стартует снова с переменной <time>. 

  <Time>  Время 

S1, S0, L1,  
L0, V1, V0,  
A1, R1 

TD[C] T X Сохраняемая задержка, сохраняемое 
поведение бита таймера (состояния 
таймера): Таймер запускается при 
возникновении события. Когда таймер 
стартовал, его поведение становится 
независимым от блокировки и 
активности шага. В течение времени  
<time>, бит таймера остается 
установленным в "0". Запущенный 
отсчет времени может быть 
перезапущен, если событие запуска 
возникает снова. Бит таймера остается 
установленным в "0", общее время 
выполнения увеличивается на <time>. 
Бит таймера устанавливается в "1" 
только после истечения времени 
таймера. 

  <Time>  Время 

S1, S0, L1,  
L0, V1, V0,  
A1, R1 

TR[C] T X Сброс: Когда происходит событие [и 
выполнена блокировка], таймер 
останавливается. Бит таймера 
(состояние таймера) и переменная 
таймера сбрасываются в "0".  

[ ] = дополнительная возможность блокировки; x = номер таймера 
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Время (длительность) 
Все действия, содержащие одну из инструкций TL или TD требуют ввода 
времени (длительности). Время программируется со следующим 
синтаксисом: 

<time> = IWy, QWy, MWy, LWy, DBWy, DIWy; переменная типа S5TIME, 
WORD; S5T#time_cnstant 

Y = 0... 65534 

Арифметика в действиях 
Вы можете предусмотреть инструкции с простыми арифметическими 
выражениями в действиях. Это присвоение в виде A:=B, A:=func(B) и 
A:=B<operator>C. Действия, содержащие арифметические выражения 
требуют инструкции N. Действия могут зависеть от событий. Это значит, что 
присвоение может выполниться или только тогда, когда происходит 
соответствующее событие, или в каждом цикле в котором шаг активен. Как 
вариант, действие может также объединяться с блокировкой (добавлена 
буква C). 

 
Событие Инструкция Присвоение Значение: 
-- N[C] A:=B 

A:=func(B) 
A:=B<operator>C 

Пока шаг активен [и блокировка 
удовлетворяется], выполняется присвоение. 

S0, S1, V0,  
V1, L0, L1,  
A1, R1 

N[C] A:=B 
A:=func(B) 
A:=B<operator>C 

После появления события [и блокировка - 
истина], выполняется присвоение. 
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Прямое присвоение 
Вы можете ввести прямое присвоение с синтаксисом A:=B. При прямом 
присвоении можно использовать следующие типы данных: 

• 8 бит: BYTE, CHAR 

• 16 бит: WORD, INT, DATE, S5TIME 

• 32 бита: DWORD, DINT, REAL, TIME, TIME_OF_DAY 

Следующая таблица дает обзор всех разрешенных в присвоении типов. Вы 
можете присвоить не только адреса того же типа, но и адреса отличающегося 
типа данных той же длины и адреса другой длины: 

 
  8 бит  16 бит    32 бита     
  BYTE CHAR WORD INT DATE S5 

TIME 
DWORD DINT REAL TIME TIME_OF 

_DAY 

8 бит BYTE := 9 9          

 CHAR := 9 9          

16 бит WORD := 9 9 9 9 9 9      

 INT := 9 9 9 9 9       

 DATE := 9  9 9 9       

 S5TIME :=   9   9      

32 бит DWORD := 9 9 9 9 9 9 9 9 9 9 9 

 DINT :=       9 9  9 9 

 REAL :=       9  9   

 TIME := 9  9 9   9 9  9  

 TIME_OF_ 
DAY := 

9  9 9   9 9   9 

Присвоение с встроенной функцией 
Присвоение с встроенной функцией записывается в виде A:=func(B). Это 
присвоение существенно для функций преобразования и сложных 
математических функций. Назначаемый адрес A определяет тип выражения. 
Вы можете использовать следующие присвоения назначения  с 
использованием встроенных функций: 

 
Присвоение со 
встроенными 
функциями 

Комментарий 
 

Функции 
преобразования: 

 

A := BCD_TO_NUM(B) BCD в INT или DINT (команды STL: BTI, BTD) 
A := NUM_TO_BCD(B) INT или DINT в BCD (команды STL: ITB, DTB) 
A := INT_TO_DINT(B) INT в DINT (команда STL: ITD) 
A := DINT_TO_REAL(B) DINT в REAL (команда STL: DTR) 
A := ROUND(B) REAL в DINT (команда STL: RND) 
A := TRUNC(B) REAL в DINT, отбрасывание остатка (команда STL: 

TRUNC) 
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Присвоение со 
встроенными 
функциями 

Комментарий 
 

Математические 
функции: 

 

A := NEGR(B) REAL отрицание 
A := ABS(B) REAL абсолютное значение 
A := SQR(B) REAL квадрат 
A := SQRT(B) REAL квадратный корень 
A := LN(B) REAL логарифм по основанию e 
A := EXP(B) REAL экспонента по основанию e 
A := SIN(B) REAL синус 
A := ASIN(B) REAL арксинус 
A := COS(B) REAL косинус 
A := ACOS(B) REAL арккосинус 
A := TAN(B) REAL тангенс 
A := ATAN(B) REAL арктангенс 
A := NEG(B) Изменение знака 

(команды STL: NEGI, NEGD, NEGR) 

  

Прочие функции:  
A := NOT(B) Инверсия (команды STL: INVI, INVD) 
A := SWAP(B) Обмен байт (команды STL: TAD, TAW) 
A := RLDA(B) Сдвиг 32 бит влево на 1 бит через CC1 (команда STL: 

RLDA) 
A := RRDA(B) Сдвиг 32 бит вправо на 1 бит через CC1 (команда STL: 

RRDA) 
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Присвоение с оператором 
Введите присвоение с оператором, используя синтаксис A:=B<operator>C. 
Эти присвоения – основные математические функции и битовые логические 
операции. Назначаемый адрес A определяет тип выражения. Вы можете 
использования следующие присвоения с оператором: 

 
с оператором  Комментарий 

 
A := B + C +I, +D, +R 
A := B – C -I, -D, -R 
A := B  C I, D, R 
A := B / C /I, /D, /R 

Если необходимо, оператор может быть дополнен +D/+R  
в основных математических функциях. 

A := B MOD C Модуль: Только для данных типа DINT 
  
A := B AND C Операция И (команды STL: AW, AD) 
A := B OR C Операция ИЛИ (команды STL: OW, OD) 
A := B XOR C Операция ИСКЛЮЧАЮЩЕЕ ИЛИ (команды STL: XOW, XOD) 
  
A := B SHL C Сдвиг влево, 0<=C<=255 (команды STL: SLW, SLD) 
A := B SHR C Сдвиг вправо, 0<=C<=255 (команды STL: SRW, SRD) 
A := B SSR C Сдвиг вправо со знаком, 0<=C<=255 (команды STL: SSI,SSD) 
A := B ROL C Циклический сдвиг влево, 0<=C<=255 (команда STL: RLD) 
A := B ROR C Циклический сдвиг вправо, 0<=C<=255 (команда STL: RRD) 

Пример: Таблица действий со счетчиками и арифметикой 

 

Две альтернативы для подсчета производственных циклов: 

(1):  Когда шаг активируется, счетчик C23 увеличивается на 1. Таким 
образом, счетчик подсчитывает число активаций шага. 

(2):  Когда шаг становится активным, переменная A увеличивается на 1. В 
этом случае арифметика может использоваться для подсчета действий, 
основанных на счете числа активаций шага. 
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7.5 Условия 

Условия это двоичные состояния процесса, которые сочетаются с 
элементами LAD или FBD (нормально разомкнутые или замкнутые контакты, 
блоки И, ИЛИ компараторы) в соответствии с булевской логикой. Результат 
логической операции (RLO) может влиять на отдельные действия шага, шаг в 
целом, разрешение следующего шага или целого секвенсора. Логические 
операции программируются в LAD или FBD. 

Условия это:  

• События (например, активный шаг покинут) и  

• Состояния (например, вход I2.1 установлен) 

Области, в которых могут применяться условия   
Условия используются в следующих областях: 

• Переход (разрешение следующего шага) 

• Блокировка 

• Супервизор 

• Постоянные инструкции (условия и вызовы блока перед началом и/или 
после выполнения секвенсора) 

Переход 
В переходе Вы программируете условия, которые управляют тем, как 
секвенсор передает управление от одного шага к другому.  

 

Переход отображается и программируется при представлении в виде 
отдельного шага. Вы также можете выбрать уровень отображения 
"Sequencer" и отобразить переходы командой меню View > Display With > 
Conditions and Actions [Вид > Отображать > Условия и действия]. 

Переход передает управление следующему шагу секвенсора, если 
выполняется логическое условие перехода, другими словами, когда 
результат выполнения сегмента 1. Шаг, следующий за переходом, становится 
активным.  

Переход не передает управление следующему шагу секвенсора, если 
выполняется логическое условие перехода; другими словами, когда 
результат выполнения сегмента 0. Активный шаг остается активным. 



Программирование условий и действий 

 S7-GRAPH для S7-300/400 Программирование систем последовательного управления 
7-16 A5E00290656-01 

Пустой переход 
Переход без запрограммированных условий это пустой переход. Он не 
влияет на выполнение секвенсора. Активный шаг выполняется при 
прохождении только однократно. Активным становится следующий шаг. 

Пропуск шагов 
Если как переход перед шагом, так и переход после шага, удовлетворяются 
одновременно, шаг не становится активным.  

На закладке "Compile/Save [Скомпилировать/Сохранить]" диалогового окна 
"Block Settings [Установки блока]" (команда меню Options > Block Settings 
[Возможности > Установки блока]) должна быть выбрана опция "Skip Steps 
[Пропуск шагов]". 

Блокировка 
Блокировка это программируемое условие для запрещения выполнения 
отдельных действий в шагах, подверженных блокировке. 

 

Если логические условия блокировки выполняются, действия, 
скомбинированные с блокировкой, выполняются.  

Если логические условия блокировки не выполняются, это считается 
нарушением:  

• Действия, скомбинированные с блокировкой, не выполняются  

• Появляется сигнал ошибки блокировки (событие L1). 

Вы программируете блокировку на уровне представления отдельного шага. В 
блокировке можно запрограммировать максимум 32 элемента LAD/FBD. 
Результат операции автоматически обрабатывается системой.  

Запрограммированная блокировка обозначается буквой C рядом с шагом на 
всех уровнях представления.  

 
 Предупреждение 

Если Вы запрограммировали блокировку, она используется только в 
действиях, инструкции которых имеют расширение в виде буквы C. 
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Пустая блокировка 
Блокировка без условий (другими словами, без элементов LAD или FBD) 
обрабатывается как блокировка с выполняющимися условиями. 

Супервизор 
Супервизор - программируемое условие для контроля шага, которое влияет 
на способ, которым секвенсор передает управление от одного шага 
следующему.  

 

Запрограммированный супервизор обозначается, на всех уровнях 
представления, буквой V слева от шага.  

Вы программируете супервизор на уровне представления отдельного шага. В 
супервизоре можно запрограммировать максимум 32 элемента LAD/FBD. 
Результат операции автоматически обрабатывается системой.   

Если логическое условие супервизора выполняется, это означает неполадку  
и сигнализирует о событии V1. Секвенсор не передает управление на 
следующий шаг. Однако, текущий шаг остается активным. Время активации 
шага Si.U останавливается, пока выполняется условие. 

Если логическое условие супервизора не выполняется, неполадки нет. Если 
условие следующего перехода выполняется, секвенсор передает управление 
на следующий шаг.  

Постоянные инструкции 
Вы программируете постоянные инструкции обычными элементами LAD/FBD. 
Для более детальной информации, справьтесь в разделе "Постоянные 
инструкции" в "Программирование структуры секвенсора". 
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7.6 Элементы контактной логики для программных 
условий  

Элементы контактных схем  
Программа контактной схемы воспроизводит течение тока по электрической 
цепи. Отдельные элементы контактной схемы несут двоичную информацию: 
состояние сигнала "0" (ток не течет) или "1" (ток течет).  

 
Элементы 
контактных схем  

Адрес 
 

Тип 
данных 
 

Область 
памяти 

Описание 
 

Нормально открытый 
контакт 

 

<Operand> BOOL, 
TIMER, 
COUNTER 

I, Q, M, T, C 
бит данных 

Нормально открытый контакт имеет 
сигнальное состояние "1", если 
сигнальное состояние адреса "1". 
Адрес определяет бит, состояние 
которого опрашивается. 

Нормально закрытый 
контакт  

 

<Operand> BOOL, 
TIMER, 
COUNTER 

I, Q, M, T, C 
бит данных 

Нормально закрытый контакт имеет 
сигнальное состояние "1", если 
сигнальное состояние адреса "0". 
Адрес определяет бит, состояние 
которого опрашивается. 

Обмотка (выход) 
<Operand> 
-----(=)  

 

<Operand> BOOL I, Q, M, бит 
данных 

Вы используете обмотку только в 
постоянных инструкциях секвенсора. 
Адрес содержит результат условий 
запрограммированных в постоянных 
инструкциях (логические операции с 
нормально открытыми и замкнутыми 
контактами, блоками сравнения). Он 
определяет бит, в который 
записывается состояние сигнала. 

Обмотка  
Установка выхода 
<Operand> 
-----(S)  

 

<Operand> BOOL I, Q, M, бит 
данных 

"Установка" выполняется только 
когда результат логической 
операции (RLO) предыдущих 
постоянных инструкций "1".  Тогда 
<address> устанавливается в "1". 
При RLO="0" эффекта нет, 
сохраняется текущее состояние 
сигнала адреса. 
Адрес определяет, какой бит будет 
установлен. 

Обмотка  
Сброс выхода 
<Operand> 
-----(R)  

 

<Operand> BOOL I, Q, M, бит 
данных 

"Сброс" выполняется только когда 
результат логической операции 
(RLO) предыдущих постоянных 
инструкций "1".  Тогда <address> 
сбрасывается в "0". 
При RLO="0" эффекта нет, 
сохраняется текущее состояние 
сигнала адреса. 
Адрес определяет, какой бит будет 
сброшен. 
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Правила для ввода элементов контактных схем  
При вводе элементов контактных схем, следуйте правилам: 

• Все элементы и ветви должны быть соединены друг с другом. 

• Каждая ветвь в контактной схеме должна содержать, по крайней мере, 
один логический элемент. 

Режим вставки элементов контактных схем  
Возможны два режима редактирования при вставке элементов LAD: 

• Insert > Direct [Вставка > Непосредственно] В этом режиме, Вы сначала 
выделяете в секвенсоре позицию, в которую Вы хотите вставить элемент, 
а затем выбираете элемент для вставки. 

• Insert > Drag and Drop [Вставка > Перетаскивание] В этом режиме, Вы 
сначала выделяете элемент, который Вы хотите вставить, а затем 
курсором мыши выбираете в секвенсоре позицию, в которую Вы хотите 
вставить элемент. Этот метод удобен для применения, когда один и тот 
же элемент вставляется в различные места в секвенсоре.  

Ввод адреса 
Имеется два способа ввода адресов:  

• Щелкните на заменителе требуемого текстового поля "??.?". Затем 
введите абсолютный или символьный адрес (например, I1.0, 
"limit_switch"). Вы можете использовать как немецкую (E, A), так и 
английскую (I, O)  мнемонику для адресации. Выбор мнемоники 
производится в SIMATIC Manager. 

• Выберите поле адреса и затем выберите абсолютный или символьный 
адрес в выпадающем списке (например, I1.0, "Limit switch"). Вводится 
выбранный адрес. 

Переключение между контактными схемами и FBD 
В S7-GRAPH Вы можете программировать условия на двух языках 
программирования: контактном плане (LAD) или функциональной блочной 
диаграмме (FBD). В любой момент Вы можете отобразить условия в виде 
LAD или FBD. Для переключения отображения достаточно выбрать 
соответствующую команду меню: View > LAD [Вид > LAD] или View > FBD 
[Вид > FBD]. 
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7.7 Логические операции с элементами контактной 
логики  

Логические операции опрашивают состояние сигнала контактной схемы на "0" 
(не активировано, выключено) или "1" (активировано, включено) и 
обеспечивают этим результат логической операции (RLO). Инструкция или 
сохраняет результат или выполняет с ним логическую операцию.  

Следует различать две логические операции И и ИЛИ: 
 

Логическая операция  Пример логических операций в переходе 
И 

 

Условие выполняется, когда 
состояние сигнала на е I0.0="1" 
И состояние сигнала I 0.1="0". 

ИЛИ 

 

Условие выполняется, когда   
• Состояние сигнала на входе 

I 0.0 = "1" 
ИЛИ  
• Блок сравнения после 

сравнения двух адресов 
выдает результат “истина". 
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Элемент 
контактной 
схемы 

Адрес Данные Область памяти Описание 

Comparator  
[Блок сравнения] 

  

  

   

 IN1: Первая 
сравниваемая 
величина 

INT/ DINT/ REAL/ 
TIMER/ CONST 

I, Q, M, (двойное) 
слово  
 

Блок сравнения 
выдает сигнал "1", 
когда сравнение 
двух адресов IN1 и 
IN2 дает результат 
“истина”. 
INT: схема 
сравнения 16-
битных целых 
чисел  
Параметры: слова 
DINT: схема 
сравнения 32- 
битных целых 
чисел и таймеров 
Параметры: 
двойные слова, 
таймеры 
REAL: схема 
сравнения 32- 
битных чисел с 
плавающей точкой 
Параметры: 
двойные слова  

 IN2: Вторая 
сравниваемая 
величина 

INT / DINT / REAL /  
TIMER /  CONST 

I, Q, M, (двойное) 
слово  
 

Заметьте:  
Когда Вы вводите 
компаратор, Вы 
должны опреде-
лить тип данных 
явно только в том 
случае, если Вы 
вводите 32-битную 
переменную без 
определения типа  
(например, при 
использовании 
абсолютного адре-
са). В других слу-
чаях тип данных 
обнаруживается  
системой, и специ-
фикация может 
быть опущена. 
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7.8 Элементы FBD для программных условий  

Элементы FBD   
Программа FBD выполняет преобразование сигнала в логической цепи. 
Отдельные элементы FBD несут бинарную информацию: Состояние сигнала 
"0" (ток не течет) или "1" (ток течет).  

 
Элемент FBD  
 

Адрес 
 

Тип 
данных 
 

Область 
памяти 

Описание 
 

Вставить двоичный 
вход 

 
 

<Operand> BOOL I, Q, M, T,  
C, D, L 

Инструкция добавляет 
логический вход к блоку AND или 
OR после выбранной позиции. 
Адрес содержит бит, состояние 
сигнала которого опрашивается. 

Инверсия двоичного 
входа 

 

None: -- -- Инструкция  инвертирует 
результат логической операции 
(RLO). 

Выход    Вы используете операцию 
вывода только в постоянных 
инструкциях секвенсора. 

Присвоение выходу 
 

 

<Operand> BOOL I, Q, M, D, L Адрес содержит результат 
условий, которые 
запрограммированы в 
непрерывных инструкциях 
(логические операции перед 
блоком вывода). Он определяет 
бит, в который записывается 
состояние сигнала. 

Установка выхода 
 

 
 

<Operand> BOOL I, Q, M, D, L Эта инструкция выполняется 
только когда RLO предыдущих 
непрерывных инструкций = "1". 
Тогда <address> устанавливается 
в "1". 
При RLO = "0" действия нет, 
текущее состояние сигнала 
адреса не изменяется. 
Адрес определяет бит, который 
должен быть установлен. 

Сброс выхода 
 

 
 

<Operand> BOOL, 
TIMER, 
COUNTER 

I, Q, M, T,  
C, D, L 

Эта инструкция выполняется 
только когда результат 
логической операции (RLO) 
предыдущих постоянных 
инструкций "1".  Тогда <address> 
сбрасывается в "0". 
При RLO="0" эффекта нет, 
сохраняется текущее состояние 
сигнала адреса. 
Адрес определяет сбрасываемый 
бит. 
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 Правила ввода элементов FBD  
При вводе элементов FBD придерживайтесь следующих правил: 

• Все элементы и ветви должны быть соединены друг с другом. 

• Все ветви в сегменте FBD должны содержать, по крайней мере, один 
элемент FBD. 

Режимы вставки  элементов FBD  
Возможны два режима редактирования при вставке элементов FBD: 

• Insert > Direct [Вставка > Непосредственно] В этом режиме, Вы сначала 
выделяете в секвенсоре позицию, в которую Вы хотите вставить элемент, 
а затем выбираете элемент для вставки. 

• Insert > Drag and Drop [Вставка > Перетаскивание] В этом режиме, Вы 
сначала выделяете элемент, который Вы хотите вставить, а затем 
курсором мыши выбираете в секвенсоре позицию, в которую Вы хотите 
вставить элемент. Этот метод удобен для применения, когда один и тот 
же элемент вставляется в различные места в секвенсоре. 

Ввод адресов 
Имеется два способа ввода адресов:  

• Щелкните на заменителе требуемого текстового поля "??.?". Затем 
введите абсолютный или символьный адрес (например, I1.0, 
"limit_switch"). Вы можете использовать как немецкую (E, A), так и 
английскую (I, O)  мнемонику для адресации. Выбор мнемоники 
производится в SIMATIC Manager. 

• Выберите поле адреса и затем выберите абсолютный или символьный 
адрес в выпадающем списке (например, I1.0, "Limit switch"). Вводится 
выбранный адрес. 

Переключение между FBD и контактной схемой 
В S7-GRAPH Вы можете программировать условия на одном из двух языков 
программирования: в контактной схеме (LAD) или функциональной схеме 
(FBD). Вы можете в любой момент представить условие в виде LAD или FBD. 
Для переключения отображения достаточно выбрать соответствующую 
команду меню: View [Вид] > LAD  или View [Вид] > FBD. 
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7.9 Логические операции с элементами FBD  

Следует различать две логические операции AND и OR: таким образом, 
имеются два элемента FBD. 

 
Элемент FBD  
 

Адрес 
 

Тип 
данных 

Область 
памяти 

Описание 
 

Операция AND  
 

 
 

<Operand> BOOL I, Q, M, T,  
C, D, L 

Инструкция дает сигнал "1", когда 
состояние всех <addresses> = "1". 
Если состояние сигнала одного 
из <address> = "0", инструкция 
дает результат "0". 
Адреса определяют биты, 
сигнальные состояния которых 
проверяются. 

Операция OR  
 

 

<Operand> BOOL I, Q, M, T,  
C, D, L 

Инструкция дает сигнал "1", когда 
состояние одного из <addresses> 
= "1". Если состояние сигнала 
всех <address> = "0", инструкция 
дает результат "0". 
Адреса определяют биты, 
сигнальные состояния которых 
проверяются. 

Блок сравнения 

 

IN1: 
Первая 
сравни-
ваемая 
величина 

INT/ DINT/ 
REAL 

I, Q, M, D, L, 
constant 

Результат логической операции 
имеет сигнальное состояние "1", 
когда сравнение двух адресов 
IN1 и IN2 истинно. 
INT: сравнение 16-битных целых: 
Параметры: слова 
DINT: сравнение 32-битных 
целых: 
Параметры: двойные слова  
REAL: сравнение 32- битных 
вещественных  
Параметры: двойные слова  

 IN2:  
Вторая 
сравни-
ваемая 
величина  

INT / DINT /  
REAL 

I, Q, M, D, L, 
constant 

Замечание:  
Когда Вы вводите сравнение, 
Вам требуется явно определить 
тип D/R/I только тогда, когда Вы 
вводите 32 битные переменные 
без определения типа (например, 
когда назначаются абсолютные 
адреса в формате двойного 
слова). В другом случае тип 
данных обнаруживается 
системой и спецификация может 
быть опущена. 
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7.10 Адреса S7-GRAPH в условиях 

Имеется возможность использовать системную информацию о состоянии 
секвенсора в качестве адресов в переходах, супервизорах, блокировках, 
действиях и постоянных инструкциях. 

 
Адрес Значение Использование 
Si.T Текущее или последнее время активации шага i Компаратор, 

присвоение 
Si.U Общее время активации шага I, за исключением времени 

неполадок 
Компаратор, 
присвоение  

Si.X Показывает, активен ли шаг i  Нормально открытый 
или закрытый контакт  

Transi.TT Выполнение перехода i  
Проверяет, выполняется ли условие перехода i  

Нормально открытый 
или закрытый контакт  

 

Вы можете использовать эти специфические адреса S7-GRAPH точно так же, 
как обычные адреса в LAD и FBD или в действиях.  

Примеры использования адресов в S7-GRAPH  
Во многих процессах, необходимо контролировать длительность активности 
(за вычетом времени неполадок). Пример: Продукт должен перемешиваться 
для в общей сложности 5 секунд, независимо от времени, в котором были 
неполадки шага нарушен.  

В ситуациях, подобных этой, Вы можете запрограммировать условие 
супервизора, в котором Вы проверяете адрес Si.U. 

Инструкция сравнения 32-битных целых позволяет Вам сравнивать величину 
адреса Si.U с заданным временем 5 секунд. Сравниваются входы IN1 и IN2. 

В примере, время активации 3 шага без нарушений сравнивается с 
установленным временем 5 секунд. Если время активации 3 шага больше или 
равно выбранного времени 5 секунд, условие удовлетворено. Если клапан 
также закрыт (сигнал = 1), условие супервизора удовлетворяется. 

  
 

CMP 
>=D 

Активность шага 

Временная константа 

S003.U

T#5s

Valve 

IN1 

IN2 
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7.11 Ошибки супервизора и квитирование  

Каждому шагу можно назначить условие супервизора. Наблюдаться может 
только активный шаг. S7-GRAPH определяет, выполняется или нет условие 
супервизора (другими словами, когда появляется ошибка супервизора). 

Состояние возникновения ошибки супервизора (1) порождает событие "V1", а 
состояние снятия ошибки супервизора (2) порождает событие "V0". 

 

Сигнализация и квитирование - Требования 
Сигнализация и квитирование ошибок супервизора возможно только с 
следующими установками на закладке "Compile / Save [Компиляция и 
сохранение]" диалога "Block Settings [Установки блока]" (команда меню 
Options > Block Settings [Возможности > Установки блока]): 

• В поле "FB Parameters [Параметры FB]" устанавливается "Standard", 
"Maximum", или "Definable". 
S7-GRAPH сигнализирует о ошибках супервизора выходным параметром 
ERR_FLT.  

• В группе "Sequencer Properties [Свойства секвенсора]" устанавливается 
"Acknowledge errors [Квитирование ошибок]". 
Это означает, что ошибки супервизора возникающие при 
функционировании должны квитироваться входным параметром ACK_EF.  

Должны или нет квитироваться ошибки можно установить «по выбору» не 
только в установках в диалоговом окне, но, как альтернатива, используя 
соответствующий параметр (EN_ACKREQ) в наборе параметров.  

Обработка ошибок супервизора  
Ошибки, которые должны быть квитированы, влияют только на 
соответствующий путь секвенсора, чтобы остальной секвенсор мог 
обрабатываться, тогда как путь секвенсора, подверженный ошибке, будет 
работать снова только после того, как ошибка квитирована. 

1

0
t

V1 V0

Нарушение Нет нарушений 

1 2

Нарушение: условия супервизора выполняется
Нет нарушений: условия супервизора не выполняются 
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Возникла ошибка супервизора 
(событие V1)

Действия с V1 выполняются однократно 
в следующем цикле секвенсора. 

Время активации шага Si.U остановлено 

Установка
компилятора: 
«Квитирование»

Сообщение в параметре FB ERR_FLT 

Квитирование? 

Квитиров. или 
SV не выполн.? 

Si.U:=0 

SV не истинно? 

Условие разреш. 
шага истинно? 

Устранение ошибки 
супервизора 
Событие V0 

Конец 

Переключение 

ошибка супервизора 
Устраняется

Событие V0 

Квитирование? 

Si.U:=0 

SV не истинно? 

Условие разреш. 
шага истинно?

Нет

Да

секвенсора

Нет 

Да

Да Да

Да

Да Да

Да

Нет

Нет 

Нет 

Нет Нет

Нет

Устранение ошибки 
супервизора 
Событие V0 
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7.12 Комментарий, расширенное имя, номер, имя 

Комментарий шага 
Комментарий шага может содержать максимум 2048 символов. Он не влияет 
на  выполнение программы.  

Комментарий шага отображается только на уровне отображения отдельного 
шага. Если Вы не ввели расширенное имя шага, вместо него отображается 
имя шага. 

Расширенное имя  
Расширенное имя шага отображается в текстовой строке над действиями. 
Оно используется, в первую очередь, как краткий комментарий, с другой 
стороны расширенное имя может также использоваться вместо имени шага 
для обозначения шага в системе диагностики.  

Число символов в расширенном имени не ограничено. Однако убедитесь, что 
расширенное имя уникально в программе.  

Если Вы не ввели расширенное имя шага, вместо него отображается имя 
шага. 

Номер и имя шага (например, S1 и Step1) 
Имя и номер шага должны быть уникальными и могут быть изменены на 
любом уровне представления. 

• Номер шага назначается автоматически системой (диапазон: от 1 до 999). 
Если номер первого шага установлен вручную в ветви, когда дальнейшие 
пары шаг-переход устанавливаются, номера назначаются системой 
автоматически в возрастающем порядке, начиная с номера, введенного 
вручную. Это обычно приводит к прерыванию нумерации пар шаг-
переход. Вы можете перенумеровать шаги и переходы в любое время так, 
чтобы отдельные области нумеровались последовательно. 

• Имя шага назначается автоматически системой (диапазон: от step1 до 
step999). Оно содержит максимум 24 букв и цифр. Первый символ должен 
быть буквой. Если масштаб отображения слишком мал, отображение 
имени шага отключается. 
Если вы изменяете имя шага в диалоговом окне "Step Properties 
[Свойства шага]", S7-GRAPH автоматически ищет старые имена и 
заменяет их во всей программе при сохранении и компиляции. Все 
инструкции, в которых есть ссылка на имя, следовательно обновляются. 
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Номер и имя перехода (например, T1 и Trans1) 
Имя и номер перехода должны быть уникальными и могут быть измены 
позднее во всех трех представленных языках программирования. 

• Номер перехода назначается автоматически системой (диапазон: от 1 до 
999). 
Если номер первого перехода установлен вручную в ветви, когда 
дальнейшие пары шаг-переход устанавливаются, номера назначаются 
системой автоматически в возрастающем порядке, начиная с номера, 
введенного вручную. Это обычно приводит к прерыванию нумерации пар 
шаг-переход. Вы можете перенумеровать шаги и переходы в любое 
время так, чтобы отдельные области нумеровались последовательно.  

• Имя перехода назначается автоматически системой (диапазон: от Trans1  
до Trans999).  
Оно содержит максимум 24 букв и цифр. Первый символ должен быть 
буквой. Если масштаб отображения слишком мал, отображение имени 
шага отключается. 
Вы можете изменить имя перехода в диалоговом окне "Transition 
Properties [Свойства перехода]". 

7.13 Программирование с символьными адресами 

Чтобы сделать программу последовательного управления более понятной, 
Вы можете использовать адреса в символьном виде, иначе говоря, 
использовать имена вместо абсолютных адресов.  

Символьные адреса назначаются в таблице символов. 

Символьная таблица автоматически создается в программе S7 и может быть 
отображена, используя команду меню Options > Symbol Table 
[Возможности > Таблица символов] или в SIMATIC manager, используя 
папку "Symbols [Символы]". 

Используемые символы отображаются в папке символов на закладке 
"Variables [Переменные]" обзорного окна. Соответствующие адреса, типы 
данных, и комментарии отображаются на закладке "Variables [Переменные]" 
детального окна. 

Требования к использованию символьных адресов 
Символьные адреса могут использоваться только в том случае, если 
символьные имена назначены абсолютным адресам в таблице символов. 

Отображение символьной информации при вводе адресов  
Вы можете упростить вход символьных адресов в условиях и действиях, 
отображая существующие символы в выпадающем списке. Если выбрана 
команда меню View > Display with > Symbol List [Вид > Отображать > 
Список символов], список символов отображается автоматически, когда 
вводится адрес. Если команда меню не выбрана, Вы можете открыть окно 
списка символов в любой момент, используя правую кнопку мыши и команду  
Insert Symbol [Вставить символ]. 
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Примеры использования символьных имен 
• Вместо адреса I0.1 используйте имя “Dr_mot_stopped" или 

• Вместо абсолютного обозначения FB11 используйте символьное имя 
“Seq_drill". 

7.14 Параметры блока и переменные в FB S7-GRAPH  

 FB S7-GRAPH назначается определенное множество параметров блока. 
Система предусматривает выбор одного из трех установленных по 
умолчанию наборов параметров. Вы можете выбрать множество параметров 
командой меню Options > Block Settings [Возможности > Установки 
блока].  

Пользователь может также определить блок параметров, а также статические 
или временные переменные требуемые для программирования. 

Вид переменных позволяет редактировать параметры и переменные блока. 
Он находится га закладке "Variables [Переменные]" обзорного окна. Если это 
окно скрыто, Вы можете открыть его на Вашем рабочем столе командой меню 
View > Overviews [Вид > Обзор].  

Дополнительную информацию о этих переменных Вы может найти в 
детальном виде переменных окна "Details [Детали]". Там Вы найдете 
информацию об адресах, начальных значениях и комментариях относящихся 
к переменным. 

Вставка параметров или переменных  в секвенсор 
Если Вы хотите использовать в программе параметры или переменные 
секвенсора, Вы можете перетащить параметры или переменные из закладки 
"Variables [Переменные]" в нужное место секвенсора, используя мышь. 

Автоматическое обновление изменений 
Изменения, сделанные Вами в параметрах или переменных в таблице 
"Variables [Переменные]", автоматически вносятся в секвенсор, чтобы 
исключить любые несоответствия. 
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8 Сохранение и компиляция 

Принципы: Сохранение и компиляция  
После того, как Вы запрограммировали секвенсор, Вы должны сохранить 
программу. При сохранении и компиляции, S7-GRAPH имеет различия между 
FB S7-GRAPH и исходным файлом S7-GRAPH. 

 

Проверка синтаксиса

Включение: 

Ошибка? Да

Нет

Включение:сохранение
исходного файла 

Включение:компиляция
исходного файла 

Сообщение об ошибке

Исправление ошибки

Создается FB

IСоздается экземпляр DB

Сохранение исходного 
файла 

cохранение FB
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8.1 Сохранение и компиляция 

Убедитесь в сохранении следующих правил: 

• Размер FB S7-GRAPH с секвенсором ограничен   

- для всех CPU 3xx максимум 8 или 16 кбайт 

- для всех CPU 4xx до 64 кбайт. 

• Каждый FB имеет экземплярный DB, который является памятью FB. Он 
содержит все данные и параметры, требующиеся для функционирования 
FB. Экземплярный DB может создаваться автоматически при компиляции 
или позднее, используя команду меню. 

• Размер экземплярного DB зависит от числа запрограммированных шагов 
и переходов, но составляет минимум 300 байт. 

• До сохранения FB S7-GRAPH или исходного файла S7-GRAPH, Вы 
должны запустить проверку правильности.  

- Ошибки и предупреждения при компиляции исходного файла 
S7-GRAPH не обязательно должны быть исправлены.  

- Однако ошибки при компиляции FB S7-GRAPH должны быть 
исправлены до сохранения FB.  

• Если Вы хотите загрузить различные секвенсоры в PLC одновременно,  
обычно лучше включить системные функции в один из поставляющих 
стандартных блоков. Это сокращает размер каждого блока S7-GRAPH 
приблизительно на 5000 байт. Стандартный блок требует при этом 
дополнительную память (однократно) (FC70 около 8200 байт, FC71 около 
7750 байт, FC72 около 10700 байт, FC73 около 8150 байт). 

8.2 Правила сохранения FB S7-GRAPH  

• Только FB S7-GRAPH, не содержащие ошибок, могут быть сохранены и 
переданы в CPU, другими словами, ошибки должны быть устранены до 
сохранения FB. Менее значимые ошибки, причины предупреждений, не 
требуют устранения, другими словами, сохранить FB с предупреждения-
ми командами “Save [Сохранить]" или “Save As [Сохранить как]". 

• Когда Вы сохраняете FB S7-GRAPH, неявно выполняется и компиляция, 
другими словами, Вы можете создать секвенсор и проверить его на 
синтаксические ошибки. Вследствие этого FB S7-GRAPH не требует 
компиляции. 
Детальное окно на закладке "Compile/Decompile Messages [Сообщения 
компилятора и декомпилятора]" показывает, как сообщения компилятора, 
ошибки (например, не определено назначение скачка) и/или 
предупреждения (например, действия без содержания). 

• Секвенсор, который сохраняет ошибки в FB S7-GRAPH может быть также 
сохранен как исходный файл S7-GRAPH, с которым Вы можете продол-
жить работу (команда меню File > Generate Source file [Файл > Генери-
ровать исходный файл]). Это позволяет Вам отложить устранение 
ошибок на более позднее время. 

• Блок созданный в результате компиляции сохраняется в папке блоков той 
же программы S7. 
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8.3 Правила сохранения исходного файла S7-GRAPH  

• Незавершенный и синтаксически неправильный секвенсор может быть 
сохранен.  

• Если в исходном файле S7-GRAPH запрограммирован секвенсор, 
свободный от ошибок, он может быть преобразован в FB S7-GRAPH с 
использованием функции "Compile [Компиляция]". 

• Исходные файлы хранятся в папке «Source Files» в той же программе S7. 

• Адреса в исходном файле могут сохраняться в абсолютном и символьном 
формате. 

Создание исходного файла 
Выполните следующие шаги: 

1. Выберите команду меню File > Create Source File [Файл > Генерировать 
исходный файл]. 

2. В диалоговом окне "New [Новый]", выберите проект и программу S7 и 
введите имя, под которым Вы хотите сохранить исходный файл. 

 
 Замечание 

Если Ваш исходный файл S7-GRAPH не имеет ошибок, Вы можете создать 
FB S7-GRAPH командой File > Compile [Файл > Компилировать]. 

 

8.4 Установки для сохранения и компиляции 

До сохранения и компиляции блока, проверьте и исправьте установки.  

• Выберите команду меню Options > Block Settings [Возможности > 
Установки блока]. Диалог имеет три закладки, относящихся к 
сохранению и компилированию. 

- Закладка "Compile / Save [Компиляция / Сохранение]" определяет 
структуру и содержание FB и соответствующего DB, общие свойства 
секвенсора и отображение предупреждений при компиляции. 

- Закладка "Messages [Сообщения]" определяет возможности 
конфигурирования сообщений. 

- Закладка "Process Diagnostics [Диагностика процесса]" определяет 
блоки, для которых используется диагностика процесса. 

• Выберите команду меню Options > Application Settings [Возможности > 
Установки блока]. Диалог имеет дальнейшие закладки, относящиеся к 
сохранению и компиляции. 

- Закладка "General [Общее]" определяет, помимо прочего, данные, 
которые создаются при сохранении Вашей программы. 
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8.4.1 Настройки на закладке "General [Общее]"  

Все настройки, которые Вы сделаете на этой закладке, будут использоваться, 
как установки по умолчанию, для вновь создаваемых блоков. 

Вид нового окна 
• Здесь Вы устанавливаете уровень отображения, который Вы хотите  

иметь при открытии блока: Sequencer [Секвенсор], single step [отдельный 
шаг] или permanent instructions [постоянные инструкции]. 

• Здесь Вы выбираете компоненты, которые должны отображаться после 
открытия блока  

 
Компонент Значение 
Comments 
[Комментарии] 

Поле, в котором Вы можете ввести комментарий блока или 
(при отображении отдельного шага) шага. 

Symbols [Символика] Отображение символьных имен адресов в рабочей области. 
Conditions and Actions 
[Условия и действия] 

Таблица, показывающая назначение символьных имен 
абсолютным адресам при отображении отдельного шага. 

Reference data 
[Справочные данные] 

Отображение справочных данных Вашей программы 

При сохранении 
Установки, определяющие какие данные должны создаваться при сохранении 
Вашей программы. 

• Include instance [Включая экземплярный DB]: 
Если Вы выбираете эту опцию, то компиляции или сохранении функцио-
нального блока, S7-GRAPH проверяет требуется ли обновлять экземпляр-
ный DB и, если необходимо, обновляет его автоматически. Если Вы не 
выбираете эту опцию, Вы должны создавать или обновлять экземплярный 
DB вручную командой меню File > Generate Instance DB [Файл > 
Генерировать экземплярный DB].  
Предупреждение 
Если Вы установили опцию "Message with [Сообщения, использующие] 
ALARM_SQ/ALARM_S (SFC17/SFC18)" на закладке "Messages [Сообще-
ния]" (команда меню Options > Application Settings [Возможности > На-
стройки приложения]) DB включается автоматически. Если экземпляр-
ный DB удаляется, убедитесь, что Вы пересоздали его в S7-GRAPH, в 
противном случае сообщения будут потеряны. 

• Generate reference data [Генерирование справочных данных] 
Если Вы выбираете эту опцию, справочные данные создаются автомати-
чески при сохранении блока. Если Вы не выбрали эту опцию, Вы, тем не 
менее, можете создать или обновить справочные данные вручную коман-
дой меню Options > Reference Data [Возможности > Справочные 
данные]. 

• Generate PDIAG data [Генерирование данных PDIAG]  
Если Вы выбираете эту опцию, S7-GRAPH генерирует диагностические 
данные, которые могут отображаться в системах интерфейса с 
оператором. 
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• Use extended names for display system [Использование символьных имен 
для системы отображения] 
Щелкните в этом боксе выбора, если Вы хотите использовать расширен-
ные имена шагов для систем диагностики. 

Адресация в исходных файлах 
В исходных файлах адреса сохраняются в символьном или абсолютном виде: 

• Absolute [Абсолютно] 
Выберите эту опцию для доступа к адресам в абсолютном виде. 

• Symbolic [Символьно] 
Выберите эту опцию для доступа к адресам в символьном виде. 
Используемые символы должны быть определены в таблице символов. 

Automatically create a new window when a step is opened [Автоматическое 
создание нового окна при открытии шага]  

• Если Вы выбираете эту опцию, при двойном щелчке на шаге,  
отображается в представлении отдельного шага в отдельном окне. 

Save window arrangement on closing [Сохранение расположения окон при 
закрытии] 

• Если Вы выбираете эту опцию, при выходе из редактора настройки 
сохраняются и будут использованы, когда Вы в следующий раз начнете 
работу в редакторе. 

Maximum number of status jobs used [Максимальное число используемых] 
• Вы можете определить максимальное число используемых заданий 

состояния, которое хотите использовать в S7-GRAPH.  

Все настройки, которые Вы сделаете на этой закладке выбранной 
командой меню  Options > Application Settings [Возможности > 
Настройки приложения] применимы к текущему открытому блоку. 

Соответствие IEC 
S7-GRAPH, начиная с V5.1, совместим с PLCopen Basis Level для 
последовательных систем управления, как оговорено в стандарте DIN EN 
61131-3. 

Если Вы имеете систему последовательного управления, которая 
совместима со стандартом, Вы можете импортировать в систему управления 
данных STEP 7 файлы ASCII, используя SIMATIC Manager, и редактируя их 
затем в S7-GRAPH. 

Для создания системы последовательного управления соответствующей 
стандарту, выберите опцию "IEC-compliant [Совместимость с IEC]". Эта 
настройка вызывает следующие эффекты 
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• Все системы последовательного управления должны содержать 
начальный шаг. В противном случае, при компиляции и создании блока 
будет показана ошибка. 

• Прямой адресации в исходных файлах и блоках (например, M0.0) 
предшествует символ % (%M0.0) 

• Адресация в исходных файлах всегда представляется в абсолютном 
виде. 

• Инструкции сравнения отображаются без определения типа данных, если  
тип данных адреса не имеет двусмысленности. 

• Опция "Addresses in Source Files Absolute/Symbolic [Адресация в исходных 
файлах в абсолютном / символьном виде ]" недоступна и установлена в 
положение абсолютно. 

Чтобы обеспечить совместимость исходных файлов с стандартом PLCopen, 
автоматически вносятся следующие изменения: 

• "function_block" заменяется на "program" 

• Точка с запятой используется как разделитель 

• Выражение "Condition:=" подавлено 

• Имя программы показано символьно в исходном файле  

• Псевдо комментарий "$_Jump" не требуется более для обозначения 
скачков. 

8.4.2 Настройки на закладке "Compile/Save [Компиляция и 
сохранение]": параметры FB  

Эти настройки определяют доступные параметры и предполагаемую 
функциональность FB, который будет создан. 

• Minimum [Минимум]: FB имеет только стартовый параметр INIT_SQ, 
который должен обеспечиваться переменной. Возможен только 
автоматический режим. 

• Standard [Стандарт]: FB содержит стандартные параметры, которые могут 
поддерживаться переменными. Возможны все режимы. 

• Maximum [Максимум]: FB содержит все параметры, которые могут 
поддерживаться переменными. Возможны все режимы. 

• Definable [Определяемое пользователем]: В этом варианте, Вы можете 
определить собственное множество параметров, используя закладку   
"Variables [Переменные]" на обзорном или детальном окне. 

 
 Предупреждение 

Если Вы отредактировали собственное множество параметров, а затем 
выбрали стандартное множество параметров, Вы потеряете собственные 
параметры.    
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8.4.3 Настройки на закладке "Compile/Save [Компиляция и 
сохранение]": Свойства выполнения 

S7-GRAPH имеет две возможности для создания FB. 

• Full code [Полный код]: 
Весь код, необходимый для выполнения каждого FB S7-GRAPH включен в  
FB. Если Вы имеете различные FB S7-GRAPH, это приводит к 
значительному увеличению потребности в памяти. 

• Standard FC required [Использование стандартной FC]: 
Для сокращения потребности в памяти, S7-GRAPH имеет альтернативу: 
Вы используете стандартную FC, раздел основного кода для всех FB. Эта 
FC копируется в Ваш проект автоматически, если Вы выбираете эту 
возможность. FB полученные этим методом существенно меньше.  

Для оптимизации потребности в памяти предпочтительно использовать 
второй метод со стандартной FC, если Вы имеете два или более FB 
S7-GRAPH. 

Вы должны выбрать между следующими стандартными FC: 

- FC70/FC71 
Эти две FC имеют размер меньше чем 8 кбайт и следовательно могут 
быть в малые CPU.  
Заметьте, что FC70 и FC71 поддерживают только функциональность 
S7-GRAPH V4.0. Вы не можете, например, использовать 
пользовательский набор параметров FB, однако Вы можете 
использовать в Вашей программе арифметические функции, таймеры 
или счетчики, начиная с S7-GRAPH V5.1. 
FC70 использует диагностические возможности SFC17/18 и могут 
быть использованы только в CPU, в которых доступны эти функции. 
Если в Вашем CPU они отсутствуют, Вы должны использовать FC71 
без диагностических возможностей или выбрать "Full Code [Полный 
код]". 

- FC72 
FC72 предусматривает полную системную функциональность но 
могут быть загружена только в большие CPU, поскольку ее размер 11 
кбайт. 

- FC73 
FC73 требует менее 8 кбайт памяти. Следовательно, она может 
выполняться на всех CPU, имеющих достаточный объем памяти для 
секвенсора S7-GRAPH (+ остальная программа пользователя). Если 
Вы используете эту FC, Вы можете существенно сократить 
требования к памяти FB S7-GRAPH в этом диалоге, выбрав "Interface 
Description: Memory minimized [Описание интерфейса: Минимизация 
памяти]" в настройках блока.  
FC73 предусматривает функциональность S7-GRAPH V5.x. Однако, 
действуют следующие ограничения: Создаваемые блоки не 
поддерживают диагностику и при мониторинге системы 
последовательного управления обеспечивают только отображение 
состояния, если Вы щелкните в области постоянных инструкций или 
на текущем активном переходе. 
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8.4.4 Настройки на закладке "Compile/Save [Компиляция и 
сохранение]": Описание интерфейса 

Описание интерфейса определяет, как в экземплярном DB создаются данные 
шагов и переходов. Данные могут храниться как массивы (ARRAY) или 
структуры (STRUCT) с более или менее детальной информацией.  

• Memory minimized [Минимизация памяти] 
Описание интерфейса хранится в экземплярном DB как структуры. 
Отдельные структуры с детальной информацией создаются для каждого 
шага и перехода секвенсора.  
Эта опция существенно сокращает требования к памяти для Вашего FB 
S7-GRAPH. Однако, создаваемый блок не совместим с диагностикой и 
только отображает состояние при мониторинге системы 
последовательного управления, если Вы щелкните в области постоянных 
инструкций или на текущем активном переходе. 
Если Вы используете эту возможность, Вы должны использовать 
поддерживающий стандартный блок FC75. 

• Structure arrays [Массивы структур]:  
Описания шагов и переходов хранятся в экземплярном DB как массивы. 
Эта возможность сокращает потребность в памяти Вашего FB S7-GRAPH. 
Однако имена шагов не сохраняются. В этом случае символьная 
адресация других блоков не возможна. 

• Individual structures [Отдельные структуры]:  
Описание  интерфейса хранится в экземплярном DB, как структуры 
(STRUCT). Они содержат предельно подробную информацию о шагах и 
переходах.  
Создаваемые блоки поддерживают все функции мониторинга и 
диагностики.  
Описание интерфейса включает также информацию о именах шагов, что 
обеспечивает внешний и внутренний доступ с использованием 
символьных имен. Экземплярный DB может обрабатываться, как 
используя прямой доступ к данным, так и с использованием имен шагов и 
переходов.  
Структуры увеличивают объем экземплярного DB, но не влияют на 
характеристики при выполнении секвенсора. 

• Interface Description [Описание интерфейса] - Download to PLC [Загрузка в 
ПЛК] 
Если Вы используете эту возможность, описание интерфейса также 
загружается в PLC, при загрузке FB с использованием S7-GRAPH. Это 
позволяет Вам декомпилировать блок на программаторе, на котором 
доступна соответствующая структура проекта. 
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8.4.5 Настройки на закладке "Compile/Save [Компиляция и 
сохранение]": Свойства секвенсора 

Свойства секвенсора определяют способ функционирования секвенсора. 

• Criteria analysis data in the DB [Данные для анализа в DB]:  
Эта возможность требуется только в том случае, если Вы не используете 
диагностику процесса с использованием стандартного приложения 
SIMATIC ProTool/ProAgent.  
Данные, необходимые для анализа, записываются в экземплярный DB, 
как дополнительная информация. Они содержат в компактной форме 
описание условий секвенсора. 

• Skip Steps [Пропуск шагов] 
Если оба перехода, перед шагом и после него, удовлетворены 
одновременно, шаг не становится активным и пропускается. 

• Acknowledge Errors [Квитирование ошибок]  
Если при функционировании возникает ошибка супервизора (выполняется 
условие супервизора), она должна быть квитирована входным 
параметром "ACK_EF", чтобы разрешить контролеру продолжение 
функционирование. Эта опция недоступна, если Вы выбрали вариант "FB 
Parameters: Minimum [Параметры FB: Минимум]". 

• Synchronization (>= V4.x) [Синхронизация (>= V4.x)]:  
Синхронизация это функция S7-GRAPH, позволяющая найти возможные 
точки синхронизации между программой и процессом, когда секвенсор 
находится в ручном режиме. 
В ручном режиме, в частности, бывает целесообразно непрерывно 
вычислять все блокировки. С этой целью, Вы можете выбрать здесь 
постоянное вычисление блокировок. При функционировании отображение 
состояния (команда меню Debug > Monitor [Отладка > Монитор]) 
показывает не выполняемые условия блокировки и, вместе с тем, шаги в 
которых могла бы быть неполадка. 

• Lock operating mode selection [Блокировать выбор рабочего режима]:  
Если Вы выбираете этот параметр, становится невозможным изменение 
режима работы от программатора или операторской панели (например, в 
диалоговом окне "Control Sequencer [Управление секвенсором]"). 

• Safe activation mode [Безопасный режим активации]:  
Когда шаг активируется, система обнаруживает и деактивирует все шаги, 
которые не могут быть активны в тот момент времени, когда активируется 
шаг, вследствие структуры секвенсора. Если, например, активируется шаг 
в альтернативной ветви, все шаги в других ветвях будут деактивированы. 
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8.4.6 Настройки на закладке "Compile/Save [Компиляция и 
сохранение]": Предупреждения 

Во время компиляции, S7-GRAPH сообщения об ошибках и на закладке 
"Compile/Decompile Messages [Сообщения компилятора и декомпилятора]". 
Отображение  предупреждений можно отключить:  

• Non [Нет]: Предупреждения, возникающие во время компиляции не. 

• All [Все]: Все предупреждения, возникающие во время компиляции 
отображаются на закладке "Feedback/Compiler messages [Сообщения 
компилятора и декомпилятора]" 

8.4.7 Настройки на закладке "Messages [Сообщения]"  

Применимость установок 
• Если Вы щелкните на этой закладке с использованием команды меню 

Options > Application Settings [Возможности > Установки 
приложения], установки применимы ко всем вновь создаваемым блокам. 

• Если Вы щелкните на этой закладке с использованием команды меню 
Options > Block Settings [Возможности > Установки блока], установки 
применимы к текущему открытому блоку. 

Настройки на закладке "Messages [Сообщения]": 
Message Handling [Обработка сообщений] 

• None [Нет]: 
Сообщения не генерируются. 

• Messages with WR_USMSG (SFC52) [Сообщения с использованием 
WR_USMSG (SFC52)]: 
Здесь Вы определяете, должны или нет вводиться в диагностический 
буфер сообщения об ошибках блокировки или супервизора. 
And then send [Посылать]: 
Щелкните на этом боксе выбора, если Вы также хотите послать 
сообщения сетевым узлам (например, OP). 

• Message with ALARM_SQ/ALARM_S (SFC17/SFC18) [Сообщения с 
использованием ALARM_SQ/ALARM_S (SFC17/SFC18)]: 
При использовании этой опции, номера сообщений и номера шагов 
вводятся в память сообщений CPU и посылаются отсюда в 
зарегистрированные узлы. 
Чтобы разрешить операторской панели отображение текста сообщений и 
другой возможной информации при появлении ошибок, Вы должны 
сначала создать проект OP. Данные для этого создаются S7-GRAPH, если 
Вы выберите вариант "Generate PDIAG Data [Генерировать данные 
PDIAG]" на закладке "General [Общее]" (команда меню Options > 
Application Settings [Возможности > Настройки приложения]). 

- Interlock with acknowledgment [Блокировка с квитированием] 
Если Вы отметите этот бокс выбора, сообщения о ошибках 
блокировки должны квитироваться. 
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- Supervision with acknowledgment [Супервизор с квитированием]  
Если Вы отметите этот бокс выбора, сообщения о ошибках 
супервизора должны квитироваться. 

Следующие вводы возможны только в диалоговом окне "Application Settings 
[Настройки приложения]". Однако они применимы и к текущему блоку. 

Create the Messages [Создание сообщений]: 
• Interlock [Блокировка]: 

Сообщения о блокировке могут создаваться как сообщения о событиях 
или как аварийные сообщения. Напишите текст сообщения в текстовом 
поле. Этот текст сообщения вводится в проект OP одновременно с 
диагностическими данными. S7-GRAPH динамически расширяет текст 
текущей информацией. 

• Supervision conditions [Условия супервизора]:  
Сообщения супервизора могут создаваться как сообщения о событиях 
или как аварийные сообщения. Напишите текст сообщения в текстовом 
поле. Этот текст сообщения вводится в проект OP одновременно с 
диагностическими данными. S7-GRAPH динамически расширяет текст 
текущей информацией. 

8.5 Сохранение 

Вычисление требований к памяти 

Требования к памяти FB с полным кодом 
С помощью следующей формулы, Вы можете оценить, сколько места 
требуется для FB S7-GRAPH и экземплярного DB в рабочей памяти (n = 
число шагов).  

FB = 4900 Byte + n * 130 Byte
DB = 270 Byte + n * 70 Byte

 
Применимы следующие предположения: 

• Опция "with criteria analysis data [c данными анализа]" на закладке 
"Compile [Компиляция]" не выбрана. 

• Каждый шаг содержит в среднем 1.2 перехода, 1.5 действия и 0.8 
функций мониторинга времени. 

• Каждый переход содержит в среднем 3.5 условия. 

Если в переходах, блокировках или супервизорах запрограммировано 
много больше условий, требования к памяти могут быть существенно 
увеличены. Требуется 10-12 байт на условие и 6-8 байт на действие. 
Сложный доступ, действия с назначением и тому подобное могут также 
существенно увеличить требования к памяти . 

Исходя из этого, ясно, что теоретически возможно максимум 250 шагов.  
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Требования к памяти  при использовании FC70, FC71, FC72 or FC73 
Для экономии памяти Вы можете перенести системную функциональность в 
один из поставляемых стандартных блоков. Это сокращает размер каждого 
блока S7-GRAPH примерно на 5000 байт. Однако потребность в памяти для 
самого стандартного блока возрастает (однократно) (FC70 около 8200 байт, 
FC71 около 7750 байт, FC72 около 10700 байт, FC73 около 8150 байт). 

Вы можете проверить, какая стандартная FC соответствует Вашей 
конфигурации, по таблице в разделе "Использование стандартных 
функциональных блоков FC70, FC71, FC72 и FC73". 

Требования к памяти  при использовании FC73 
Если Вы используете FC73, Вы можете значительно сократить требования к 
памяти FB S7-GRAPH. Опция "Full-Code [Полный код]" не доступна для этой 
модели минимизации памяти. 

Применимы также следующие ограничения:  

• Созданные блоки не поддерживают диагностику. 

• При мониторинге системы последовательного управления, Вы можете 
наблюдать состояние не всех, а только выбранных обрабатываемых 
условий. 

С помощью следующей формулы, Вы можете оценить, сколько места 
требуется для FB S7-GRAPH и экземплярного  DB в рабочей памяти (n = 
число шагов). 

FB = 150 Byte + n * 16 Byte
DB = 236 Byte + n * 26 Byte

 
Каждое запрограммированное условие требует дополнительно 2-4 байта, 
каждое действие требует 6-8 байт. 
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Использование стандартных функциональных блоков FC70, FC71, FC72, и 
FC73 

Следующая таблица показывает Вам, какие FC подходят Вам для Ваших 
условий. Если в Вашей программе используются различные FB S7-GRAPH, 
целесообразно использовать общую стандартную функцию для всех FB, так 
чтобы не требовалось загружать более одной стандартной FC в Ваш CPU. 

 
 Полный код Стандартная 

FC70 
Стандартная 
FC71 

Стандартная 
FC72 

Стандартная 
FC73 

Требования к 
памяти  

Зависит от 
числа и 
размеров 
секвенсоров  

Примерно 8200 
байт  
 

Примерно 7750  
 

Примерно 
10700  
 

Примерно 8150 
байт 

Ограничения 
с точки 
зрения задачи 

Нет 
ограничений 
 

Арифметичес-
кие функции, 
таймеры и 
счетчики могут 
использовать-
ся только с 
S7-GRAPH 
V5.1 и выше  

Нет  параметров, 
определяемых 
пользователем, 
арифметические 
функции, тайме-
ры и счетчики 
могут использо-
ваться только с 
S7-GRAPH V5.1 
и выше, нет 
сообщений с  
SFC17/SFC18,  
однако сообще-
ния можно посы-
лать с SFC52 
 

Нет 
ограничений  
 

Нельзя посылать 
сообщений и 
следовательно 
нет соединения с 
диагностикой 
процесса  
Нет времени 
активации шага  
(.U) 
Не доступна 
опция "Skip Steps 
[пропуск шага]"  
Не возможна 
пользователь-
ская нумерация 
шагов и перехо-
дов  

Ограничения 
со стороны 
CPU 

менее 8 
кбайт и 
возможность 
загрузки в 
малые CPU. 
Особенно 
подходит для 
малых 
приложений 
(например, 30 
шагов) 

Можно 
загружать 
только в CPU, 
которые имеют  
SFC17 и SFC18 
(ALARM_S и 
ALARM_SQ). 
 

Нет ограничений  
 

Из-за 
ограничения в 
8 кбайт, не 
может быть 
загружена во: 
все CPU 313  
все CPU314  
все CPU314 
IFM  
CPU315-1 (до 
версии -1AF02)  

Нет ограничений  

CPU Нет 
специальных 
требований. 
Ограничение 
8 кбайт 
относится, 
как к FB, так и 
к DB. 
 

Можно 
загружать 
только в CPU, 
которые имеют  
SFC17 и SFC18 
(ALARM_S и 
ALARM_SQ). 
(все CPU S7-
400 и некото-
рые  CPU S7-
300) 

Нет ограничений  
 

CPU должны 
быть совмес-
тимы с загру-
жаемыми бло-
ками, которые 
больше 8 кбайт 
(все CPU 
S7-400 и 
S7-300 начиная 
с версии -
1AF03 / -2AF03 
CPU315 и  
старше) 

Нет ограничений  
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Сохранение FB S7-GRAPH или исходного файла S7-GRAPH 

   
 

Когда Вы сохраняете открытый объект (блок или исходный файл), имеются 
следующие возможности: 

1. Выберите команду меню File > Save [Файл > Сохранить] или щелкните на 
кнопке "Save [Сохранить]"  в панели инструментов. Объект сохраняется 
под предустановленным именем. 

2. Вам требуется копия текущего объекта, выберите команду меню File > 
Save As [Файл > Сохранить как]. В появившемся диалоге "Save As 
[Сохранить как]" Вы можете определить имя объекта и путь для 
копирования.  

3. Если Вы выберите команду меню File > Close [Файл > Закрыть], кнопку 
Close или команду меню File > Exit [Файл > Выход] и измененный объект 
еще не сохранен, появится запрос, хотите ли Вы сохранить или отбросить 
изменения, или отменить команду Close [Закрыть]. 

 
 Предупреждение 

Если в секвенсоре остаются ошибки, он не может быть сохранен как FB. В 
качестве альтернативы, Вы можете сохранить его как исходный файл 
S7-GRAPH, с которым Вы можете продолжить работу. Это позволяет Вам 
установить ошибки позднее. 
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8.6 Компиляция 

В результате компиляции создается программа, которая может быть 
загружена в CPU. При компиляции проверяется синтаксис программы, 
создается FB S7-GRAPH и, если необходимо, экземплярный DB. 

Требования  
До компиляции FB должны быть устранены все ошибки. Вы можете проверить 
Ваш блок S7-GRAPH следующим образом: 

• Или выполнить проверку правильности блока до компиляции, или  

• Неоднократно компилировать. 

Методы компиляции секвенсоров  
• Проверка правильности 

Выполняя проверку правильности, Вы можете обнаружить синтаксические 
ошибки Вашей программы без ее компиляции. Вы можете использовать 
проверку правильности как для FB S7-GRAPH, так и для исходного файла  
S7-GRAPH. 

• Автоматическая компиляция при сохранении FB S7-GRAPH  
Если Вы программируете секвенсор FB S7-GRAPH, компиляция является 
частью сохранения. 

• Компиляция исходного файла S7-GRAPH  
Если Вы программируете секвенсор, как исходный файл S7-GRAPH, Вы 
можете начать компиляцию явным образом. 

• Устранение ошибок после компиляции или после проверки 
правильности  
Все ошибки, которые появляются при компилировании, отображаются в 
окне сообщений. Окно сообщений прикрепляется к рабочей области и 
может включаться и выключаться кнопкой в панели инструментов. 

Проверка правильности  
Используя проверку правильности, Вы можете найти синтаксические ошибки 
Вашей программы без ее компилирования. Вы можете использовать проверку 
правильности как для FB S7-GRAPH, так и для исходного файла  S7-GRAPH. 

1. Выберите команду меню File > Consistency Check [Файл > Проверка 
правильности].  
Результат: При завершении проверки правильности число обнаруженных 
ошибок отображается на закладке "Compile/Decompile Messages 
[Сообщения компилятора и декомпилятора]" и все ошибки перечисляются 
по отдельности. 

2. Исправить отображаемые ошибки. 
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Автоматическая компиляция при сохранении FB S7-GRAPH 
Если Вы программируете секвенсор как FB S7-GRAPH, компиляция 
выполняется при сохранении. 

1. Выберите команду меню File > Save [Файл > Сохранить] или щелкните на 
соответствующей кнопке.  
FB S7-GRAPH автоматически компилируется при сохранении. 

2. Проверьте информацию о ошибках на закладке "Compile/Decompile 
Messages [Сообщения компилятора и декомпилятора]" и исправьте их. 
Сохраните FB снова. 

 
 Предупреждение 

Если обнаружены ошибки, S7-GRAPH не создает FB. Вы должны устранить 
все ошибки, чтобы иметь возможность сохранить FB S7-GRAPH. 

Компиляция исходного файла S7-GRAPH  
 Если Вы программируете секвенсор, как исходный файл S7-GRAPH, Вы 
можете запустить компиляцию явным образом. 

1. Выберите команду меню File > Compile [Файл > Сохранить] или 
щелкните на соответствующей кнопке. 

Результат: FB S7-GRAPH автоматически создается из исходного файла. 

2. Проверьте информацию о ошибках на закладке "Compile/Decompile 
Messages [Сообщения компилятора и декомпилятора]" и исправьте их. 
Затем скомпилируйте исходный файл снова 

 
 Предупреждение 

Если показаны ошибки, S7-GRAPH не создает FB. Вы должны сначала 
устранить ошибки, чтобы иметь скомпилировать файл в FB. 

Устранение ошибок после компиляции или после проверки правильности 
Все ошибки, которые появляются при компилировании, отображаются на 
закладке сообщений "Compile/Decompile [Компилятор и декомпилятор]". Эта 
закладка является составной частью окна детального представления и может 
включаться и выключаться команда меню View > Details [Вид > Детали]. 
Для устранения ошибок, выполните следующее: 

1. Найдите ошибку в программе двойным щелчком на сообщении об ошибке 
в окне сообщений.  

2. Нажмите клавишу F1, чтобы получить описание ошибки и способов ее 
устранения.  

3. Исправьте секвенсор или программу, в соответствии с описаниями.  

Другие ошибки могут быть найдены командой меню Edit > Go To > Previous 
Error  или Edit > Go To > Next Error [Редактировать > Перейти > 
Следующая ошибка].
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9 Назначение параметров FB S7-GRAPH и 
вызов  

9.1 Вызов FB S7-GRAPH в программе S7  

Чтобы загруженный FB S7-GRAPH мог выполняться CPU, он должен 
вызываться из циклически выполняемого блока. Этот вызов может быть из 
OB1 или другого FB или FC, вызванного из OB1. 
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9.2 Вызов FB S7-GRAPH  

Программирование логического блока (например, OB1, FBn,...), в котором 
должен вызываться FB S7-GRAPH на одном из языков программирования 
STEP 7 (например, LAD, FBD, STL, SCL):  

• Вы программируете в STL, используя команду CALL. 

• Если Вы программируете в LAD/FBD, дважды щелкните на FB в каталоге 
элементов программы. 

 
 Замечание 

Вам требуется назначать только те параметры FB, которые действительно 
необходимы для работы. 

 

Пример: Назначение параметров FB в режиме с подталкиванием 
Для вызова и управления секвенсором в режиме с подталкиванием, не 
требуются все адреса. Следующая диаграмма показывает параметры, 
которые должны быть назначены при программировании в контактной схемы. 
FB создан с стандартным набором параметров. 

 

FB секвенсора

BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
INT 
BOOL
BOOL
BOOL

INT
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL

S_NO
S_MORE

S_ACTIVE
ERR_FLT

AUTO_ON 
TAP_ON
MAN_ON 

OFF_SQ
INIT_SQ
ACK_EF
S_PREV
S_NEXT
SW_AUTO
SW_TAP
SW_MAN

S_ON 
S_OFF
T_PUSH

S_SEL

EN ENO

DB секвенсора

BOOLBOOL
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9.3 Выбор множества параметров FB  

Множество параметров Вы выбираете в зависимости, как от предполагаемого 
использования секвенсора, так и доступной памяти CPU. Размер множества 
параметров также определяет размер требуемой для FB S7-GRAPH и 
экземплярного DB памяти. 

 
Ваши задачи... ... тогда используйте  множество параметров 
Вы хотите использовать секвенсор только в автоматичес-
ком режиме. Вам не требуются дополнительные функции 
управления или мониторинга. 

� Minimum [Минимум] 

Вы хотите использовать секвенсор в различных режимах. 
Вам также требуется обратная связь от процесса и 
возможность квитирования сообщений. 

� Standard [Стандарт] 

Независимо от возможностей, предусмотренных 
стандартным набором параметров, Вам требуются 
дополнительные функции мониторинга и управления для 
обслуживания и ввода в эксплуатацию. Это множество 
параметров применяется в блоках, начиная с версии 4. 

� Maximum (as of V4) 
[Максимум (начиная с 
V4)] 

Независимо от возможностей, предусмотренных 
стандартным набором параметров, Вам требуются 
дополнительные функции мониторинга и управления для 
обслуживания и ввода в эксплуатацию. Это множество 
параметров применяется в блоках, начиная с версии 5x. 

� User-specific/Maximum (as 
of V5x) [Пользователь-
ский/ Максимум (начиная 
с V5.x)] 

 

Вы можете также изменить существующий набор параметров в окне описания 
переменных. Вы можете, например, удалить не используемые параметры из 
стандартного набора. Системные параметры нельзя изменить, однако Вы 
можете определить пользовательские параметры в соответствии с Вашими 
требованиями. 

 
 Предупреждение 

Имена определяемых параметров должны отличаться от имен шагов (и 
наоборот). 

 

Установка множества параметров 
1. Выберите команду меню Options > Block Settings [Возможности > 

Установки блока] и щелкните на закладке "Compile / Save 
[Скомпилировать / Сохранить]". 

2. Выберите настройку для "FB Parameters". 

 
 Предупреждение 

Если Вы отредактировали пользовательский набор параметров и позднее 
выбираете стандартный набор параметров на этой закладке, Вы потеряете 
пользовательские параметры. 
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9.4 Установка параметров FB 

 

FB секвенсора

BOOL INIT_SQ 
EN ENO 

DB секвенсора

BOOL BOOL 

Минимум 

FB секвенсора

BOOL 
BOOL 
BOOL 
BOOL 
BOOL 
BOOL 
BOOL 
BOOL 
INT 
BOOL 
BOOL 
BOOL 

INT 
BOOL 
BOOL 
BOOL 
BOOL 
BOOL 
BOOL 

S_NO 
S_MORE 

S_ACTIVE
ERR_FLT 

AUTO_ON 
TAP_ON 
MAN_ON 

OFF_SQ
INIT_SQ 
ACK_EF
S_PREV
S_NEXT
SW_AUTO 
SW_TAP
SW_MAN

S_ON
S_OFF
T_PUSH 

S_SEL

EN ENO 

DB секвенсора

BOOL BOOL 

Стандарт
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FB секвенсора

BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL

INT
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL

S_NO 
S_MORE 

S_ACTIVE
ERR_FLT 

AUTO_ON 
TAP_ON 
MAN_ON 

OFF_SQ
INIT_SQ 
ACK_EF

S_PREV
S_NEXT
SW_AUTO 
SW_TAP
SW_MAN

S_ON
S_OFF
T_PUSH 

S_SEL

EN ENO 

DB секвенсора

BOOLBOOL

BOOL
INT 
BOOL
BOOL
BOOL

HALT_SQ 

ZERO_OP
EN_IL
EN_SV

HALT_TM

BOOL
BOOL
BOOL
BOOL
BOOL

SQ_HALTED
TM_HALTED
OP_ZEROED
IL_ENABLED

SV_ENABLED

Максимум <= V4 DB секвенсора
FB секвенсора

INT 
BOOL 
BOOL 
TIME 
TIME (*) 

DWORD (*) 

S_NO 
S_MORE

S_ACTIVE
S_TIME 

T_NO
T_MORE 

T_CRIT 

ENO BOOL 

DWORD (*) 
WORD 
INT 
BOOL 

DWORD (*) 

S_TIMEOK 
S_CRITLOC 

S_CRITLOCERR
S_CRITSUP

S_STATE

Максимум V5/ пользоват. 

T_CRITOLD DWORD (*) 

SALL_DISP

BOOL (*) 
BOOL
BOOL
BOOL
BOOL
BOOL

SSKIP_ENABLED
SACT_DISP

SEF_DISP

BOOL
BOOL

AUTO_ON 
TAP_ON 
TOP_ON
MAN_ON 

EN_ACKREQ

BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL

OFF_SQ
INIT_SQ 
ACK_EF

ZERO_OP 
EN_IL 
EN_SV

EN_SSKIP

DISP_SEF
DISP_SALL
S_PREV

DISP_SACT
L

ENBOOL

(*) BOOL 
BOOL
BOOL
BOOL
BOOL

REG_EF

REG_S
HALT_SQ 
HALT_TM 

ACK_S

BOOL
BOOL
BOOL
BOOL
BOOL

INT
BOOL
BOOL
BOOL
BOOL
BOOL
BOOL

S_NEXT
SW_AUTO 
SW_TAP

S_OFF
T_PREV
T_NEXT 
T_PUSH 

SW_TOP 

S_SEL
S_SELOK
S_ON 

SW_MAN

ERR_FLT 

DWORD (*)
BOOL
BOOL
BOOL
BOOL
BOOL

T_CRITFLT 
ERROR 
FAULT 

IL_ENABLED
SV_ENABLED

ACKREQ_ENABLED

BOOL
BOOL
BOOL
BOOL
BOOL

SQ_ISOFF
SQ_HALTED
TM_HALTED
OP_ZEROED 

Замечание: Параметры обозначенные (*) не доступны для FC73
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9.5 Входные параметры FB S7-GRAPH  

FB реагирует на положительный фронт входного параметра (исключение EN). 
 

Параметр 
 

Тип 
данных 

Описание 
 

Мин. 
 

Стан. 
 

Макс. 
 

Поль-
зоват.  

EN BOOL Управление выполнением FB (вход 
разрешения). Если EN не подключен, FB 
всегда выполняется. 

9 9 9 9 

OFF_SQ BOOL OFF_SEQUENCE: 
Выключение секвенсора, другими словами,  
деактивация всех шагов  

 9 9 9 

INIT_SQ BOOL INIT_SEQUENCE: 
Активация начальных шагов (сброс 
секвенсора) 

9 9 9 9 

ACK_EF BOOL ACKNOWLEDGE_ERROR_FAULT: 
Квитирование всех ошибок, принудительное 
переключение к следующему шагу 

 9 9 9 

REG_EF BOOL REGISTRATE_ERROR_FAULT: 
Регистрация всех ошибок и неполадок 

   9 

ACK_S BOOL ACKNOWLEDGE_STEP: 
Квитирование шага, показанного на S_NO 

   9 

REG_S BOOL REGISTRATE_STEP: 
Регистрация шага, показанного на S_NO 

   9 

HALT_SQ BOOL HALT_SEQUENCE: 
Останов/реактивация секвенсора 

  9 9 

HALT_TM BOOL HALT_TIMES: 
Останов/реактивация всех таймеров 
активности шагов секвенсора и инструкций, 
зависящих от времени (L и D)  

  9 9 

ZERO_OP BOOL ZERO_OPERANDS: 
Сброс в 0 всех адресов инструкций N, D, L в 
активных шагах и не выполнение команд 
CALL в действиях /реактивация адресов и 
команды CALL. 

  9 9 

EN_IL BOOL ENABLE_INTERLOCKS: 
Деактивация/реактивация блокировок 
(поведение секвенсора как при выполнении 
блокировок) 

  9 9 

EN_SV BOOL ENABLE_SUPERVISORS: 
Деактивация/реактивация условий 
супервизора (поведение секвенсора как при 
невыполнении условий супервизора) 

  9 9 

EN_ACKREQ BOOL ENABLE_ACKNOWLEDGE_REQUIRED: 
Активация обязательного квитирования 

   9 

DISP_SACT BOOL DISPLAY_ACTIVE_STEPS: 
Отображать только активные шаги 

   9 

DISP_SEF BOOL DISPLAY_STEPS_WITH_ERROR_OR_FAULT: 
Отображать только шаги с ошибками и 
неполадками 

   9 

DISP_SALL BOOL DISPLAY_ALL_STEPS: 
Отображать все шаги 

   9 
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Параметр 
 

Тип 
данных 

Описание 
 

Мин. 
 

Стан. 
 

Макс. 
 

Поль-
зоват.  

S_PREV BOOL PREVIOUS_STEP: 
Автоматический режим: Шаг назад 
относительно текущего активного шага. 
Номер шага показан на S_NO. 
Ручной режим: Показывает номер 
предыдущего шага (следующий меньший 
номер) на S_NO. 

 9 9 9 

S_NEXT BOOL NEXT_STEP: 
Автоматический режим: Шаг вперед 
относительно текущего активного шага. 
Номер шага показан на S_NO.  
Ручной режим: Показывает номер 
следующего шага (следующий больший 
номер) на S_NO. 

 9 9 9 

SW_AUTO BOOL SWITCH_MODE_AUTOMATIC: 
Изменение режима: 
Автоматический режим: 

 9 9 9 

SW_TAP BOOL SWITCH_MODE_TRANSITION_AND_PUSH: 
Изменение режима: 
Режим с подталкиванием ("полуавтомат") 

 9 9 9 

SW_TOP BOOL SWITCH_MODE_TRANSITION_OR_PUSH: 
Изменение режима: 
Автомат или переключение к следующему 

   9 

SW_MA 
 
 
 
 
 
N 

BOOL SWITCH_MODE_MANUAL: 
Изменение режима: 
Ручной режим (автоматическое выполнение 
не включено) 

 9 9 9 

S_SEL INT STEP_SELECT: 
Выбор определенного шага для выходного 
параметра S_NO. Активация/деактивация в 
ручном режиме с S_ON, S_OFF. 

 9 9 9 

S_SELOK BOOL STEP_SELECT_OK: 
Использовать переменную на S_SEL для 
S_NO 

   9 

S_ON BOOL STEP_ON: 
Ручной режим: Активация отображаемого 
шага 

 9 9 9 

S_OFF BOOL STEP_OFF: 
Ручной режим: деактивация отображаемого 
шага  

 9 9 9 

T_PREV BOOL PREVIOUS_TRANSITION: 
Отображать предыдущий открытый переход 
на T_NO 

   9 

T_NEXT BOOL NEXT_TRANSITION: 
Отображать следующий открытый переход 
на T_NO  

   9 
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Параметр 
 

Тип 
данных 

Описание 
 

Мин. 
 

Стан. 
 

Макс. 
 

Поль-
зоват.  

T_PUSH BOOL PUSH_TRANSITION: 
Переход передает управление когда 
условие выполняется и появляется фронт  
или пошаговый режим (SW_TOP) 
Если блок версии V4 (или более старый), 
срабатывает первый открытый переход. 
Если версия V5 и если определен входной 
параметр T_NO,  срабатывает переход, 
номер которого отображается.  
В противном случае срабатывает первый 
открытый переход. 

 9  9 9 

EN_SSKIP BOOL ENABLE_STEP _SKIPPING: 
Активация пропуска шага 

   9 

       

Множество параметров: Mин. = Минимум; Стан. = Стандарт; Макс. = Максимум; Пользоват. = 
Определенное пользователем 
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9.6 Выходные параметры FB S7-GRAPH 

 
Параметры 
 

Тип 
данных 

Описание 
 

Mин. Стан. Макс. 
 

Поль-
зоват. 

ENO BOOL Разрешение выхода. Когда FB активен, 
и нет ошибок, ENO имеет значение 1, в 
другом случае 0 

9 9 9 9 

S_NO INT STEP_NUMBER 
Отображает номер шага 

 9 9 9 

S_MORE BOOL MORE_STEPS: 
Другие шаги существуют и могут быть 
выбраны в S_NO 

 9 9 9 

S_ACTIVE BOOL STEP_ACTIVE 
Отображаемый шаг активен  

 9 9 9 

S_TIME TIME STEP_TIME 
Время активации шага 

   9 

S_TIMEOK TIME STEP_TIME_OK: 
Нет ошибок во время активации шага  

   9 

S_CRITLOC DWORD STEP_CRITERIA 
Биты критериев блокировки  

   9 

S_CRITLOC 
ERR 

DWORD S_CRITERIA_IL_LAST_ERROR: 
Биты критериев блокировки для 
события L1 

   9 

S_CRITSUP DWORD STEP_CRITERIA 
Биты критериев супервизора 

   9 

S_STATE WORD STEP_STATE: 
Биты состояния шага 

   9 

T_NO INT TRANSITION_NUMBER: 
Номер открытого перехода  

   9 

T_MORE BOOL MORE_TRANSITIONS: 
Другие открытые переходы доступны 
для отображения 

   9 

T_CRIT DWORD TRANSITION_CRITERIA: 
Биты критериев перехода 

   9 

T_CRITOLD DWORD T_CRITERIA_LAST_CYCLE: 
Биты критериев перехода последнего 
цикла 

   9 

T_CRITFLT DWORD T_CRITERIA_LAST_FAULT: 
Биты критериев перехода для события 
V1 

   9 

ERROR BOOL БЛОКИРОВКА_ERROR: 
Ошибка блокировки (любой шаг) 

   9 

FAULT BOOL СУПЕРВИЗОР_FAULT: 
Ошибка супервизора (любой шаг) 

   9 

ERR_FLT BOOL IL_ERROR_OR_SV_FAULT: 
Групповая неполадка 

 9 9 9 

SQ_ISOFF BOOL SEQUENCE_IS_OFF: 
Секвенсор пуст (нет активных шагов) 

   9 

SQ_HALTED BOOL SEQUENCE_IS_HALTED: 
Секвенсор остановлен 

  9 9 
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Параметры 
 

Тип 
данных 

Описание 
 

Mин. Стан. Макс. 
 

Поль-
зоват. 

TM_HALTED BOOL TIMES_ARE_HALTED: 
Таймеры остановлены 

  9 9 

OP_ZEROED BOOL OPERANDS_ARE_ZEROED: 
Адреса сброшены 

  9 9 

IL_ENABLED BOOL INTRLOCK_IS_ENABLED: 
Блокировка разрешена 

  9 9 

SV_ENABLED BOOL SUPERVISOR_IS_ENABLED: 
Супервизор разрешен 

  9 9 

ACKREQ_EN 
ABLED 

BOOL ACKNOWLEDGE_REQUIRED_IS_ 
ENABLED: 
Активировано обязательное 
квитирование 

   9 

SSKIP_EN 
ABLED 

BOOL STEP_SKIPPING_IS_ENABLED: 
Активирован пропуск шага 

   9 

SACT_DISP BOOL ACTIVE_STEPS _WERE_DISPLAYED: 
Отображение только активных шагов 
на S_NO 

   9 

SEF_DISP BOOL STEPS_WITH_ERROR_FAULT_WERE_ 
DISPLAYED: 
Отображение только шагов с 
ошибками и неполадками на S_NO 

   9 

SALL_DISP BOOL ALL_STEPS_WERE_DISPLAYED: 
Отображение всех шагов на S_NO 

   9 

AUTO_ON BOOL AUTOMATIC_IS_ON: 
Индикация автоматического режима 

 9 9 9 

TAP_ON BOOL T_AND_PUSH_IS_ON: 
Индикация режима с подталкиванием 

 9 9 9 

TOP_ON BOOL T_OR_PUSH_IS_ON: 
Индикация режима SW_TOP  

   9 

MAN_ON BOOL MANUAL_IS_ON: 
Показывает ручной режим 

 9 9 9 

Множество параметров: Мин. = минимальное; Стан. = стандартное; Макс. = максимальное; 
Пользоват. = определенное пользователем 
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9.7 Режимы системы последовательного управления 

Выбрав один из четырех возможных режимов, Вы определяете, как секвенсор 
переключается от одного шага к другому. Задав соответствующие параметры 
для FB S7-GRAPH, Вы можете выбрать требуемый режим системы 
последовательного управления. Возможны следующие режимы: 

• Автоматический режим: В автоматическом режиме управление 
передается следующему шагу, если удовлетворены условия перехода. 

• Ручной режим: 
В отличие от автоматического режима, в ручном режиме, следующий шаг 
не разрешается, когда выполняется условие перехода. Шаги выбираются 
и отменяются вручную. 

• Режим с подталкиванием: 
Режим с подталкиванием соответствует автоматическому режиму с 
дополнительным условием разрешения шага. Должен выполняться не 
только переход, но также появляться положительный фронт параметра 
T_PUSH для передачи управления на следующий шаг. 

• Автомат или переключение к следующему 
В режиме "Автомат или переключение к следующему», управление 
передается к следующему шагу, когда выполнены или когда появляется 
положительный фронт параметра T_PUSH. 

Предпосылки для работы в различных режимах 
Автоматический режим стандартный режим секвенсора. Он установлен по 
умолчанию для всех множеств параметров FB S7-GRAPH. 

Чтобы разрешить другие режимы, Вы должны скомпилировать FB S7-GRAPH 
с стандартным, максимальным или пользовательским множеством 
параметров. 

Выбираемые режимы 
Вы выбираете один из четырех режимов, используя входные параметры FB. 
Положительный фронт одного из следующих параметров активирует 
соответствующий режим. 

• SW_AUTO (Автоматический режим) 

• SW_MAN (Ручной режим) 

• SW_TAP (Режим с подталкиванием) 

• SW_TOP (Автомат или переключение к следующему) 
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9.7.1 Автоматический режим (SW_AUTO) 

В автоматическом режиме управление передается следующему шагу, когда 
выполняется условие перехода. 

Входные параметры в автоматическом режиме 
Не приведенные параметры – не зависят от режима.  

 
Параметр Данные Описание 
OFF_SQ BOOL Секвенсор выключен; другими словами, деактивируются все 

шаги 
INIT_SQ BOOL Инициализация секвенсора, скачок к начальному шагу  
ACK_EF BOOL Квитирование всех ошибок, принудительное переключение 

к следующему шагу 
S_PREV BOOL Шаг назад, относительно текущего активного шага. Номер 

шага показан на S_NO. 
S_NEXT BOOL Шаг вперед, относительно текущего активного шага. Номер 

шага показан на S_NO. 
SW_TAP BOOL Требование режима с подталкиванием 
SW_MAN BOOL Требование ручного режима 
SW_TOP BOOL Требование режима «Автомат или переключение к 

следующему» 

Выходные параметры в автоматическом режиме 
 
Параметр Данные Описание 
S_NO INT Отображать активный шаг, выбранный S_PREV или S_NEXT 
S_MORE BOOL Существуют другие активные шаги, которые могут быть 

выбраны на S_NO  
S_ACTIVE BOOL Шаг, показанный в S_NO, активен 
ERR_FLT BOOL Возникла ошибка или неполадка  
AUTO_ON BOOL Автоматический режим активен  
TAP_ON BOOL Режим с подталкиванием не активен  
MAN_ON BOOL Ручной режим не активен 
TOP_ON BOOL Режим «Автомат или переключение к следующему» не активен  
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9.7.2 Ручной режим (SW_MAN) 

Ручной режим выбирается, например, для проверки секвенсора. Ручной 
режим характеризуется следующим: 

1. Следующий шаг не разрешается, когда выполнены условия перехода  

2. Шаги можно выбирать и отменять вручную  

Входные параметры в ручном режиме 
Не приведенные параметры – не зависят от режима.  
 
Параметр Данные Описание 
OFF_SQ BOOL Все шаги немедленно деактивируются, другими словами,   

"Секвенсор выключается" 
INIT_SQ BOOL Инициализация секвенсора, скачок к начальному шагу 
ACK_EF BOOL Квитирование всех ошибок 
S_PREV BOOL Показать в S_NO предыдущий шаг 
S_NEXT BOOL Показать в S_NO следующий шаг  
SW_AUTO BOOL Требование автоматического режима 
SW_TAP BOOL Требование режима с подталкиванием 
SW_TOP BOOL Требование режима «Автомат или переключение к 

следующему» 
S_SEL INT Номер шага для выбора, показанного на S_NO вследствие  

выбора 
S_ON BOOL Шаг, показанный в S_NO, активирован 
S_OFF BOOL Шаг, показанный в S_NO, деактивирован 

Выходные параметры в ручном режиме  
 
Параметр Данные Описание 
S_NO INT Номер шага, показывающий выбранный шаг  
S_MORE BOOL Существуют другие шаги, которые могут быть выбраны на 

S_NO 
S_ACTIVE BOOL Шаг, показанный в S_NO, активен 
ERR_FLT BOOL Возникла ошибка или неполадка 
AUTO_ON BOOL Автоматический режим не активен 
TAP_ON BOOL Режим с подталкиванием не активен 
MAN_ON BOOL Ручной режим активен 
TOP_ON BOOL Режим «Автомат или переключение к следующему» не 

активен 
 

 Предупреждение 
Входные параметры DISP_SACT, DISP_SEF, DISP_SALL влияют на номер 
шага, отображаемый параметром S_NO.  

В ручном режиме, неподходящее назначение парaметров приводит к тому, 
что шаг не отображается.  

Если Вы хотите отобразить все шаги, установите параметр DISP_SALL в 
TRUE или удалите три входных параметра DISP_SACT, DISP_SEF, 
DISP_SALL.  
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9.7.3 Режим с подталкиванием (SW_TAP) 

Для настройки или тестирования системы шаг за шагом может быть очень 
полезен режим с подталкиванием : 

• Секвенсор передает управление, когда выполняется условие перехода и 
возникает положительный фронт (переключение из 0 в 1) в параметре 
T_PUSH. 

Входные параметры режима с подталкиванием 
Не перечисленные параметры не зависят от режима.  

 
Параметр Данные Описание 
OFF_SQ BOOL Все шаги немедленно деактивируются, другими словами,   

"Sequencer Off [Секвенсор выключен]" 
INIT_SQ BOOL Инициализация секвенсора, скачок к начальному шагу 
ACK_EF BOOL Квитирование всех ошибок 
S_PREV BOOL Как для автоматического 
S_NEXT BOOL Как для автоматического 
SW_AUTO BOOL Требование автоматического режима 
SW_MAN BOOL Требование ручного режима 
SW_TOP BOOL Требование режима «Автомат или переключение к 

следующему» 
T_PUSH BOOL Переход передает управление, когда возникает 

положительный фронт на T_PUSH и одновременно 
выполняется условие перехода. 

Выходные параметры режима с подталкиванием  
 
Параметр Данные Описание 
S_NO INT Номер шага, показывает выбранный шаг 
S_MORE BOOL Существуют другие активные шаги, которые могут быть 

выбраны на S_NO 
S_ACTIVE BOOL Отображаемый шаг активен 
ERR_FLT BOOL Появляется ошибка или неполадка  
AUTO_ON BOOL Автоматический режим не активен 
TAP_ON BOOL Режим с подталкиванием активен  
MAN_ON BOOL Ручной не активен 
TOP_ON BOOL Режим «Автомат или переключение к следующему» не 

активен 
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9.7.4 Режим «Автомат или переключение к следующему 
(SW_TOP)» 

 начального запуска проекта или пошагового тестирования управляющей 
системы может успешно применяться режим "automatic or switch to next 
[Автоматический или переключение к следующему режиму]": 

• Секвенсор выполняется когда открыт переход или когда возникает 
положительный фронт парaметра T_PUSH. 

Входные параметры режима «Автомат или переключение к следующему»  
Не перечисленные параметры не зависят от режима.  

 
Параметр  Данные  Описание 
OFF_SQ BOOL Все шаги немедленно деактивируются, другими словами,   

"Sequencer Off [Секвенсор выключен]" 
INIT_SQ BOOL Инициализация секвенсора, скачок к начальному шагу 
ACK_EF BOOL Квитирование всех ошибок 
S_PREV BOOL Как для автоматического 
S_NEXT BOOL Как для автоматического  
SW_AUTO BOOL Требование автоматического режима 
SW_MAN BOOL Требование ручного режима 
SW_TAP BOOL Требование режима с подталкиванием 
T_PUSH BOOL Переход, независимо от выполнения условий перехода, 

передает управление, когда возникает положительный 
фронт на T_PUSH. 

Выходные параметры режима «Автомат или переключение к следующему» 
 
Параметр Данные Описание 
S_NO INT Номер шага, показывает выбранный шаг 
S_MORE BOOL Существуют другие активные шаги, которые могут быть 

выбраны на S_NO 
S_ACTIVE BOOL Отображаемый шаг активен 
ERR_FLT BOOL Появляется ошибка или неполадка  
AUTO_ON BOOL Автоматический режим не активен 
TAP_ON BOOL Режим с подталкиванием активен  
MAN_ON BOOL Ручной режим не активен 
TOP_ON BOOL Режим «Автомат или переключение к следующему» активен 
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9.7.5 Выбор шага с S_SEL 

1. Установите ручной режим, используя входной параметр SW_MAN 
(положительный фронт). 

2. Введите номер желаемого шага, используя входной параметр S_SEL. 
Если в модели компиляции существует входной параметр S_SELOK, Вы 
можете подтвердить выбор номера шага, используя параметр. Тогда шаг 
отображается. 

3. Активируйте выбранный шаг входным параметром S_ON (положительный 
фронт). 

Если секвенсор имеет пути в параллельных ветвях и Вы хотите выбрать 
более одного шага повторите шаги 2 и 3. 

9.7.6 Выбор шага с использованием S_PREV или S_NEXT 

1. В зависимости от того, хотите ли Вы двигаться вперед или назад, 

- выберите предыдущий шаг (шаг с меньшим номером), используя 
входной параметр  S_PREV, 

- выберите следующий шаг (шаг с большим номером), используя 
входной параметр S_NEXT. 

2. Активируйте выбранный шаг, используя входной параметр S_ON 
(положительный фронт). 

 
 Заметьте 

Заметьте, что эта процедура может привести к некоторому увеличению 
времени реакции. 

9.7.7 Перевод к следующему шагу с T_PUSH 

1. Установите режим с подталкиванием, используя входной параметр 
SW_TAP, или режим «автомат или переключение к следующему», 
используя входной параметр SW_TOP. 

2. Подайте фронт на входной параметр T_PUSH, чтобы переключить 
переход. 
Если Вы установили параметр SW_TAP, секвенсор переключается только 
в том случае, когда выполняются условия перехода. Если Вы установили 
параметр SW_TOP, секвенсор переключается, если условия перехода не  
выполняются. 

 
 Предупреждение 

• Если блок создан для версии V4 (или более старой), переключается 
первый подходящий переход. 

• Если блок создан для версии V5 и определен входной параметр T_NO, 
включается переход, которого отображается. 
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10 Загрузка FB S7-GRAPH и экземплярного 
DB 

10.1 Загрузка блоков из программатора в CPU 

 FB S7-GRAPH в CPU 
Для загрузки программы пользователя в CPU, должны выполняться 
следующие требования: 

• Существует соединение между программатором и программируемым 
логическим контроллером. 

• Система последовательного управления состоит из FB, экземплярного  
DB и, например, OB1. 

- FB S7-GRAPH должен быть откомпилирован без ошибок. 

- должен быть создан экземплярный DB для FB S7-GRAPH. 

• Всякий раз, когда возможно, загружайте блок S7-GRAPH в режиме STOP, 
поскольку при дальнейшей загрузке экземплярного DB, секвенсор 
автоматически устанавливается в начальное состояние.  

• FB S7-GRAPH вызывается в блоке (например, OB1) который выполняется 
циклически, и блок уже загружен в CPU. 

Download with Instance DB [Загрузка с экземплярным DB]: 
Если Вы выбрали вариант "Include Instance DB [Включая экземплярный DB]" 
на закладке "General [Общее]", выбранной командой меню Options > 
Application Settings [Возможности > Настройки приложения], S7-GRAPH 
проверяет существуют ли изменения после последней загрузки 
экземплярного DB и требуется ли его обновление. Опция "Download with 
instance DB [Загрузка с экземплярным DB]" выбирается, если необходимо, в 
диалоговом окне "Download [Загрузка]". В этом случае экземплярный DB 
должен загружаться в CPU только вместе с FB. 

С другой стороны, S7-GRAPH не может проверить загруженный 
экземплярный DB, и предоставляет Вам решить, надо или нет снова 
загружать экземплярный DB.  Опция "Download with Instance DB [Загрузка с 
экземплярным DB]" не выбирается в диалоговом окне "Download [Загрузка]". 
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Download with standard FC [Загрузка с стандартной FC] 
Если Вы выбрали этот вариант командой меню Options > Block Settings 
[Возможности > Настройки блока] на закладке "Compile / Save [Компиляция 
/ Сохранение]", система проверяет, загружена ли уже стандартная FC в 
подключенный online CPU. Если FC отсутствует, она загружается. 

Turn off the sequencer before download [Отключить секвенсор перед 
загрузкой] 

При выборе этот вариант, активные структурные элементы секвенсора, ак-
тивные переходы или шаги останавливаются при загрузке программы в CPU. 

Если экземплярный DB загружен при загрузке программы, функциональный 
блок стартует с начального шага. 

Если экземпляр DB не загружен при загрузке программы, структурные эле-
менты активные до загрузки, активируются снова при завершении загрузки. 

Загрузка в CPU 
Для загрузки FB S7-GRAPH в CPU с экземплярным DB, выполните 
следующие шаги: 

1. В открытом FB выберите команду меню PLC > Download [ПЛК > Загру-
зить]. В CPU загружается FB, открытый в данное время в рабочем окне. 

2. Сделайте соответствующие настройки в диалоговом окне "Download 
[Загрузка]": 

- Если Вы выберите "Include instance DB [Включая экземплярный DB]", 
система автоматически подготавливает переменные, 
соответствующие реальной ситуации. You can change this default. 

- Если Вы не выберите "Include instance DB [Включая экземплярный 
DB]", Вы должны самостоятельно оценивать надо или нет загружать 
экземплярный DB при загрузке программы. 

- Если FB использует стандартную FC, Вы можете определить, надо 
или нет загружать эту FC при загрузке программы. Если эта FC уже 
существует интерактивно (online), эта опция деактивируется. 

3. Если блоки уже находятся в CPU, подтвердите запрос о перезаписи 
блоков. 

 Предупреждение 
Вы должны загружать блоки S7-GRAPH в режиме RUN только в том случае, 
когда секвенсор находится в начальном состоянии или выключен (состояние 
OFF). Если Вы загружаете блоки секвенсора в другом состоянии, при 
перезаписи старого блока, может возникнуть проблемы синхронизации 
секвенсора с процессом. Например, адреса действий активных шагов, как с 
фиксацией переменных, так и без фиксации, в момент загрузки останутся не 
сброшенными. 

Если невозможно изменить секвенсор в начальном или выключенном 
состоянии, перед загрузкой блоков в CPU деактивируйте все шаги (например, 
используя функцию "Control Sequencer [Управление секвенсором]"). 
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10.2 Выгрузка блоков из CPU в программатор  

Предпосылки для выгрузки блоков в программатор 
Для выгрузки FB из CPU в программатор должно быть установлено 
соединение между программатором и программируемым контроллером. 

Выгрузка блоков из CPU в программатор 
Блоки из CPU можно выгрузить в программатор, используя SIMATIC Manager 
STEP 7. SIMATIC Manager декомпилирует блоки S7-GRAPH. Вы можете после 
этого отредактировать систему последовательного управления, как это 
описано в разделе 5. Для белее подробной информации о выгрузке из CPU в 
программатор, справьтесь в интерактивной помощи в SIMATIC Manager. 

Запомните, что Вы сможете декомпилировать секвенсор снова на PG, 
который не содержит структуру проекта только в том случае, если Вы 
отметите опцию "Interface Description - Download to PLC [Описание 
интерфейса – Загрузка в ПЛК]" на закладке "Compile/Save [Компиляция и 
сохранения]" диалогового окна "Block Settings [Настройки блока]".   
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11 Мониторинг и тестирование системы 
последовательного управления  

 
Функции мониторинга позволяют Вам наблюдать и проверять программу, 
выполняемую в CPU.  

Это позволяет Вам обнаружить ошибки, которые не обнаруживаются 
формальной проверкой согласованности при написании программы или 
синтаксической проверкой во время компиляции. Эти ошибки включают: 

• Ошибки программирования, например, неправильная установка времени 
мониторинга в условии супервизора 

• Логические шибки в структуре программы, другими словами, 
программирование шагов и условий не соответствующих требуемой Вам 
реальной последовательности процесса. 

Методы тестирования системы последовательного управления 
S7-GRAPH обеспечивает Вам различные методы, с помощью которых Вы 
можете проверить систему последовательного управления. Эти методы 
разделяются на следующие классы: 

• Мониторинг информации о состоянии системы последовательного 
управления. С помощью этих функций, Вы получаете быстрый обзор 
путей функционирования секвенсора. 

• Управление секвенсором 
Независимо от управления секвенсором, использующего 
программируемый вызов FB, S7-GRAPH предусматривает также удобный 
диалог для тестового режима.  

• Синхронизация 
Синхронизация это функция S7-GRAPH, с помощью которой секвенсор 
может быть согласован с процессом. 

• Расширенные тестовые функции для мониторинга системы 
последовательного управления. Вызывая функции STEP 7 из S7-GRAPH, 
Вы можете получить дополнительную, исчерпывающую информацию о 
процессе в целом.  
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Требования к активации тестовых функций  S7-GRAPH 
До начала тестирования программы S7-GRAPH, должны быть выполнены 
следующие требования:  

1. PG должен быть интерактивно (online) связан с CPU. 

2. Программа должна быть откомпилирована без ошибок.  

3. FB S7-GRAPH должен вызываться в циклически выполняемом блоке 
(например, OB1). 

4. Программа (другими словами, FB, DB OB и, если требуется, стандартные 
FC) должны быть загружена в CPU.  

5. CPU должен находиться в режиме RUN (чтение) или RUN-P (чтение и 
запись). 

11.1 Функции мониторинга и тестирования в S7-GRAPH 

11.1.1 Наблюдение информации о состоянии 

Принципы функций мониторинга S7-GRAPH 
Когда Вы запускаете функции мониторинга, Вы также запускаете тестовый 
режим для проверки системы последовательного управления. Отдельные 
шаги и условия и сигнальное состояние адресов отображается различными 
цветами на экране в зависимости от состояния. Пошаговое выполнение 
программы можно, следовательно, визуально наблюдать на экране.   

В зависимости от текущего состояния секвенсора отражается состояние 
следующих компонентов: 

• Шаги и условия 

• Сигнальное состояние адресов 

Изменение цветовых настроек для отображения состояния 
Вы можете выбрать и установить требуемый цвет для отображения 
отдельных состояний, используя  команду меню Options > Application 
Settings [Возможности > Настройки приложения] на закладке "Editor 
[Редактор]" в диалоговом окне "Application Settings [Настройки приложения]". 



 Мониторинг и тестирование системы последовательного управления 

S7-GRAPH для S7-300/400 Программирование систем последовательного управления 
A5E00290656-01 11-3 

Отображение состояния шагов и переходов 
Состояние следующих элементов секвенсора отображается цветом: 

• Шаги: Активные шаги и шаги с ошибками показаны различными цветами. 

• Постоянные инструкции, переходы, блокировки и супервизоры: 

- Отображение показывает, какие отдельные условия выполняются 
(например, меркер или выход). 

- Отображение показывает, какие законченные логические операции, 
содержащие отдельные условия, удовлетворяются, например, для 
операции ИЛИ. 

- Отображение показывает, какие переходы в целом (T), блокировки (C) 
или супервизоры (V) выполняются. 

 

Отображение состояния сигналов адресов 
Сигнальное состояние программируемых действий отображается в шагах. 
Сигнальное состояние адресов (например, входов, выходов, меркеров) 
определяется фактическим опросом отдельных адресов. То есть эта оценка в 
чистом виде не относится к шагу. Булевские адреса отображаются на этом 
дисплее состояния. Состояния других адресов отображаются в детальном 
окне на закладке "Addresses [Адреса]". 

Если нет вызовов блоков в пределах действий, состояние не отображается. 

 

Усл..1 
.1

Усл..2 
. 2 

Условие перехода выполняется 
Усл..1 Усл.. 2

Условие перехода не выполняется 
и шаг не 
переключается Выполн.  Не выполн.

Выполн. Выполн. 
и шаг переключается

N
S1 S

A 4.2
A 4.3 

S4

S0 R A 4.4 

Шаг активен 

Выполнение секвенсора 

Состояние сигнала 

1
1
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11.1.2 Управление секвенсором 

Управление секвенсором это тестовая функция, с помощью которой Вы 
можете проверить секвенсор S7-GRAPH во всех рабочих режимах. Все 
установки и вводы в диалоговом окне имеют тот же самый эффект, что и 
соответствующие параметры FB.  

Вводы в диалоговом окне "Sequencer Control [Управление секвенсором]" 
могут отличаться от установок, использованных Вами при компиляции 
секвенсора. Установки диалогового окна имеют приоритет. 

Диалоговое окно "Sequencer Control [Управление секвенсором]" 
Диалоговое окно "Sequencer Control [Управление секвенсором]" используется 
как и как окно вывода, для отображения текущих настроек, и одновременно 
как окно для ввода текущего состояния. 

Если Вы квитируете ошибку, инициализируете секвенсор или хотите изменить 
шаг в ручном режиме, вызовите диалоговое окно "Control Sequencer 
[Управление секвенсором]" командой меню Debug > Control Sequencer 
[Отладка > Управление секвенсором]. 

Если Вы изменяете эти установки в диалоговом окне, выбранные 
оригинально установки выделяются жирным, чтобы Вы могли в любой 
момент вернуть оригинальные установки. 

Чтобы сделать возможной модификацию, переключатель режимов CPU 
должен находиться в положении RUN-P. 

11.1.3 Синхронизация 

S7-GRAPH помогает Вам обнаружить возможные точки синхронизации между 
процессом и секвенсором. 

Процесс более не синхронизирован, если он изменен в другое состояние 
вручную. Это может быть, например, результатом переключения к ручному 
режиму, в котором Вы можете активировать любой шаг, даже если 
предшествующий переход не разрешен. Чтобы разрешить автоматическое 
продолжение процесса. И обнаружить возможные точки синхронизации, Вы 
можете запустить функцию синхронизации.  

Вы должны выбрать одну из двух различных стратегий синхронизации: 

S7-GRAPH показывает все шаги, в которых предшествующие шагу переходы 
открыты, а последующие за шагом закрыты.  

Предпосылки 
• Секвенсор должен управляться в ручном режиме. 

• Вы должны выбрать стратегию синхронизации в диалогом окне 
"Application settings – General [Настройки приложения - Общее]". 

• Блок откомпилирован с опцией "Synchronization [Синхронизация]". Вы 
можете найти эту опцию на закладке "Compile / Save [Компиляция и 
сохранение]" (команда меню Options > Block Settings [Возможности > 
Установки блока] ). 
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Запуск синхронизации 

Для запуска синхронизации: 

1. Выберите команду меню Debug > Synchronization [Отладка > 
Синхронизация]. 
После этого S7-GRAPH ищет все шаги, соответствующие условию 
синхронизации. Все найденные шаги отмечаются желтым. 

2. Выберите один или более из этих шагов, используя указатель мыши, 
который принимает вид перекрестья. Вы можете также выбрать другие 
шаги не маркированные желтым. 

 
 Предупреждение 

В параллельных ветвях, каждый путь должен содержать подлежащий 
активации шаг. 

 

3. Активируйте выбранные шаги кнопкой "Activate [Активировать]". 

4. Переключите секвенсор в автоматический режим. 

11.2 Тестовые функции STEP 7 

Следующие тестовые функции доступны для дальнейшего анализа системы 
последовательного управления. Однако запомните, что не все функции 
обеспечивают доступную информацию о системе последовательного 
управления S7-GRAPH: 

• Наблюдение и изменение переменных 

• Состояние модуля 

• Опрос рабочего режима 

• Анализ сообщений CPU 

• Создание справочных данных 

• Создание диагностических данных 

• Проверка правильности блока 

Эти функции обеспечивают дальнейшие методы отладки и обеспечивают 
важной информацией о используемых блоках и адресах. Вы можете также 
выбрать эти тестовые функции непосредственно в  SIMATIC Manager. 

 
 Заметьте 

Если требуется более детальная информация о этих разделах, отобразите 
текст помощи по командам меню в SIMATIC Manager. 
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Наблюдение и изменение переменных 
Используя команду меню PLC > Monitor/Modify Variables [ПЛК > 
Наблюдение и изменение переменных], Вы можете создать таблицу 
переменных, наблюдать и модифицировать сигнальные состояния адресов 
(например, вход I2.3).  

Сигнальные состояния для мониторинга, можно скомпоновать индивидуально 
в таблице переменных,  вводя требуемые адреса в отображаемую таблицу.  

Анализ информации о модуле и режим управления  
Используя команду меню PLC > Module Information [ПЛК > Информация о 
модуле], Вы можете получить различную информацию о модуле. В качестве 
дополнительной информации о системе последовательного управления, 
содержание диагностического буфера и текущее использование рабочей и 
загрузочной памяти представляют особый интерес. 

Вы можете, например, найти причину ошибки, используя закладки "Diagnostic 
Buffer [Диагностический буфер]" и "Stacks [Стеки]".  

Используя команду меню PLC > Operating Mode [ПЛК > Режим управления], 
Вы можете проверить и изменить текущий режим CPU, например, выполнить 
рестарт. 

Анализ диагностического буфера 
Если Вы командой Options > Block Settings [Возможности > Установки 
блока] установили опцию "Message with [сообщения с использованием] 
WR_USMSG (SFC52)" на закладке "Messages [Сообщения]", S7-GRAPH 
вводит следующие сообщения в диагностический буфер: 

• Возникновение и устранение ошибки блокировки 

• Возникновение и устранение ошибки мониторинга (ошибки выполнения)  

Из детальной информации о сообщении, Вы может определить место, где 
произошла ошибка.  

 

Анализ сообщений CPU  
В SIMATIC Manager Вы можете использовать команду меню PLC > S7 
Message [ПЛК > Сообщения S7] для отображения сообщений о событиях и 
авариях.  
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Отображение справочных данных 
Для проверки системы последовательного управления Вы можете вызвать 
ряд справочной информации. Вы создаете справочные данные следующим 
способом: 

• Когда Вы сохраняете FB, справочные данные создаются, если Вы 
выбрали эту функцию на закладке "General [Общее]", которую Вы можете 
отобразить командой меню Options > Application Settings 
[Возможности > Настройки приложения]. Должна быть выбрана опция  
"Generate Reference Data [Генерировать справочные данные]". 

• Используя команду меню Options > Reference Data [Возможности > 
Справочные данные] можно создать справочные данные, когда 
требуется. После этого, S7-GRAPH вызывает диалоговое окно STEP 7 
для отображения справочных данных. 

Следующая таблица показывает доступную информацию:  

 
Список Содержание списка 
Cross-reference 
[Перекрестные ссылки] 

Обзор используемых адресов в областях памяти I, Q, M, 
P, T, C и DB в пределах программы пользователя. 

Program structure 
[Структура программы] 

Вызов иерархии блоков в пределах пользовательской 
программы и обзор используемых блоков и их 
взаимозависимостей. 

Reference list [Ссылочный 
список] 

Показывает использование: 
• Входы, выходы и меркеры  
• Таймеры и счетчики 

List of unused addresses 
[Список неиспользуемых 
адресов] 

Обзор всех символов, находящихся в символьной 
таблице, но не используемых в части пользовательской 
программы, для которой созданы справочные данные.  

List of addresses without 
symbols [Список адресов 
без символов] 

Обзор всех абсолютных адресов, которые используются в 
части пользовательской программы, для которой созданы 
справочные данные, но для которых не определен 
символ в символьной таблице.    

Если отображаются справочные данные "Program Structure [Структура 
программы]" или "Cross-Reference List [Список перекрестных ссылок]", Вы 
можете перейти к месту пользовательской программы, в котором 
используется выбранный блок или адрес используя команду меню Edit > Go 
To > Location [Редактировать > Перейти > Расположение]. 

Генерация и обновление диагностических данных 
Диагностические данные генерируются, когда Вы сохраняете FB, если Вы 
выбрали опцию "Generate PDIAG Data [Генерировать данные PDIAG]" на 
закладке "General [Общее]" в диалоговом окне "Application Settings [Настройки 
приложения]. Вы должны также выбрать опцию "Message with [Сообщения с 
использованием] ALARM_SQ/ALARM_S" на закладке "Messages [Сообщения]" 
диалогового окна "Block Settings [Настройки блока]". 
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Обновление диагностических данных после перемонтажа 
Если Вы изменили адреса в SIMATIC manager, используя команду меню 
Rewire [Перемонтаж], и эти адреса также используются в секвенсоре, 
соответствующие диагностические данные могут быть обновлены после того, 
как Вы снова откроете соответствующий  FB S7-GRAPH и сохраните его. 

Проверка правильности блока 
После того как Вы измените интерфейс блока, Вы должны адаптировать все 
блоки, которые вызывают этот блок,  в противном случае Вы получите 
несогласованную программу и конфликт временных меток. 

Вы можете вызвать функцию STEP 7 "Check Block Consistency [Проверка 
правильности блока]", чтобы начать общую проверку правильности всех 
программных изменений в блоках S7. Это позволяет Вам получить право 
контроля эффектов модификации интерфейсов в других блоках и быстрый 
способ устранения ошибок.  

Функция автоматически переключается к соответствующим позициям в 
редакторе, если несогласованность не может быть устранена автоматически . 
Тогда Вы можете отредактировать соответствующие элементы блока до 
полного устранения несогласованности.  

Порядок действий: 

Выберите команду меню Edit > Check Block Consistency [Редактировать > 
Проверка правильности блока].  

Дальнейшую информацию о этой функции Вы можете найти в помощи по  
STEP 7. 



 

S7-GRAPH для S7-300/400 Программирование систем последовательного управления 
A5E00290656-01 12-1 

12 Распечатка секвенсора  

12.1 Распечатка секвенсора  

Документирование программы 
После создания системы последовательного управления Вы в любой момент 
распечатать ее для создания документации. Распечатываются или соответ-
ствующие установки, или содержание активного окна. Уровень и масштаб, 
установленные для активного окна отображения влияют и на распечатку.  

Вы можете изменить макет страницы в соответствии с Вашими требованиями 
и проверить его предварительным просмотром печати. Вы можете настроить: 

• Уровень и масштаб отображения  

• Колонтитулы страницы 

• Формат страницы 

Облик распечатки 
Если Вы имеете многостраничную распечатку, ссылки на соседние страницы 
распечатываются на полях страницы для лучшей ориентации. Ссылки на 
предыдущие и последующие элементы также распечатываются, например, 
следующие шаги или шаги и переходы, разделенные на две страницы. 

Для большей ясности, начало перехода выравнивается вправо, а блок 
действий влево. Это  обеспечивает необходимый зазор между ветвями 
секвенсора. Пустые страницы не распечатываются. 

Условия для печати 
Распечатка из S7-GRAPH аналогична другим приложениям Windows. До 
печати принтер должен быть установлен и инициализирован в Control Panel 
Windows.  

Облик распечатки 
В диалоговом окне "Print [Печать]", Вы можете выбрать содержание текущей 
распечатки. 

• Current View [Текущий вид]:  Вид FB, выбранный в рабочей области, 
передается принтеру. 

• According to Settings [В соответствии с установками]: Независимо от 
текущего отображения используются настройки, сделанные на закладке 
"Print [Печать]" диалогового окна "Application Settings [Настройки 
приложения]". 
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Закладка "Print [Печать]" диалогового окна "Application Settings [Настройки 
приложения]" 

На закладке "Print [Печать]" диалогового окна "Application Settings [Настройки 
приложения]" Вы можете выбрать стандартные настройки печати. Вы 
выбираете требуемые настройки отметками в боксах выбора. Вы можете 
выбрать следующие компоненты распечатки: 

• Sequencer view with / without conditions and actions [Вид секвенсора с/без 
условий и действий] 

• Step view with / without address List, step comment and cross references [Вид 
шага с/без списка адресов, комментируя к шагу и перекрестных ссылок] 

• Permanent instructions with / without address list [Постоянные инструкции 
с/без списка адресов] 

• Addresses [Адреса] 

• Block properties [Свойства блока] 

• Compiler options [Опции компилятора] 

• Variables [Переменные] 

Активный блок может быть также отображен с символьными или 
абсолютными адресами и как блок LAD или FBD. 

Создание колонтитулов в SIMATIC Manager 
Чтобы задать колонтитулы документа, используйте команду меню File > 
Headers and Footers [Файл > Колонтитулы] в SIMATIC manager. 

Выбор формата страницы 
Командой меню File > Page Setup [Файл > Установки страницы] Вы можете 
выбрать формат страницы для распечатки. Формат, заданный в SIMATIC 
Manager, используется по умолчанию. 

Проверка в предварительном просмотре распечатки  
Используя команду меню File > Print Preview [Файл > Предварительный 
просмотр распечатки], Вы можете проверить все установки текущего блока 
перед посылкой блока на печать. Редактирование в этом представлении 
невозможно. 

Запуск задания на печать 
Вы можете начать печать в S7-GRAPH двумя способами:  

• Нажав кнопку "Print [Печать]" в панели инструментов.  

• Выбрав команду меню File > Print [Файл > Печать].  

Появляется диалоговое окно, в котором Вы можете выбрать настройки 
печати, такие как принтер и число копий.  

Нажмите OK, чтобы послать документ на печать. 
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13 Обзор всех действий 

S7-GRAPH использует настройку мнемоники (Немецкая или английская) 
выбранной на закладке "Language [Язык]" в SIMATIC manager по команде 
меню Options > Customize [Возможности > Настройки]. 

13.1 Стандартные действия с самоблокировкой и без  

Эти действия выполняются всякий раз при выполнении секвенсора. 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 
 
 

Констан-
та 
времени 

Разъяснение 
  

Диапа-
зон 
адресов 

 N Q, I, M, D m.n  Пока шаг активен, состояние сигнала 
для адреса = 1. 

от 0.0 до 
65535.7 

 S Q, I, M, D m.n  Когда шаг активен, адрес устанавли-
вается в 1 и остается в этом состоянии. 

от 0.0 до 
65535.7 

 R Q, I, M, D m.n  Когда шаг активен, адрес сбрасывается 
в 0 и остается в этом состоянии. 

от 0.0 до 
65535.7 

 D Q, I, M, D m.n T#<const> Через n секунд после активации шага 
состояние сигнала для адреса устанав-
ливается в 1 на время активности шага. 
Это не происходит, если шаг активен в 
течение времени, меньшего n секунд. 

от 0.0 до 
65535.7 

 L Q, I, M, D m.n T#<const> Если шаг активен, состояние сигнала 
для адреса устанавливается в 1 на 
время n секунд. 

от 0.0 до 
65535.7 

 CALL FB, FC, 
SFB,SFC 

Номер 
блока 

 Если шаг активен, вызывается заданный 
блок 

 

 NC Q, I, M, D m.n  Пока шаг активен и условие 
(блокировка) выполнено, состояние 
сигнала для адреса = 1.  

от 0.0 до 
65535.7 

 SC Q, I, M, D m.n  Когда шаг активен и условие (блокиров-
ка) выполнено, адрес устанавливается в 
1 и остается в этом состоянии. 

от 0.0 до 
65535.7 

 RC Q, I, M, D m.n  Когда шаг активен и условие (блокиров-
ка) выполнено, адрес сбрасывается в 0 
и остается в этом состоянии.  

от 0.0 до 
65535.7 

 DC Q, I, M, D m.n T#<const> Через n секунд после активации шага 
состояние сигнала для адреса устанав-
ливается в 1, если шаг активен и 
условие (блокировка) выполнено. Если  
шаг не активен, состояние сигнала 
остается 0. 

от 0.0 до 
65535.7 
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Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 
 
 

Констан-
та 
времени 

Разъяснение 
  

Диапа-
зон 
адресов 

 LC Q, I, M, D m.n T#<const> Если шаг активен и условие (блокиров-
ка) выполнено, состояние сигнала для 
адреса устанавливается в 1 на время n 
секунд. Если  шаг не активен, состояние 
сигнала остается 0. 

от 0.0 до 
65535.7 

 CALLC FB, FC, 
SFB,  
SFC 

Номер 
блока 

 Если шаг активен и условие (блокиров-
ка) выполнено, вызывается заданный 
блок  

 

Для CALL[C] FB/SFB требуется экземплярный DB. 

13.2 Действия, зависящие от событий - с 
самоблокировкой и без 

Эти действия выполняются только, когда наступает событие, а 
соответствующий шаг активен. Когда секвенсор проходит через них, 
зависимые от событий действия выполняются только тогда, когда появляется 
событие. 

S1: Действия, связанные с активацией шага 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 
 

Разъяснение Диапа-
зон 
адресов 
 

S1  N Q, I, M, D m.n В момент, когда шаг становится активным, 
состояние сигнал в адресе примет значение 1. 

от 0.0 до 
65535.7 

S1 S Q, I, M, D m.n Когда шаг становится активным, адрес устанавли-
вается в 1 и остается в этом состоянии. 

от 0.0 до 
65535.7 

S1 R Q, I, M, D m.n Когда шаг становится активным, адрес 
сбрасывается в 0 и остается в этом состоянии. 

от 0.0 до 
65535.7 

S1 CALL FB, FC, 
SFB,  
SFC 

Номер 
блока 

Когда шаг становится активным, вызывается 
заданный блок. 

 

S1 ON S I Когда шаг становится активным, активируется шаг 
i. 

i = номер 
шага 

S1 OFF S I Когда шаг становится активным, деактивируется 
шаг i.  

i = номер 
шага 

S1 OFF S_ALL  Когда шаг становится активным, деактивируются 
все шаги, за исключением того, в котором 
находится это действие. 

 

S1 NC Q,I,M,D m.n Когда шаг становится активным и условие 
(блокировка) выполнено, состояние сигнала для 
адреса = 1. 

от 0.0 до 
65535.7 
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Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 
 

Разъяснение Диапа-
зон 
адресов 
 

S1 SC Q, I, M, D m.n Когда шаг становится активным и условие 
(блокировка) выполнено, адрес устанавливается в 
1 и остается в этом состоянии. 

от 0.0 до 
65535.7 

S1 RC Q, I, M, D m.n Когда шаг становится активным и условие 
(блокировка) выполнено, адрес сбрасывается в 0 
и остается в этом состоянии. 

от 0.0 до 
65535.7 

S1 CALL
C 

FB, FC, 
SFB,  
SFC 

Номер 
блока 

Когда шаг становится активным и условие 
(блокировка) выполнено, вызывается заданный 
блок 

 

S1 ONC S I Когда шаг становится активным и условие 
(блокировка) выполнено, активируется шаг i. 

i = номер 
шага 

S1 OFFC S I Когда шаг становится активным и условие 
(блокировка) выполнено, деактивируется шаг i.   

i = номер 
шага 

S1 OFFC S_ALL  Когда шаг становится активным и условие 
(блокировка) выполнено, деактивируются все 
шаги, за исключением того, в котором находится 
это действие. 

 

S0: Действия, связанные с деактивацией шага 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапа-
зон 
адресов 
 

S0 N Q, I, M, D m.n В момент, когда шаг деактивируется, состояние 
сигнал в адресе примет значение 1. 

от 0.0 до 
65535.7 

S0 S Q, I, M, D m.n Когда шаг деактивируется, адрес устанавливается в 
1 и остается в этом состоянии. 

от 0.0 до 
65535.7 

S0 R Q, I, M, D m.n Когда шаг деактивируется, адрес сбрасывается в 0 
и остается в этом состоянии. 

от 0.0 до 
65535.7 

S0 CALL FB, FC, 
SFB,  
SFC 

Номер 
блока 

Когда шаг деактивируется,  вызывается заданный 
блок. 

 

S0 ON S I Когда шаг деактивируется, активируется шаг i. i = номер 
шага 

S0 OFF S I Когда шаг деактивируется, деактивируется шаг i.  i = номер 
шага 
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V1: Действия, связанные с состоянием возникновения ошибки супервизора 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапа-
зон 
адресов 
 

V1 N Q,I,M,D m.n Если возникла ошибка супервизора, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага, сигнальное состояние адреса = 1. 

от 0.0 до 
65535.7 

V1 S Q,I,M,D m.n Если возникла ошибка супервизора, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага, адрес устанавливается в 1 и 
остается в этом состоянии. 

от 0.0 до 
65535.7 

V1 R Q,I,M,D m.n Если возникла ошибка супервизора, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага, адрес сбрасывается в 0 и остается 
в этом состоянии. 

от 0.0 до 
65535.7 

V1 CALL FB, FC, 
SFB,  
SFC 

Номер 
блока 

Если возникла ошибка супервизора, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага, вызывается заданный блок. 

 

V1 ON S I Если возникла ошибка супервизора, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага, активируется шаг i. 

от 0.0 до 
65535.7 

V1 OFF S I Если возникла ошибка супервизора, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага, деактивируется шаг i. 

от 0.0 до 
65535.7 

V1 OFF S_ALL  Если возникла ошибка супервизора, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага, деактивируются все шаги, за 
исключением того, в котором находится это 
действие. 

от 0.0 до 
65535.7 

V1 NC Q,I,M,D Mn Если ошибка супервизора возникла, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага и если условие (блокировка) 
выполняется, сигнальное состояние адреса = 1. 

от 0.0 до 
65535.7 

V1 SC Q,I,M,D m.n Если ошибка супервизора возникла, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага и если условие (блокировка) 
выполняется, адрес устанавливается в 1 и остается 
в этом состоянии. 

от 0.0 до 
65535.7 

V1 RC Q,I,M,D m.n Если ошибка супервизора возникла, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага и если условие (блокировка) 
выполняется,  адрес сбрасывается в 0 и остается в 
этом состоянии. 

от 0.0 до 
65535.7 
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Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапа-
зон 
адресов 
 

V1 CALL
C 

FB, FC, 
SFB,  
SFC 

Номер 
блока 

Если ошибка супервизора возникла, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага и если условие (блокировка) 
выполняется, вызывается заданный блок. 

 

V1 ONC S I Если ошибка супервизора возникла, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага и если условие (блокировка) 
выполняется, активируется шаг i. 

от 0.0 до 
65535.7 

V1 OFFC S I Если ошибка супервизора возникла, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага и если условие (блокировка) 
выполняется, деактивируется шаг i. 

от 0.0 до 
65535.7 

V1 OFFC S_ALL  Если ошибка супервизора возникла, пока шаг 
активен или ошибка супервизора обнаружена до 
активации шага и если условие (блокировка) 
выполняется, деактивируются все шаги, за 
исключением того, в котором находится это 
действие. 

от 0.0 до 
65535.7 

 

V0: Действия, связанные с состоянием снятия ошибки супервизора  
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Диапа-
зон 
адресов 
 

V0 N Q,I,M,D m.n Когда ошибка супервизора снимается 
(устраняется или квитируется),  сигнальное 
состояние адреса = 1 

от 0.0 до 
65535.7 

V0 S Q,I,M,D m.n Когда ошибка супервизора снимается 
(устраняется или квитируется), адрес устанавли-
вается в 1 и остается в этом состоянии. 

от 0.0 до 
65535.7 

V0 R Q,I,M,D m.n Когда ошибка супервизора снимается 
(устраняется или квитируется), адрес 
сбрасывается в 0 и остается в этом состоянии. 

от 0.0 до 
65535.7 

V0 CALL FB,  
FC,  
SFB,  
SFC 

 Когда ошибка супервизора снимается 
(устраняется или квитируется), вызывается 
заданный блок. 

 

V0 ON S I Когда ошибка супервизора снимается 
(устраняется или квитируется), активируется шаг i. 

i = номер 
шага 

V0 OFF S I Когда ошибка супервизора снимается 
(устраняется или квитируется), шаг i также 
деактивируется. 

i = номер 
шага 
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L0: Действия, связанные с состоянием возникновения блокировки 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапа-
зон 
адресов 
 

L0 N Q,I,M,D m.n В момент, когда условия блокировки выполняются и 
шаг активен, состояние сигнала адреса принимает 
значение  1. 

от 0.0 до 
65535.7 

L0 S Q,I,M,D m.n В момент, когда условия блокировки выполняются и 
шаг активен, адрес устанавливается в 1 и остается 
в этом состоянии. 

от 0.0 до 
65535.7 

L0 R Q,I,M,D m.n В момент, когда условия блокировки выполняются и 
шаг активен, адрес сбрасывается в 0 и остается в 
этом состоянии. 

от 0.0 до 
65535.7 

L0 CALL FB, FC, 
SFB,  
SFC 

Номер 
блока 

В момент, когда условия блокировки выполняются и 
шаг активен, вызывается заданный блок. 

 

L0 ON S I В момент, когда условия блокировки выполняются и 
шаг активен, активируется шаг i. 

i = номер 
шага 

L0 OFF S I В момент, когда условия блокировки выполняются и 
шаг активен, деактивируется шаг i. 

i = номер 
шага 

 

L1: Действия, связанные с состоянием снятия блокировки 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапа-
зон 
адресов 
 

L1 N Q,I,M,D m.n В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или, если условия 
блокировки не выполняются, когда шаг становится 
активным, адрес устанавливается в 1. 

от 0.0 до 
65535.7 

L1 S Q,I,M,D m.n В момент, когда условия блокировки перестают 
выполняться, пока шаг активен,  или, если условия 
блокировки не выполняются, когда шаг становится 
активным,  адрес устанавливается в 1 и остается в 
этом состоянии. 

от 0.0 до 
65535.7 

L1 R Q,I,M,D  
m.n 

В момент, когда условия блокировки перестают 
выполняться, пока шаг активен,  или, если условия 
блокировки не выполняются, когда шаг становится 
активным, адрес сбрасывается в 0 и остается в 
этом состоянии. 

от 0.0 до 
65535.7 

L1 CALL FB, FC, 
SFB,  
SFC 

Номер 
блока 

В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или, если условия 
блокировки не выполняются, когда шаг становится 
активным,  вызывается заданный блок. 

 

L1 ON S I В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или, если условия 
блокировки не выполняются, когда шаг становится 
активным, активируется шаг i. 

i = номер 
шага 
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Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапа-
зон 
адресов 
 

L1  OFF S I В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или, если условия 
блокировки, не выполняются, когда шаг становится 
активным, шаг i деактивируется. 

i = номер 
шага 

L1  OFF S_ALL  В момент, когда условия блокировки, перестают 
выполняться, пока шаг активен, или если условия 
блокировки не выполняются, когда шаг становится 
активным,  деактивируются все шаги, за 
исключением того, в котором находится это 
действие. 

 

 

A1: Действия, связанные с квитированием сообщений 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапа-
зон 
адресов 
 

A1 N Q,I,M,D m.n Если сообщение квитировано, адрес устанавли-
вается в 1. 

от 0.0 до 
65535.7 

A1 S Q,I,M,D m.n Как только, адрес устанавливается в 1 и остается в 
этом состоянии. 

от 0.0 до 
65535.7 

A1 R Q,I,M,D m.n Как только сообщение квитировано, адрес 
сбрасывается в 0 и остается в этом состоянии. 

от 0.0 до 
65535.7 

A1 CALL FB, FC, 
SFB,  
SFC 

Номер 
блока 

Как только сообщение квитировано, вызывается 
заданный блок. 

 

A1 ON S I Как только сообщение квитировано, активируется 
шаг i. 

i = step 
number 

A1 OFF S I Как только сообщение квитировано, деактивируется 
шаг i. 

i = step 
number 

A1 NC Q,I,M,D m.n Когда сообщение квитировано и условие 
(блокировки) выполнено, состояние сигнала адреса 
устанавливается в 1. 

от 0.0 до 
65535.7 

A1 SC Q,I,M,D m.n Когда сообщение квитировано и условие 
(блокировки) выполнено, адрес устанавливается в 1 
и остается в этом состоянии. 

от 0.0 до 
65535.7 

A1 RC Q,I,M,D m.n Когда сообщение квитировано и условие 
(блокировки) выполнено, адрес сбрасывается в 0 и 
остается в этом состоянии. 

от 0.0 до 
65535.7 

A1 CALL
C 

FB, FC, 
SFB,  
SFC 

Номер 
блока 

Когда сообщение квитировано и условие 
(блокировки) выполнено, вызывается заданный 
блок. 

 

A1 ONC S I Когда сообщение квитировано и условие 
(блокировки) выполнено, активируется шаг i. 

i = номер 
шага 

A1 OFFC S I Когда сообщение квитировано и условие 
(блокировки) выполнено, деактивируется шаг i. 

i = номер 
шага 
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R1: Действия, связанные с установкой регистрации  
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапа-
зон 
адресов 
 

R1 N Q,I,M,D m.n Когда устанавливается регистрация, адрес 
устанавливается в 1. 

от 0.0 до 
65535.7 

R1 S Q,I,M,D m.n Когда устанавливается регистрация, адрес 
устанавливается в 1 и остается в этом состоянии. 

от 0.0 до 
65535.7 

R1 R Q,I,M,D m.n Когда устанавливается регистрация, адрес 
сбрасывается в 0 и остается в этом состоянии. 

от 0.0 до 
65535.7 

R1 CALL FB, FC, 
SFB,  
SFC 

Номер 
блока 

Когда устанавливается регистрация, вызывается 
заданный блок. 

 

R1 ON S I Когда устанавливается регистрация, активируется 
шаг i. 

i = номер 
шага 

R1 OFF S I Когда устанавливается регистрация, 
деактивируется шаг i. 

i = номер 
шага 

R1 NC Q,I,M,D m.n Когда устанавливается регистрация и условие (бло-
кировки) выполнено, адрес устанавливается в 1. 

от 0.0 до 
65535.7 

R1 SC Q,I,M,D m.n Когда устанавливается регистрация и условие 
(блокировки) выполнено, адрес устанавливается в 1 
и остается в этом состоянии. 

от 0.0 до 
65535.7 

R1 RC Q,I,M,D m.n Когда устанавливается регистрация и условие 
(блокировки) выполнено, адрес сбрасывается в 0 и 
остается в этом состоянии. 

от 0.0 до 
65535.7 

R1 CALL
C 

FB, FC, 
SFB,  
SFC 

Номер 
блока 

Когда устанавливается регистрация и условие 
(блокировки) выполнено, вызывается заданный 
блок. 

 

R1 ONC S I Когда устанавливается регистрация и условие 
(блокировки) выполнено, активируется шаг i. 

i = номер 
шага 

R1 OFFC S I Когда устанавливается регистрация и условие 
(блокировки) выполнено, деактивируется шаг i. 

i = номер 
шага 

Адрес D: Формат: DBi.DBXm.n (i = Номер блока, m = адрес байта, n = адрес бита) 
Для CALL[C] FB/SFB, требуется экземплярный DB. 
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13.3 Счетчики в действиях 

”Эти действия выполняются только тогда, когда происходит событие, и 
соответствующий шаг активен. Когда секвенсор проходит через эти действия, 
действия, зависящие от событий, выполняются только в том случае, если 
возникает соответствующее событие. 

S1: Счетчики в действиях  связанные с активацией шага 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Диапазон 
адресов 
 

S1  CS C 
<началь-
ное значе-
ние 
счетчика> 

X Когда шаг становится активным (возникновение 
состояния), в счетчик загружается начальное 
состояние. 

x = номер 
счетчика  

S1  CU C X Когда шаг становится активным (возникновение 
состояния), счетчик увеличивается на 1. 

x = номер 
счетчика  

S1  CD C X Когда шаг становится активным (возникновение 
состояния), счетчик уменьшается на 1. 

x = номер 
счетчика  

S1  CR C X Когда шаг становится активным (возникновение 
состояния), счетчик сбрасывается в 0. 

x = номер 
счетчика  

S1  CSC C 
<initial 
counter 
value> 

X Когда шаг становится активным (возникновение 
состояния) и условие (блокировки) выполнено, в 
счетчик загружается начальное состояние. 

x = номер 
счетчика  

S1  CUC C X Когда шаг становится активным (возникновение 
состояния) и условие (блокировки) выполнено, 
счетчик увеличивается на 1. 

x = номер 
счетчика  

S1  CDC C X Когда шаг становится активным (возникновение 
состояния) и условие (блокировки) выполнено, 
счетчик уменьшается на 1. 

x = номер 
счетчика  

S1  CRC C X Когда шаг становится активным (возникновение 
состояния) и условие (блокировки) выполнено, 
счетчик сбрасывается в 0. 

x = номер 
счетчика  
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S0: Счетчики в действиях  связанные с деактивацией шага 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Диапазон 
адресов 
 

S0  CS C 
<началь-
ное значе-
ние 
счетчика> 

X Когда шаг деактивируется (состояние ухода), в 
счетчик загружается начальное состояние. 

x = номер 
счетчика  

S0  CU C X Когда шаг деактивируется (состояние ухода), 
счетчик увеличивается на 1. 

x = номер 
счетчика  

S0  CD C X Когда шаг деактивируется (состояние ухода), 
счетчик уменьшается на 1. 

x = номер 
счетчика  

S0  CR C X Когда шаг деактивируется (состояние ухода), 
счетчик сбрасывается в 0. 

x = номер 
счетчика  

L1: Счетчики в действиях  связанные с состоянием снятия блокировки 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Диапазон 
адресов 
 

L1  CS C 
<началь-
ное значе-
ние 
счетчика> 

X В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или если 
условия блокировки не выполняются, когда шаг 
становится активным, в счетчик загружается 
начальное состояние. 

x = номер 
счетчика  

L1  CU C X В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или если усло-
вия блокировки не выполняются, когда шаг ста-
новится активным, счетчик увеличивается на 1. 

x = номер 
счетчика  

L1  CD C X В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или если 
условия блокировки не выполняются, когда шаг 
становится активным, счетчик уменьшается на 1. 

x = номер 
счетчика  

L1  CR C X В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или если 
условия блокировки не выполняются, когда шаг 
становится активным, счетчик сбрасывается в 0. 

x = номер 
счетчика  
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L0: Счетчики в действиях  связанные с состоянием возникновения 
блокировки 

 
Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Диапазон 
адресов 
 

L0  CS C 
<началь-
ное значе-
ние 
счетчика> 

X В момент, когда условия блокировки 
выполняются и шаг активен, в счетчик 
загружается начальное состояние. 

x = номер 
счетчика  

L0  CU C X В момент, когда условия блокировки 
выполняются и шаг активен, счетчик 
увеличивается на 1. 

x = номер 
счетчика  

L0  CD C X В момент, когда условия блокировки 
выполняются и шаг активен, счетчик 
уменьшается на 1. 

x = номер 
счетчика  

L0  CR C X В момент, когда условия блокировки 
выполняются и шаг активен, счетчик 
сбрасывается в 0. 

x = номер 
счетчика  

V1: Счетчики в действиях  связанные с состоянием возникновения ошибки 
супервизора 

 
Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Диапазон 
адресов 
 

V1  CS C 
<началь-
ное значе-
ние 
счетчика> 

X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, в счетчик загружается 
начальное состояние. 

x = номер 
счетчика  

V1  CU C X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, счетчик увеличивается на 1. 

x = номер 
счетчика  

V1  CD C X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, счетчик уменьшается на 1. 

x = номер 
счетчика  

V1  CR C X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, счетчик сбрасывается в 0. 

x = номер 
счетчика  

V1  CSC C 
<initial 
counter 
value> 

X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, и если условие (блокировка) 
выполняется, в счетчик загружается начальное 
состояние. 

x = номер 
счетчика  

V1  CUC C X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, и если условие (блокировка) 
выполняется, счетчик увеличивается на 1. 

x = номер 
счетчика  
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Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Диапазон 
адресов 
 

V1  CDC C X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, и если условие (блокировка) 
выполняется, счетчик уменьшается на 1. 

x = номер 
счетчика  

V1  CRC C X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, и если условие (блокировка) 
выполняется, счетчик сбрасывается в 0. 

x = номер 
счетчика  

V0: : Счетчики в действиях  связанные с состоянием снятия ошибки 
супервизора 

 
Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Диапазон 
адресов 
 

V0  CS C 
<началь-
ное значе-
ние 
счетчика> 

X Когда ошибка супервизора снимается 
(устраняется или квитируется), в счетчик 
загружается начальное состояние. 

x = номер 
счетчика  

V0  CU C X Когда ошибка супервизора снимается 
(устраняется или квитируется), счетчик 
увеличивается на 1. 

x = номер 
счетчика  

V0  CD C X Когда ошибка супервизора снимается 
(устраняется или квитируется), счетчик 
уменьшается на 1. 

x = номер 
счетчика  

V0  CR C X Когда ошибка супервизора снимается 
(устраняется или квитируется), счетчик 
сбрасывается в 0. 

x = номер 
счетчика  
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A1: Счетчики в действиях  связанные с квитированием сообщений 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Диапазон 
адресов 
 

A1  CS C 
<началь-
ное значе-
ние 
счетчика> 

X Когда сообщение квитировано, в счетчик 
загружается начальное состояние. 

x = номер 
счетчика  

A1  CU C X Как только сообщение квитировано, счетчик 
увеличивается на 1. 

x = номер 
счетчика  

A1  CD C X Как только сообщение квитировано, счетчик 
уменьшается на 1. 

x = номер 
счетчика  

A1  CR C X Как только сообщение квитировано, счетчик 
сбрасывается в 0. 

x = номер 
счетчика  

A1  CSC C 
<началь-
ное значе-
ние 
счетчика> 

X Когда сообщение квитировано и условие 
(блокировки) выполнено, в счетчик загружается 
начальное состояние. 

x = номер 
счетчика  

A1  CUC C X Когда сообщение квитировано и условие 
(блокировки) выполнено, счетчик увеличивается 
на 1. 

x = номер 
счетчика  

A1  CDC C X Когда сообщение квитировано и условие 
(блокировки) выполнено, счетчик уменьшается 
на 1. 

x = номер 
счетчика  

A1  CRC C X Когда сообщение квитировано и условие 
(блокировки) выполнено, счетчик сбрасывается 
в 0. 

x = номер 
счетчика  

R1: : Счетчики в действиях  связанные с установлением регистрации 
Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Address  
range 

R1  CS C 
<началь-
ное значе-
ние 
счетчика> 

X Когда устанавливается регистрация, в счетчик 
загружается начальное состояние. 

x = номер 
счетчика  

R1  CU C X Когда устанавливается регистрация, счетчик 
увеличивается на 1. 

x = номер 
счетчика  

R1  CD C X Когда устанавливается регистрация, счетчик 
уменьшается на 1. 

x = номер 
счетчика  

R1  CR C X Когда устанавливается регистрация, счетчик 
сбрасывается в 0. 

x = номер 
счетчика  
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Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложение 

Разъяснение Address  
range 

R1  CSC C 
<началь-
ное значе-
ние 
счетчика> 

X Когда устанавливается регистрация и условие 
(блокировки) выполнено, в счетчик загружается 
начальное состояние. 

x = номер 
счетчика  

R1  CUC C X Когда устанавливается регистрация и условие 
(блокировки) выполнено, счетчик увеличивается 
на 1. 

x = номер 
счетчика  

R1  CDC C X Когда устанавливается регистрация и условие 
(блокировки) выполнено, счетчик уменьшается 
на 1. 

x = номер 
счетчика  

R1  CRC C X Когда устанавливается регистрация и условие 
(блокировки) выполнено, счетчик сбрасывается 
в 0. 

x = номер 
счетчика  

13.4 Таймеры в действиях 

Эти действия выполняются однократно, когда происходит событие и 
соответствующий шаг активен. Когда секвенсор проходит через эти действия, 
действия, зависящие от событий, выполняются только в том случае, если 
возникает соответствующее событие. 

S1: Таймеры в действиях, связанных с активацией шага 
 

Действие 
Собы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение 
 
 

Диапазон 
адресов 
 

S1  TL T 
<time> 

X Когда шаг становится активным (возникновение 
состояния), таймер запускается. На заданное время, 
бит таймера (состояние) устанавливается в 1, когда 
время истекает, он сбрасывается в 0. 

x = номер 
таймера 

S1  TD T 
<time> 

X Когда шаг становится активным (возникновение 
состояния) таймер запускается. На заданное время, бит 
таймера (состояние) устанавливается в 0, когда время 
истекает, он устанавливается в 1. 

x = номер 
таймера 

S1  TR T X Когда шаг становится активным (возникновение 
состояния) таймер останавливается. Бит таймера 
(состояние) и значение таймера сбрасывается в 0. 

x = номер 
таймера 

S1  TLC T 
<time> 

X Когда шаг становится активным и условие (блокировки) 
выполнено, таймер запускается. На заданное время, 
бит таймера (состояние) устанавливается в 1, когда 
время истекает, он сбрасывается в 0. 

x = номер 
таймера 

S1  TDC T 
<time> 

X Когда шаг становится активным и условие (блокировки) 
выполнено, таймер запускается. На заданное время, 
бит таймера (состояние) устанавливается в 0, когда 
время истекает, он устанавливается в 1. 

x = номер 
таймера 

S1  TRC T X Когда шаг становится активным и условие (блокировки) 
выполнено, таймер останавливается. Бит таймера 
(состояние) и значение таймера сбрасываются в 0. 

x = номер 
таймера 
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S0: Таймеры в действиях, связанных с деактивацией шага 
 

Действие 
Собы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапазон 
адресов 
 

S0  TL T 
<time> 

X Когда шаг деактивируется (состояние ухода) 
таймер запускается. На заданное время, бит 
таймера (состояние) устанавливается в 1, когда 
время истекает, он сбрасывается в 0. 

x = номер 
таймера 

S0  TD T 
<time> 

X Когда шаг деактивируется (состояние ухода) 
таймер запускается. На заданное время, бит 
таймера (состояние) устанавливается в 0, когда 
время истекает, он устанавливается в 1. 

x = номер 
таймера 

S0  TR T X Когда шаг деактивируется (состояние ухода) 
таймер останавливается. Бит таймера 
(состояние) и значение таймера сбрасывается в 
0. 

x = номер 
таймера 

 

L1: Таймеры в действиях, связанных с снятием блокировки 
 

Действие 
Собы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапазон 
адресов 
 

L1  TL T 
<time> 

X В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или если 
условия блокировки не выполняются, когда шаг 
становится активным, таймер запускается. На 
заданное время, бит таймера (состояние) 
устанавливается в 1, когда время истекает, он 
сбрасывается в 0. 

x = номер 
таймера 

L1  TD T 
<time> 

X В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или если 
условия блокировки не выполняются, когда шаг 
становится активным, таймер запускается. На 
заданное время, бит таймера (состояние) 
устанавливается в 0, когда время истекает, он 
устанавливается в 1. 

x = номер 
таймера 

L1  TR T X В момент, когда условия блокировки перестают 
выполняться, пока шаг активен, или если 
условия блокировки не выполняются, когда шаг 
становится активным, таймер останавливается. 
Бит таймера (состояние) и значение таймера 
сбрасывается в 0. 

x = номер 
таймера 
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L0: Таймеры в действиях, связанных с состоянием возникновения 
блокировки 

 
Действие 
Собы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапазон 
адресов 
 

L0  TL T 
<time> 

X В момент, когда условия блокировки 
выполняются и шаг активен, таймер 
запускается. На заданное время, бит таймера 
(состояние) устанавливается в 1, когда время 
истекает, он сбрасывается в 0. 

x = номер 
таймера 

L0  TD T 
<time> 

X В момент, когда условия блокировки 
выполняются и шаг активен, таймер 
запускается. На заданное время, бит таймера 
(состояние) устанавливается в 0, когда время 
истекает, он устанавливается в 1. 

x = номер 
таймера 

L0  TR T X В момент, когда условия блокировки 
выполняются и шаг активен, таймер 
останавливается. Бит таймера (состояние) и 
значение таймера сбрасывается в 0. 

x = номер 
таймера 

 

V1: Таймеры в действиях, связанных с состоянием возникновения ошибки 
супервизора  

 
Действие 
Собы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапазон 
адресов 
 

V1  TL T 
<time> 

X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, таймер запускается. На заданное 
время, бит таймера (состояние) устанавливается в 
1, когда время истекает. он сбрасывается в 0. 

x = номер 
таймера 

V1  TD T 
<time> 

X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, таймер запускается. На заданное 
время, бит таймера (состояние) устанавливается в 
0, когда время истекает. он устанавливается в 1. 

x = номер 
таймера 

V1  TR T X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, таймер останавливается. Бит 
таймера (состояние) и значение таймера 
сбрасывается в 0. 

x = номер 
таймера 

V1  TLC T 
<time> 

X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, и если условие (блокировка) 
выполняется, таймер запускается. На заданное 
время, бит таймера (состояние) устанавливается в 
1, когда время истекает, он сбрасывается в 0. 

x = номер 
таймера 
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Действие 
Собы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапазон 
адресов 
 

V1  TDC T 
<time> 

X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, и если условие (блокировка) 
выполняется, таймер запускается. На заданное 
время, бит таймера (состояние) устанавливается в 
0, когда время истекает, он устанавливается в 1. 

x = номер 
таймера 

V1  TRC T X Если ошибка супервизора возникла, пока шаг 
активен, или ошибка супервизора обнаружена до 
активации шага, и если условие (блокировка) 
выполняется, таймер останавливается. Бит таймера 
(состояние) и значение таймера сбрасывается в 0. 

x = номер 
таймера 

 

V0: Таймеры в действиях, связанных с состоянием  снятия ошибки 
супервизора 

 
Действие 
Собы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапазон 
адресов 
 

V0  TL T 
<time> 

X Когда ошибка супервизора снимается 
(устраняется или квитируется), таймер 
запускается. На заданное время, бит таймера 
(состояние) устанавливается в 1, когда время 
истекает, он сбрасывается в 0. 

x = номер 
таймера 

V0  TD T 
<time> 

X Когда ошибка супервизора снимается 
(устраняется или квитируется), таймер 
запускается. На заданное время, бит таймера 
(состояние) устанавливается в 0, когда время 
истекает, он устанавливается в 1. 

x = номер 
таймера 

V0  TR T X Когда ошибка супервизора снимается 
(устраняется или квитируется), таймер 
останавливается. Бит таймера (состояние) и 
значение таймера сбрасывается в 0. 

x = номер 
таймера 
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A1: Таймеры в действиях, связанных с квитированием сообщений 
 

Действие 
Собы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение Диапазон 
адресов 
 

A1  TL T 
<time> 

X Как только сообщение квитировано, таймер 
запускается. На заданное время, бит таймера 
(состояние) устанавливается в 1, когда время 
истекает, он сбрасывается в 0. 

x = номер 
таймера 

A1  TD T 
<time> 

X Как только сообщение квитировано, таймер 
запускается. На заданное время, бит таймера 
(состояние) устанавливается в 0, когда время 
истекает, он устанавливается в 1. 

x = номер 
таймера 

A1  TR T X Как только сообщение квитировано, таймер 
останавливается. Бит таймера (состояние) и 
значение таймера сбрасывается в 0. 

x = номер 
таймера 

A1  TLC T 
<time> 

X Когда сообщение квитировано и условие 
(блокировки) выполнено, таймер запускается. 
На заданное время, бит таймера (состояние) 
устанавливается в 1, когда время истекает, он 
сбрасывается в 0. 

x = номер 
таймера 

A1  TDC T 
<time> 

X Когда сообщение квитировано и условие 
(блокировки) выполнено, таймер запускается. 
На заданное время, бит таймера (состояние) 
устанавливается в 0, когда время истекает, он 
устанавливается в 1. 

x = номер 
таймера 

A1  TRC T X Когда сообщение квитировано и условие 
(блокировки) выполнено, таймер 
останавливается. Бит таймера (состояние) и 
значение таймера сбрасывается в 0. 

x = no. 
of timer 

 

R1: Таймеры в действиях, связанных с установкой регистрации 
 

Действие 
Собы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение 
 

Диапазон 
адресов 
 

R1  TL T 
<time> 

X Когда устанавливается регистрация, таймер 
запускается. На заданное время, бит таймера 
(состояние) устанавливается в 1, когда время 
истекает, он сбрасывается в 0. 

x = номер 
таймера 

R1  TD T 
<time> 

X Когда устанавливается регистрация, таймер 
запускается. На заданное время, бит таймера 
(состояние) устанавливается в 0, когда время 
истекает, он устанавливается в 1. 

x = номер 
таймера 

R1  TR T X Когда устанавливается регистрация, таймер 
останавливается. Бит таймера (состояние) и 
значение таймера сбрасывается в 0. 

x = номер 
таймера 
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Действие 
Собы-
тие 

Инст-
рук-
ция 

Адрес Распо-
ложе-
ние 

Разъяснение 
 

Диапазон 
адресов 
 

R1  TLC T 
<time> 

X Когда устанавливается регистрация и условие 
(блокировки) выполнено, таймер запускается. 
На заданное время, бит таймера (состояние) 
устанавливается в 1, когда время истекает, он 
сбрасывается в 0. 

x = номер 
таймера 

R1  TDC T 
<time> 

X Когда устанавливается регистрация и условие 
(блокировки) выполнено, таймер запускается. 
На заданное время, бит таймера (состояние) 
устанавливается в 0, когда время истекает, он 
устанавливается в 1. 

x = номер 
таймера 

R1  TRC T X Когда устанавливается регистрация и условие 
(блокировки) выполнено, таймер 
останавливается. Бит таймера (состояние) и 
значение таймера сбрасывается в 0. 

x = номер 
таймера 

13.5 Арифметика в действиях 

Эти действия выполняются либо в каждом цикле, когда соответствующий шаг 
активен, или однократно, когда происходит соответствующее  событие.  
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Присвоение 
Разъяснение 

--  N A:=B 
A:=func(B) 
A:=B<operator>C 

Пока шаг активен, выполняется арифметическая операция. 

--  NC A:=B 
A:=func(B) 
A:=B<operator>C 

Пока шаг активен и условие (блокировки) выполнено, 
выполняется арифметическая операция. 

S1: Арифметика в действиях , связанная с активацией шага 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Присвоение 
Разъяснение 

S1  N A:=B 
A:=func(B) 
A:=B<operator>C 

Когда шаг становится активным (состояние прихода), 
выполняется арифметическая операция. 

S1  NC A:=B 
A:=func(B) 
A:=B<operator>C 

Когда шаг становится активным (состояние прихода) и условие 
(блокировки) выполнено, выполняется арифметическая 
операция. 
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S0: Арифметика в действиях, связанная с деактивацией шага 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Присвоение 
Разъяснение 

S0  N A:=B 
A:=func(B) 
A:=B<operator>C 

Когда шаг деактивируется (состояние ухода), выполняется 
арифметическая операция. 

L1: Арифметика в действиях, связанная с состоянием снятия блокировки 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Присвоение 
Разъяснение 

L1  N A:=B 
A:=func(B) 
A:=B<operator>C 

В момент, когда условия блокировки перестают выполняться, 
пока шаг активен,  или если условия блокировки не 
выполняются, когда шаг становится активным, выполняется 
арифметическая операция. 

L0: Арифметика в действиях, связанная с состоянием возникновения 
блокировки 

 
 

Действие 
Собы-
тие 

Инст-
рук-
ция 

Присвоение 
Разъяснение 

L0  N A:=B 
A:=func(B) 
A:=B<operator>C 

В момент, когда условия блокировки выполняются и шаг 
активен, выполняется арифметическая операция. 

V1: : Арифметика в действиях , связанная с состоянием возникновения 
ошибки супервизора 

 
Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Присвоение 
Разъяснение 

V1  N A:=B 
A:=func(B) 
A:=B<operator>C 

Если ошибка супервизора возникла, пока шаг активен, или 
ошибка супервизора обнаружена до активации шага, 
выполняется арифметическая операция. 

V1  NC A:=B 
A:=func(B) 
A:=B<operator>C 

Если ошибка супервизора возникла, пока шаг активен, или 
ошибка супервизора обнаружена до активации шага и условие 
(блокировки) выполнено, выполняется арифметическая 
операция. 
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V0: Арифметика в действиях, связанная с состоянием снятия ошибки 
супервизора  

 
Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Присвоение 
Разъяснение 

V0  N A:=B 
A:=func(B) 
A:=B<operator>C 

Когда ошибка супервизора снимается (устраняется или 
квитируется), выполняется арифметическая операция. 

A1:Арифметика в действиях, связанная с квитированием сообщений  
 

Действие 
Собы
тие 

Инстр
укция 

Присвоение 

Разъяснение 

A1  N A:=B 
A:=func(B) 
A:=B<operator>C 

Как только сообщение квитировано, выполняется 
арифметическая операция. 

A1  NC A:=B 
A:=func(B) 
A:=B<operator>C 

Когда сообщение квитировано и условие (блокировки) 
выполнено, выполняется арифметическая операция. 

R1: Арифметика в действиях, связанная с установкой регистрации 
 

Действие 
Со-
бы-
тие 

Инст-
рук-
ция 

Присвоение 
Разъяснение 

R1  N A:=B 
A:=func(B) 
A:=B<operator>C 

Когда устанавливается регистрация, выполняется 
арифметическая операция. 

R1  NC A:=B 
A:=func(B) 
A:=B<operator>C 

Когда устанавливается регистрация и условие (блокировки) 
выполнено, выполняется арифметическая операция. 
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14 Инструкции по проектированию 

Введение 
Для автоматизации системы последовательного управления с S7-GRAPH, в 
дополнение к работе в автоматическом режиме, доступен ряд 
дополнительных возможностей. Прежде, чем Вы сможете использовать 
функции S7-GRAPH, Вы должны убедиться в выполнении определенных 
условий. Чтобы сделать для Вас проще использование S7-GRAPH, наиболее 
важные моменты суммируются в этой главе в виде кратких инструкций по 
конфигурации.  
Рассматриваются следующие моменты: 

• Какие общие структуры существуют и как они влияют на структуру 
программы секвенсора? 

• Что является наиболее важным при программировании и использовании 
секвенсора? 

• Как подключаются системы операторского интерфейса? 
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14.1 Общий уровень и структура программы 

Структура уровней, основанная на примере производственной ячейки 
При использовании S7-GRAPH запомните, что первоначально секвенсор 
спроектирован, чтобы сделать процесс конфигурирования последовательного 
процесса понятнее и проще. Кроме этих секвенсоров, с которыми, например, 
могут быть скоординированы части промышленной установки, требуются 
также дополнительные функции высокого (ячейки) и низкого (функции или 
модули) уровней. 

Секвенсор, запрограммированный с использованием S7-GRAPH, 
принадлежит уровню координации, но следует принять во внимание 
взаимозависимости с уровнями ячейки и устройств. 

 

Отдельные уровни имеют следующее значение: 

• Уровень ячеек 
Уровень ячеек охватывает функции, имеющие центральное или более 
широкое значение, например, подготовка к разрешению операций и 
режимов.  
Блоки уровня ячеек обеспечивают сигналы, которые необходимы всем 
блокам уровней координации и модулей в этой ячейке. 

• Координационный уровень 
Уровень координации включает различные функции координации, 
например, для автоматического режима и пересмотра вследствие обрыва 
операции. Для каждой станции, по крайней мере, один секвенсор требует 
координации на этом уровне. 

• Уровень модуля 
Уровень модуля включает функции для активации отдельных модулей 
установки, например, моторов и вентилей. Он включает все низкоуровне-
вые функции, например, условия блокировок и супервизора  независимо 
от секвенсора и прямое ручное вмешательство в работу модуля. 

Разрешение Режимы

Гидравлика

Пневматика

Сохранить,
удалить

Лента конвейера

Память мотора 

Охлаждение 

Уровень ячейки

Уровень
координации

Уров. функции 
или устройства

Глобально

Утилиты 

Станция n: Сохранение 

Переключ.

Вставить
сварить

Зажим

Центровка
r

Станция 1: Вставить

Табл. перелюч..
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Определение структуры программы и встраивание секвенсора  
Для каждого секвенсора S7-GRAPH создает FB с экземплярным DB. Этот FB 
S7-GRAPH должен вызываться в блоке (например, OB, FB или FC). Поскольку 
вместе с программами, созданными в S7-GRAPH, обычно требуются другие 
программы, наилучший способ это вызов всех FB, созданных в  S7-GRAPH в 
одном блоке (FC или FB), как показано на следующем примере.  

 

Различные функции на отдельных уровнях выполняются циклически в 
порядке, в котором они вызываются: 

• Секвенсоры, которые следуют центральным, это функции более высокого 
уровня, чем уровень ячеек. 

• Различные секвенсоры для отдельных станций вызываются в FB 
"Sequencers", который вызывается в OB1. 

• Разделы программы для ручного режима, блокировок и постоянных 
функций мониторинга для модулей следуют за секвенсорами. 

• Если производственная ячейка включает роботов, требуются также 
разделы программы для обеспечения и очистки интерфейса роботов. 

Станция n  Сохран. 

Ручной режим, 
Блокировки

OB 1
(цикл)

Секвенсоры

Режимы 

Операция выпуска

Робот
Интерфейс 

Гидравлика
Пневматика

Модуль станции 1

Станция 1 Перекл.
Станция 1
Вставка, сварка

Модуль станции n

Общие
функции 
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Разрешающие операции 
В промышленных установках, приспособлениях, таких как гидравлические и 
пневматические системы, часто требуются и функции всех других модулей, в 
зависимости от их доступности. Следовательно имеет смысл включить 
гидравлическую и пневматическую системы централизовано после включения 
оборудования и генерировать сигналы готовности для других блоков.  

Следующая диаграмма дает пример как общее функционирования системы 
может быть разрешено в S7-GRAPH. 

 

• После включения контроллера, с использованием параметра INIT_SQ и 
сигналов  активируется шаг step 1 (начальный шаг) и сбрасываются 
сигналы  Unit_ready и Process_enabled. 

• По прошествию заданного минимального времени ожидания шаг step 2  
включает гидравлический и пневматический модули в зависимости от 
сигнала Controlpow_ok (контроль напряжения OK) используя действие  
Controller_on. 

• После того как сигналы обратной связи покажут, что гидравлическая и 
пневматическая системы в порядке, шаг step 3 выдает сообщение 
Unit_ready (различным приемникам, включая центральный процессор). 
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• Включаемый сигналом "Central_start" (выдается консолью установки), шаг 
step 4 устанавливает модуль в состояние готовности и разрешает 
автоматическое функционирование. 

• С "Emer_off" или снятием сигнала "Door_closed", переключение к шагу 5 
отменяет Process_enabled. Если это квитировано, совершается прыжок к 
шагу 2. 

• Если условие разрешения шага от одной из систем питания отменено, 
пока активен Process_enabled (шаг 4), сигнал разрешения также 
отменяется при переключении к шагу 2. Как только условие разрешения 
шага ("OK_Signal") системы питания снова представлено, Central_start 
может снова возвратить модуль в разрешенное состояние.  

• Сигналы "Controller_on", "Unit_ready" и "Process_enabled" посылаются 
другим блокам и центральному контроллеру.  

• Сигнал "Unit_ready" также разрешает раздел режимов в блоке режимов.  

• Сигнал "Process_enabled" разрешает автоматический режим. 

Режимы работы 
В зависимости от ситуации, пользователю требуются различные режимы 
работы системы и установки. В несвязанных производственных ячейках, 
например, на сборке корпуса, возможны следующие режимы: 

• Автоматический 

• С подталкиванием (inching), другими словами, разновидность 
автоматического режима с остановкой после каждого обработанного шага 

• Автомат или переключение к следующему (Automatic or switch to next); 
другими словами,  автоматический режим с дополнительными условиями 
разрешения шага  

• Ручной (Manual/setup), другими словами, прямое управление модулями и 
функциями 

Режимы, тем не менее, не имеют одного эффекта  на всех уровнях. 
Следующий обзор приводит режимы и их эффекты на уровне координации и 
уровне устройства (двигатели, клапаны и т.п..). 

Режим Эффект на уровне координации Эффект на уровне устройства  
Автоматиче
ский 

Секвенсор передает управление следующему 
шагу, когда переход удовлетворен. 

Разрешение движения секвенсором 

С подталки-
ванием 

Секвенсор передает управление следующему 
шагу, когда переход удовлетворен и сигналь-
ная кнопка "Inching" разрешает следующий 
шаг. 

Разрешение движения секвенсором  

Режим 
«Автомат 
или шаг за 
шагом»  

Секвенсор переключается, когда переход 
удовлетворен или сигнальная кнопка "Inching"  
разрешает следующий шаг. 

Разрешение движения секвенсором  

Ручной или 
установка  

Разрешение следующего шага подавлено, 
состояние секвенсора не влияет на уровень 
устройства. 

Движение разрешается прямой 
кнопкой  
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Представление режима секвенсора 
Если, например, переключатель на управляющей панели обеспечивает 
сигналы автоматического, с подталкиванием и ручного режима, как 
отдельные простые сигналы, только относительно простая логика требуется, 
чтобы получить сигналы режима для секвенсора лежащих в основе 
драйверов устройств, как принципиально показано на следующей диаграмме.  

 

Режимы, установленные на консоли, передаются секвенсору, когда активен  
Process_enabled. Если Process_enabled не установлен, режимы секвенсоров 
переключаются в SW_MAN и разрешение шага подавлено. 

В автоматическом или режиме с подталкиванием, для функций устройств 
устанавливается автоматический режим. Ручной режим передается 
непосредственно. Если нет process_enabled, оба режима сбрасываются и 
процесс останавливается. Функции групп устройств представлены в FB, 
созданном на LAD/FBD или STL. 

Группа мод.FB  n 
Automatic
Manual 

SW_MAN

SW_AUTO 
SW_TAPАвтом.

С подвержд. 

Ручн. 

Автом..

С подвержд.

Ручн. 

 
Мод. авт.

Мод. ручн. 

Разреше- 
ние

Выбор
режима 

Группа мод. FB 1 
Авт.
Ручн. 

SW_MAN

SW_AUTO 
SW_TAP

FB секвенсора n 

Установка режима 

FB секвенсора 1
& 

& 

& 
&

>1_

>1_



 Инструкции по проектированию 

S7-GRAPH для S7-300/400 Программирование систем последовательного управления 
A5E00290656-01 14-7 

Обработка блокировок и ручное управление в ручном режиме  

в S7-GRAPH секвенсор управляет функционированием в автоматическом 
режиме. Функционирование в ручном режиме требует кроме этого, чтобы 
автоматический режим был включен в отдельный FB. Используя биты 
действия (например, Carr_fwd), секвенсор подключается к блокировке и 
ручному управлению. 

 

Функции непрерывного мониторинга, требуемые для модулей, могут быть 
запрограммированы с использованием S7 PDIAG. В зависимости от 
потребностей, условия супервизора могут быть сформулированы так, что они 
эффективны, как для автоматического, так и ручного режимов, или для 
заданных условий супервизора, запрограммированных для автоматического и 
для ручного режима.  

S 4

S 5

& 

& 

& 

Carr_fwd 
Autom. 

Man 
Btn_fwd 

KM_on
Carr_fwd 

Spind_on

Execute

Mot_on S

S

N 

FB управления в ручном и блокировок

FB секвенсора 

&
Cnd1
Cnd2
Cnd3
Cnd4

( )

( )

_>1

Enable_fwd 

Valve1_fwd

Enable_fwd 
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14.2 Точки для заметок о программируемом секвенсоре  

Инициализация 
Секвенсор инициализируется с использованием параметра INIT_SQ. Если он 
переключается в "1", все шаги, размеченные как начальные, активируются. 
Все другие шаги деактивируются.  

После включения контроллера, секвенсор находится в том режиме, в котором 
он был при выключении контроллера, другими словами, если контроллер был 
в режиме SW_AUTO перед выключением, он останется в этом режиме и 
после включения. Если Вы хотите избежать этого, секвенсор должен быть 
явно установлен в требуемый режим (например, SW_MAN), когда он 
включается, например, используя сигнал инициализации. 

Если состояние процесса (системы или машины) не соответствует 
начальному состоянию секвенсора, Вы можете действовать двумя 
способами: 

• Например, процесс переключается в начальное состояние командой.  
Если Вы хотите переключить процесс в начальное состояние, обычно 
рекомендуется, создать отдельный секвенсор с этой целью. 

• Секвенсор должен синхронизироваться с состоянием процесса, 
используя функцию синхронизации, другими словами, секвенсор должен 
устанавливаться в текущую часть процесса. 

Какой метод Вы используете, зависит от типа процесса. 

Блокировки 
В S7-GRAPH, блокировки  можно определить для каждого шага. Все 
действия, которые выполняются в зависимости от условий, активируются 
только тогда, когда выполняется условие блокировки. 

Если условие блокировки не выполняется, когда шаг активен, сообщение об 
ошибке посылается на консоль (например, операторскую панель). Ошибка 
сбрасывается, когда выполняется условие блокировки. 
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Супервизоры 
В S7-GRAPH, условия мониторинга могут быть определены для каждого шага 
в форме супервизоров. Большинство общих условий супервизора это время 
выполнения действий. Если условие супервизора выполнено, другими 
словами, появилась ошибка, сообщение об ошибке посылается на консоль 
(например, операторскую панель). Такие ошибки квитированы через 
параметр ACK_EF.  

Настройки компилятора (команда меню Options > Block Settings 
[Возможности > Установки блока]) определяют при создании FB S7-
GRAPH, требуется ли квитирование. 

• Выбрана опция компилятора "Acknowledge Errors [Квитирование ошибок]": 
Ошибка сбрасывается только тогда, когда послан сигнал квитирования и 
условие супервизора далее не выполняется или когда послан сигнал 
квитирования и следующий за шагом переход открыт.  

Если время мониторинга запрограммировано как Si.U, сигнал 
квитирования сбрасывает время мониторинга, так что условие 
супервизора более не выполняется.  

• Не выбрана опция компилятора "Acknowledge Errors [Квитирование 
ошибок]": 
Ошибка сбрасывается, когда условие супервизора более не выполняется.  

 
 Предупреждение 

Если условие разрешения шага выполняется в течение цикла квитирования, 
следующий шаг разрешен. 

Пожалуйста, запомните, что супервизоры, определенные в секвенсоре, 
заданы для отдельных шагов и осуществляют мониторинг времени 
выполнения только соответствующего действия. Если, например, мотор 
включен на шаге 1, время выполнения показывает длительность шага 1. 
Когда шаг деактивируется, мотор более не подвергается мониторингу в 
секвенсоре. Если Вы хотите наблюдать мотор непрерывно и независимо от 
секвенсора, это может быть сделано на лежащем в основе уровне модуля. 

Ситуации прекращения 
Ситуации прекращения появляются, когда из-за критической ситуации или 
ошибки модуля возникают "немедленный стоп" или "аварийное выключение": 

• Секвенсоры останавливаются переключением в SW_MAN. 

• На уровне модуля выходные сигналы деактивируются при сбросе 
разрешения автомата. 
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Синхронизация 
Синхронизация секвенсора с состоянием процесса или машины необходима, 
по крайней мере, в следующих ситуациях:  

• Случай 1: Изменение программы в период установки и запуска означает,  
что экземплярный DB должен быть регенерирован. 

• Случай 2: В ручном режиме, модули управляются вручную, так что 
состояние секвенсора более не соответствует состоянию сигнала 
процесса или машины. Вследствие ручного вмешательства, и в 
зависимости от процесса автоматический режим должен быть продолжен 
начиная с текущего состояния системы или машины; другими словами, 
текущая позиция секвенсора должна быть приспособлена к процессу 
(синхронизирована). 

В случае 1, команда меню Debug > Control Sequencer [Отладка > 
Управление секвенсором] может использоваться в ручном режиме для 
сброса и установки шагов, при работе на программаторе, с тем чтобы 
установить состояние, которое существовало до изменения программы.  

В случае 2, синхронизация может быть активирована непосредственно с 
программатора. Синхронизация в этом случае включает следующие шаги: 

1. Выберите команду меню Options > Block Settings [Возможности > 
Настройки блока] и убедитесь, что на закладке "Compile/Save 
[Компиляция и сохранение]" выбрана опция "Synchronization 
[Синхронизация]". 

2. Выберите команду меню Debug > Synchronization [Отладка > 
Синхронизация]. 

Результат: Выявляются все переходы и условия блокировки. Выполняемые 
подпоследовательности показываются с шагами, которые расположены 
между открытым и не закрытым переходами. Все найденные шаги показаны 
желтым. 

3. Щелкните на всех шагах, которые Вы хотите выбрать, используя курсор 
мыши, который принимает вид перекрестья.  

4. Выберите шаги кнопкой "Activate [Активировать]" button.  

В принципе, Вы можете синхронизироваться, используя консоль (например, 
операторскую панель). Это возможно, если включено выполнение 
непрерывного вычисления условий переходов и блокировок, тогда результат 
отображается, а требуемые шаги могут быть активированы с консоли.  

Программно управляемая синхронизация возможна также, например, когда 
сигнал кнопки приводит к изменению из начального шага к 
синхронизованному шагу, в котором оценивается состояние переходов, 
разрешающих завершение шага. Используя команду скачка, секвенсор может 
переключиться к соответствующему шагу. 
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Изменения при установке и вводе в эксплуатацию  
Если в структуре секвенсора при вводе в эксплуатацию были сделаны 
изменения, например, добавлены, удалены или перенумерованы шаги или 
переходы, при компиляции секвенсора создается новый экземплярный DB. 
Загрузка экземплярного DB в PLC имеет тот же эффект, что и инициализация 
с использованием входа INIT_SQ, другими словами, активируются все 
начальные шаги, а все другие деактивируются. Действия, тем не менее, не 
аннулируются автоматически. Загружайте экземплярный DB только в ручном 
режиме, чтобы избегнуть ошибок, которые могут появиться при перезаписи 
данных. 

Используя команду меню Debug > Control Sequencer [Отладка > 
Управление секвенсором], Вы можете сбросить секвенсор в то состояние, 
которое было прежде чем были сделаны изменения. 

 
 Предупреждение 

Используя команду меню Debug > Control Sequencer [Отладка > 
Управление секвенсором], Вы можете изменить режим секвенсора 
непосредственно в S7-GRAPH. Если секвенсор и базовые функции 
мониторинга и управления обеспечены параметрами, как описано в 
«Обработка режимов», это означает, что режим секвенсора более не 
соответствует базовым функциям. Если Вы хотите избежать этого, изменение 
режима, включаемое с программатора, должно быть запрещено. Следующая 
диаграмма иллюстрирует принцип. 

 

 

По этой логике, секвенсор после одного цикла переустанавливается в 
состояние, установленное сигналами автомат/с подталкиванием/ручной. 

SW_MAN 

SW_AUTO
SW_TAP

Автом.

С подтвержд. 

Ручн. 

&

&

&

FB секвенсора

AUTO_ON
TAP_ON
MAN_ON 
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14.3 Связь с системами операторского наблюдения и  
управления  

Задача машины или системы – производство. В процессе нормальной 
работы, отображение состояния процесса обычно не имеет значения. 
Ситуация изменяется, когда в процессе возникает неполадка. В этом случае 
это важно, чтобы определить и устранить причину по возможности быстро. С 
функциями мониторинга и блокировки S7-GRAPH и с стандартизованным 
диагностическим интерфейсом это требование выполняется идеально.  

Следующая диаграмма показывает взаимодействие между программатором  
с S7-GRAPH, ПЛК и операторской панелью. 

 

Создание диагностических данных  
Когда Вы компилируете секвенсор, Вы можете решить, должны ли также 
создаваться в дополнение к FB/DB диагностические данные 
предусмотренные опцией "сообщения с ALARM_SQ/ALARM_S". 

FB/DB

FB/DB

Номер сообщения, номер шага 

Кадр сообщения

OP 

Память
сообщения

PG 

PLC 

ProTool
с
ProAgent OP 

Проект

Диагностические
данные

SFC 17/18

Mot_EinS
S 4

S 5

FB секвенсора
S7 Graph 

Spind_On 

Execute 
KM_on
Carr_fwd

S
N



 Инструкции по проектированию 

S7-GRAPH для S7-300/400 Программирование систем последовательного управления 
A5E00290656-01 14-13 

Диагностические данные содержат структурированные данные секвенсора и 
могут быть связаны соответствующим проектом OP, использующим ProAgent.  

Это обеспечивает выполнение операторской панелью следующих функций: 

• Отображение текущего состояния секвенсора с текущими именами 
секвенсора и шагов  

• Отображение шага с неполадками (имя и номер шага) 

• Отображение причины неполадок, другими словами, : 

- Если появляется ошибка супервизора: Отображение разрешающего 
условия пропущенного шага  

- Если появляется ошибка блокировки: Отображение условия 
пропущенной блокировки. 

Если Вы изменяете адреса в SIMATIC Manager, используя команду меню 
Rewire [Перемонтаж], и эти адреса используются также секвенсором, 
соответствующие диагностические данные будут обновлены только после 
открытия соответствующего FB S7-GRAPH вновь и его сохранения. 

Создание сообщений 
Для отображения неполадок, например, на операторской панели, Вы должны 
выбрать опцию "Message with [сообщения с использованием] ALARM_SQ / 
ALARM_S (SFC17/SFC18)” на закладке  "Messages [Сообщения]", которую Вы 
можете отобразить используя команду меню Options > Block Settings 
[Возможности > Установки блока]. Если эта опция выбрана, сообщение 
вводится в память сообщений CPU выбранными SFC, и автоматически 
передается на операторскую панель. Кадр сообщения содержит не только 
автоматически назначаемый номер сообщения, но и номер текущего шаг, что 
позволяет операторской панели отобразить соответствующий текст и, в 
зависимости от вида отображения, соответствующие условия. 

Независимо от сообщения, устанавливается бит групповой ошибки, который 
отображается на операторской панели в зависимости от вида отображения. 

На операторской панели возможен ряд видов отображения секвенсора: 

• Обзорный уровень 
Все модули отображаются с их текущим шагом. Каждый блок секвенсора 
представляется как модуль. Если секвенсор имеет неполадки, эта строка 
маркируется символом . Если выбрана эта строка, Вы можете переклю-
читься непосредственно на уровень детального отображения, используя 
функциональную клавишу. 

• Уровень отображения сообщения 
Отображается текущее сообщение с датой и временем. С этого уровня 
Вы можете переключиться непосредственно на уровень детального 
отображения. 

• Детальное отображение 
Сегмент с неполадками отображается как контактный план или как список 
команд, где выделяются недостающие условия. Вы имеете также возмож-
ность отображения всего сегмента или его части, содержащей только 
влияющие условия. Это в частности удобно при сильно развитых 
логических операциях. 
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 Замечания 
• Если Вы используете стандартную FC71, Вам не требуются блоки  

SFC17/SFC18. Однако сообщения могут обрабатываться с 
использованием SFC52 ("WR_USMSG"). 

• Если Вы используете стандартную FC73, сообщения не генерируются, из-
за минимизации конфигурации памяти. 
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15 Экземплярный DB 

Каждому FB GRAPH назначается экземплярный блок данных, который 
является представлением памяти FB. Он содержит данные, относящиеся к 
секвенсору, другими словами, все данные и параметры, необходимые для 
выполнения FB:  

• все параметры FB для выбранного множества параметров  

• описание шагов-переходов (например, текущее или последнее время 
активности шага с нарушениями или без; индикатор активности шага). 

Данные вносятся автоматически. 

15.1 Установки для экземплярного DB 

Включение экземплярного DB 
Чтобы создавать экземплярный DB автоматически после безошибочной 
компиляции FB, включите опцию "Include Instance DB [Включая экземплярный 
DB]" на закладке "General [Общее]" (команда меню Options > Application 
Settings [Возможности > Настройки приложения]). Если эта опция 
включена, при компиляции и загрузке блока S7-GRAPH проверяет надо ли 
создавать или обновлять экземплярный DB и выполняет необходимые 
действия. 

Описание интерфейса 
На закладке "Save/Compile [Сохранение/Компиляция]" возможны три 
установки для описания интерфейса экземплярного DB: 

• Memory minimized (as of V5.1) [Минимизация памяти (с версии V5.1)] 
Описание интерфейса хранится в экземплярном как структуры. 
Отдельные структуры с существенной информацией создаются для 
каждого шага и каждого перехода секвенсора. Эта настройка значительно 
сокращает требования к памяти Вашего FB S7-GRAPH. Однако блоки, 
созданные иначе, имеют возможности диагностики. При мониторинге 
системы последовательного управления Вы наблюдаете состояние 
условий только для активного шага.  
Если Вы используете эту возможность, Вы должны использовать 
поставляемый стандартный блок FC75. 
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Использование стандартных блоков FC70, FC71, FC72 и FC73  

• Structure  Arrays [Массивы структур] 
Описание интерфейса хранится в экземплярном как поле (массивы). Эта 
функция оптимизирует требования к памяти функционального блока 
S7-GRAPH. Однако имена шагов не сохраняются. В этом случае 
невозможна символьная адресация других блоков.  

• Individual Structures [Отдельные структуры] 

Описание интерфейса хранится в экземплярном как структуры (STRUCT). 
Для каждого шага и каждого перехода секвенсора создается отдельная 
структура с подробной информацией. Это удобный метод, обеспечива-
ющий, обеспечивающий внутренний и внешний доступ с использованием 
символьных имен. Данные экземплярного DB можно оценивать, исполь-
зуя как прямой доступ к данным, так и с использованием имен шагов и 
переходов. Структурирование увеличивает размер экземплярного DB, но 
не влияет на исполнение секвенсора. 

15.2 Назначение экземплярного DB и FB S7-GRAPH  

В общем, S7-GRAPH автоматически назначает DB для блока. Если DB с тем 
же номером, что и FB еще не существует, этот номер автоматически 
присвпйвается DB. Во всех других случаях (при компилировании исходника), 
Вы должны ввести номер DB. Для этого выполните: 

• Выберите команду меню File > Modify/Adapt Instance DB Number [Файл 
> Изменить номер экземплярного DB] и введите новый номер DB в 
появившемся диалоговом name окне. Создается экземплярный DB 
соответствующий FB. 

Предложение номера DB при первой компиляции исходного файла  
При первом создании экземплярного DB (автоматически или вручную), 
S7-GRAPH предлагает выбрать номер DB в том же окне, где и номер FB. 
Если Ваш функциональный блок, например, называется "FB6", S7-GRAPH 
предложит "DB6". Вы можете или согласиться с предложенным номером DB 
или нажать кнопку "Select [Выбор]" и выбрать другой номер DB или другой 
путь. 
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15.3 Автоматическое создание DB при сохранении 

Если Вы включили опцию "Include Instance DB [Включая экземплярный DB]" 
на закладке "General [Общее]", которая отображается командой меню 
Options > Block Settings [Возможности > Установки блока], выполните 
следующий шаги: 

• Запрограммируйте FB S7-GRAPH и выберите команду меню File > Save 
[Файл > Сохранить]. 

Результат: Сохраняется FB S7-GRAPH и создается экземплярный DB. 

 
 Предупреждение 

Блок данных не следует создавать или удалять вручную, если Вы установили 
опцию "message with [сообщения с] ALARM_SQ / ALARM_S (SFC17 / SFC18)" 
на закладке "Messages [Сообщения]" (команда меню Options > Block 
Settings [Возможности > Установки блока]), в противном случае 
сообщения могут быть потеряны. При этом экземплярный блок данных 
включается автоматически. 

 

15.4 Последующее создание экземплярного DB  

 Если Вы не выбрали опцию "Include Instance DB [Включая экземплярный DB]" 
на закладке "General [Общее]", выполните следующие шаги: 

1. Запрограммируйте FB S7-GRAPH и выберите команду меню File > Save 
[Файл > Сохранить]. 

2. Если FB S7-GRAPH откомпилирован без ошибок, выберите команду меню 
File > Create Instance DB [Файл > Создать экземплярный DB]. 

Результат: Создается новый или переписывается старый экземплярный 
DB. 

15.5 Отображение и распечатка экземплярного DB 

Для отображения и распечатки содержания экземплярного DB, выполните 
следующие шаги: 

1. Откройте DB в SIMATIC Manager двойным щелчком на нем в 
соответствующей программе пользователя. 

2. Выберите команду меню View > Data View [Вид > Вид данных] в 
редакторе LAD/STL/FBD. 

3. Для распечатки содержания экземплярного DB, выберите команду меню 
File > Print [Файл > Печатать]. 
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15.6 Доступ к экземплярному DB 

Вы имеете доступ к экземплярному DB внутренне, другими словами,  в 
пределах FB S7-GRAPH (например, связывая действия с событиями) или 
извне, другими словами, за пределами  FB S7-GRAPH (например, 
подключаясь к различным блокам). 

Доступ к данным экземплярного DB  
Вы имеете доступ к экземплярному DB средствами STEP 7. Мы, однако, 
настоятельно советуем не редактировать DB. 

15.7 Структура экземплярного DB 

Структура экземплярного DB зависит от установок, сделанных на закладке 
"Compile / Save [Скомпилировать / Сохранить]" (команда меню Options > Block 
Settings [Возможности > Установки блока] ). На размер и содержание влияют 
следующие факторы. 

1. Множество параметров, выбранное для FB 

2. Описание интерфейса для данных, относящихся к шагам и переходам 
(минимизация памяти/массивы структур/отдельные структуры). Данные 
вводятся автоматически. 

3. Возможность ввода данных для критериев анализа. 

4. Число и размер пользовательских переменных 

15.8 Обзор структуры экземплярного DB 

Следующая таблица иллюстрирует деление экземплярного DB.  
Область Идентификатор Длина 
Параметры FB  Имена входов и выходов 

параметров FB S7-GRAPH  
В зависимости от выбранного набора 
параметров: 
2 байта: minimum [минимум] 
10 байт:Standard/Maximum [Стандарт/Максимум] 
Индивидуально: Maximum V5/User-def. 
[Максимум V5/ Определ. пользователем] 

Резервная рабочая 
область 

G7T_0  16 байт 

Переходы Имя перехода (например, 
Trans1, Trans2) 

(число переходов)  16 байт 

Резервная рабочая 
область  

G7S_0 32 байта  

Шаги Имя шага (например, 
Step1, Step2) 

(число шагов)  32 байта 

Состояние 
секвенсора 

- - 

Внутренняя рабочая 
область  

- - 
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15.9 Параметры FB  

Параметры FB расположены в экземплярном DB. Размер, требуемый для 
хранения параметров FB зависит от установок, сделанных на странице 
"Compile / Save [Компилировать / Сохранить]", появляющейся по команде 
меню Options > Block Settings [Возможности > Установки блока] 
(минимальный, стандартный,  максимальный или определенный 
пользователем набор параметров). (Если, например, выбран минимальный 
набор параметров, отображается только параметр INIT_SQ). 

Следующая таблица показывает максимальный набор параметров V5 (можно 
определять). 
 

Параметр 
 

Описание 
 

Тип 
данных 

Внутр. 
чтение 

Внутр. 
запись 

Внешн.  
чтение  

Внешн.  
запись 

OFF_SQ OFF_SEQUENCE: 
Выключение секвенсора 

BOOL да нет да нет 

INIT_SQ INIT_SEQUENCE: 
Инициализация секвенсора 

BOOL да нет да нет 

ACK_EF ACKNOWLEDGE_ERROR_FAULT: 
Квитирование всех ошибок, 
принудительный переход к 
следующему шагу   

BOOL да нет да нет 

REG_EF REGISTRATE_ERROR_FAULT: 
Регистрация всех ошибок и 
неполадок 

BOOL да нет да нет 

ACK_S ACKNOWLEDGE_STEP  
Квитирование шага, показанного 
на S_NO 

BOOL да нет да нет 

REG_S REGISTRATE_STEP  
Регистрация шага указанного на 
S_NO 

BOOL да нет да нет 

HALT_SQ HALT_SEQUENCE 
Останов/реактивация секвенсора 

BOOL да нет да нет 

HALT_TM HALT_TIMES: 
Останов/реактивация таймеров 
активации всех шагов и инструк-
ций, зависящих от времени (L и D) 
в секвенсоре 

BOOL да нет да нет 

ZERO_OP ZERO_OPERANDS: 
Сброс всех адресов в инструкциях 
N, D, L в активных шагах в ноль и 
не выполнение вызовов инструк-
ций CALL в действиях / реактива-
ция адресов  и команд CALL. 

BOOL да нет да нет 

EN_IL ENABLE_БЛОКИРОВКАS: 
Деактивация/реактивация 
блокировок 

BOOL да нет да нет 

EN_SV ENABLE_СУПЕРВИЗОРS: 
Деактивация/реактивация 
супервизоров 

BOOL да нет да нет 
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Параметр 
 

Описание 
 

Тип 
данных 

Внутр. 
чтение 

Внутр. 
запись 

Внешн.  
чтение  

Внешн.  
запись 

EN_ACKREQ ENABLE_ACKNOWLEDGE_ 
REQUIRED: 
Активация обязательного 
квитирования 

BOOL да нет да нет 

EN_SSKIP ENABLE_STEP _SKIPPING: 
Активация сброса шага 

BOOL да нет да нет 

DISP_SACT DISPLAY_ACTIVE_STEPS: 
Отображение только активных 
шагов 

BOOL да нет да нет 

DISP_SEF DISPLAY_STEPS_WITH_ERROR_ 
OR_FAULT: 
Отображение только шагов с 
ошибками и нарушениями  

BOOL да нет да нет 

DISP_SALL DISPLAY_ALL_STEPS: 
Отображение всех шагов 

BOOL да нет да нет 

S_PREV PREVIOUS_STEP: 
Автоматический режим: 
Индикация предыдущей 
параллельного активного шага в 
S_NO  
Ручной режим: Индикация 
предыдущего шага (следующий 
меньший номер) 

BOOL да нет да нет 

S_NEXT NEXT_STEP: 
Автоматический режим: 
Индикация последующего парал-
лельного активного шага в S_NO  
Ручной режим: Индикация 
последующего шага (следующий 
больший номер)  

BOOL да нет да нет 

SW_AUTO SWITCH_MODE_AUTOMATIC: 
Изменение режима: 
Автоматический режим  

BOOL да нет да нет 

SW_TAP SWITCH_MODE_TRANSITION_AND 
_PUSH: 
Изменение режима: режим с 
подталкиванием ("полуавтомат") 

BOOL да нет да нет 

SW_TOP SWITCH_MODE_TRANSITION_OR_PU
SH: 
Изменение режима: Автомат или 
переключение к следующему 

BOOL да нет да нет 

SW_MAN SWITCH_MODE_MANUAL: 
Переключатель режима: Ручной 
режим, нет включения 
автоматического выполнения  

BOOL да нет да нет 

S_SEL STEP_SELECT: 
Выбор заданного шага для 
выходного параметра S_NO. 
Активация/деактивация в ручном 
режиме с S_ON, S_OFF. 

INT да нет да нет 

S_SELOK STEP_SELECT_OK: 
Использовать значение S_SEL 
для S_NO 

BOOL да нет да нет 
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Параметр 
 

Описание 
 

Тип 
данных 

Внутр. 
чтение 

Внутр. 
запись 

Внешн.  
чтение  

Внешн.  
запись 

S_ON STEP_ON: 
Ручной режим: Активация 
отображения шага 

BOOL да нет да нет 

S_OFF STEP_OFF: 
Ручной режим: Деактивация 
отображения шага  

BOOL да нет да нет 

T_PREV PREVIOUS_TRANSITION: 
Отображение предыдущего 
имеющего силу перехода в T_NO 

BOOL да нет да нет 

T_NEXT NEXT_TRANSITION: 
Отображение следующего 
имеющего силу перехода в T_NO 

BOOL да нет да нет 

T_PUSH PUSH_TRANSITION: 
Переход передает управление 
когда выполнено условие и 
имеется положительный фронт на 
T_PUSH; условие: режим с 
подталкиванием (SW_TAP) 

BOOL да нет да нет 

S_NO STEP_NUMBER 
Отображает номер шага 

INT да нет да нет 

S_MORE MORE_STEPS: 
Further active steps can be selected 
in S_NO 

BOOL да нет да нет 

S_ACTIVE STEP_ACTIVE 
Показывает активный шаг 

BOOL да нет да нет 

S_TIME STEP_TIME 
Время активности шага 

TIME да нет да нет 

S_TIMEOK STEP_TIME_OK: 
Нет ошибки во времени активации 
шага  

TIME да нет да нет 

S_CRITLOC STEP_CRITERIA_БЛОКИРОВКА 
Биты критерия блокировки 

DWORD да нет да нет 

S_CRITLOC 
ERR 

S_CRITERIA_IL_LAST_ERROR: 
Биты критерия блокировки для 
события L1 

DWORD да нет да нет 

S_CRITSUP STEP_CRITERIA_СУПЕРВИЗОР: 
Биты критерия супервизора  

DWORD да нет да нет 

S_STATE STEP_STATE: 
Биты состояния шага 

WORD да нет да нет 

T_NO TRANSITION_NUMBER: 
Номер открытого перехода 

INT да нет да нет 

T_MORE MORE_TRANSITIONS: 
Другие открытые переходы, 
доступные для отображения  

BOOL да нет да нет 

T_CRIT TRANSITION_CRITERIA: 
Биты условий переходов 

DWORD да нет да нет 

T_CRITOLD T_CRITERIA_LAST_CYCLE: 
Биты условий переходов от 
последнего цикла  

DWORD да нет да нет 
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Параметр 
 

Описание 
 

Тип 
данных 

Внутр. 
чтение 

Внутр. 
запись 

Внешн.  
чтение  

Внешн.  
запись 

T_CRITFLT T_CRITERIA_LAST_FAULT: 
Биты условий переходов для 
событий V1 

DWORD да нет да нет 

ERROR БЛОКИРОВКА_ERROR: 
Ошибка блокировки (любой шаг) 

BOOL да нет да нет 

FAULT СУПЕРВИЗОР_FAULT: 
Ошибка супервизора (любой шаг) 

BOOL да нет да нет 

ERR_FLT IL_ERROR_OR_SV_FAULT: 
Групповая неполадка 

BOOL да нет да нет 

SQ_ISOFF SEQUENCE_IS_OFF: 
Секвенсор выключен 

BOOL да нет да нет 

SQ_HALTED SEQUENCE_IS_HALTED: 
Секвенсор остановлен 

BOOL да нет да нет 

TM_HALTED TIMES_ARE_HALTED: 
Таймеры остановлена 

BOOL да нет да нет 

OP_ZEROED OPERANDS_ARE_ZEROED: 
Сброс адресов 

BOOL да нет да нет 

IL_ENABLED INTERLOCK_IS_ENABLED: 
Блокировки разрешены 

BOOL да нет да нет 

SV_ENABLED SUPERVISOR_IS_ENABLED: 
Супервизоры разрешены  

BOOL да нет да нет 

ACKREQ_EN 
ABLED 

ACKNOWLEDGE_REQUIRED_IS_ 
ENABLED: 
Активировано обязательное 
квитирование 

BOOL да нет да нет 

SSKIP_EN 
ABLED 

STEP_SKIPPING_IS_ENABLED: 
Активирован пропуск шага 

BOOL да нет да нет 

SACT_DISP ACTIVE_STEPS_WERE_DISPLAYED 
Отображение списка только 
активных шагов  

BOOL да нет да нет 

SEF_DISP STEPS_WITH_ERROR_FAULT_WERE_ 
DISPLAYED: 
Отображение списка шагов только 
с ошибками и неполадками   

BOOL да нет да нет 

SALL_DISP ALL_STEPS_WERE_DISPLAYED: 
Отображение списка всех шагов 

BOOL да нет да нет 

AUTO_ON AUTOMATIC_IS_ON: 
Индикатор автоматического 
режима 

BOOL да нет да нет 

TAP_ON T_AND_PUSH_IS_ON: 
Индикатор режима с 
подталкиванием 

BOOL да нет да нет 

TOP_ON T_OR_PUSH_IS_ON: 
Отображение режима SW_TOP  

BOOL да нет да нет 

MAN_ON MANUAL_IS_ON: 
Индикатор ручного режима 

BOOL да нет да нет 
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15.10 Структура перехода 

В экземлярном DB создается структура со следующими параметрами для 
каждого, содержащегося в секвенсоре FB S7-GRAPH перехода: 
 

Компо-
нент 

Описание 
 

Тип 
данных 

Внутр.
чтение 

Внутр. 
запись 

Внешн. 
чтение  

Внешн.  
запись 

TV Переход действителен BOOL да нет да нет 
TT Условие перехода выполняется  BOOL да нет да нет 
TS Переход переключает BOOL да нет да нет 
CF_IV Ввод CRIT_FLT ошибочен BOOL да нет да нет 
TNO Индикация номера перехода, 

определенного пользователем  
INT да нет да нет 

CRIT Состояние максимум 32 
элементов LAD/FBD перехода в 
текущем цикле обработки  

DWORD да нет да нет 

CRIT_OLD Состояние максимум 32 
элементов LAD/FBD перехода в 
предыдущем цикле обработки  

DWORD да нет да нет 

CRIT_FLT Копия CRIT, если появилась 
ошибка 

DWORD да нет да нет 

Вариант "Memory minimized [Минимизация памяти]"  
Если Вы выбрали вариант "Memory minimized [Минимизация памяти]", 
создается массив, со структурами переходов, аналогично варианту "Structure 
fields [Структурированные поля]". Как структурные элементы хранятся только 
булевские компоненты TV, TT, TS. Внутренний и внешний доступ тот же, что в 
варианте "Structure fields [Структурированные поля]". 

Вариант "Structure arrays [Массивы структур]"  
Если Вы выбрали вариант "Structure arrays [Массивы структур]", создается  
массив, содержащий структуры переходов. 
Имя массива Длина в байтах 
G7T (число переходов)  16  

Внутренний доступ использует номер перехода с последующим именем 
структурного элемента. 

Это означает, что возможен следующий доступ в условиях или действиях: 

• T003.TT 

• T017.CRIT 

Внешний доступ использует только элемент массива, дополненное именем 
структурного элемента. 

Предупреждение: Индекс массива – внутренний номер перехода, не равный 
номеру, присвоенному пользователем. 

• G7T[1].TT 

• G7T[3].CRIT 
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Вариант "Individual structures [Отдельные структуры]"  
Если Вы выбрали вариант "Individual Structures [Отдельные структуры]", 
структуры переходов вводятся в отдельные разделы экземплярного DB, одна 
за другой следующим образом: 
 
Имя структуры Длина в байтах 
<Aktionen_Transition> 16 
...  
<ASCII_Transition> 16 

Внутренний доступ использует номер или имя перехода, дополненные 
именем структурного элемента.  

Это означает, что возможен следующий доступ в условиях или действиях: 

• T003.TT 

• T017.CRIT 

• VALVE_ON.TT 

Внешний доступ использует только имя перехода (Имя структуры) 
дополненное именем элемента структуры. 

• VALVE_ON.TT 

• VALVE_ON.CRIT 
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15.11 Структура шага 

DB создается следующая структура со следующими компонентами для 
каждого шага секвенсора в FB S7-GRAPH: 
 

Компонент 
 

Описание 
 

Тип 
данных 

Внутр.
чтение 

Внутр. 
запись 

Внешн. 
чтение  

Внешн.  
запись 

S1 Шаг активируется BOOL Да нет да нет 
L1 Состояние снятия блокировки  BOOL Да нет да нет 
V1 Состояние возникновения 

супервизора 
BOOL Да нет да нет 

R1 Зарезервировано BOOL Нет нет нет нет 
A1 Ошибка квитирована BOOL да нет да нет 
S0 Шаг деактивирован BOOL да нет да нет 
L0 Состояние возникновения 

блокировки 
BOOL да нет да нет 

V0 Состояние снятия супервизора  BOOL да нет да нет 
X Шаг активирован BOOL да нет да нет 
LA Блокировка не удовлетворяется  BOOL да нет да нет 
VA Супервизор активирован  BOOL да нет да нет 
RA Резерв BOOL нет нет нет нет 
AA Резерв  BOOL нет нет нет нет 
SS Системная внутренняя BOOL нет нет нет нет 
LS Прямой результат 

запрограммированной блокировки 
BOOL да нет да нет 

VS Прямой результат запрограмми-
рованного супервизора 

BOOL да нет да нет 

SNO Пользовательский номер шага INT нет нет да нет 
T Общее время активации шага  TIME да нет да нет 
U Время активации шага за 

исключением времени неполадок  
TIME да нет да нет 

CRIT_LOC Состояние максимум 32 
элементов LAD/FBD блокировки в 
текущем цикле обработки   

DWORD да нет да Нет 

CRIT_LOC_ 
ERR 

Копия CRIT_LOC, при снятии со-
стояния блокировки (событие L1)  

DWORD да нет да Нет 

CRIT_SUP Состояние максимум 32 
элементов LAD/FBD супервизора в 
текущем цикле обработки 

DWORD да нет да Нет 

SM Системная внутренняя BOOL нет нет нет Нет 
LP Системная внутренняя BOOL нет нет нет Нет 
LN Системная внутренняя BOOL нет нет нет No 
VP Системная внутренняя BOOL нет нет нет No 
VN Системная внутренняя BOOL нет нет нет No 
H_IL_ERR Системная внутренняя BYTE нет нет нет No 
H_SV_FLT Системная внутренняя BYTE нет нет нет No 
RESERVED Резерв DWORD нет нет нет No 
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Вариант "Structure arrays [Массивы структур]"  
Если Вы выбрали вариант "Structure arrays [Массивы структур]", генерируется 
поле с структурами шагов, а именно: 
 
Имя массива Длина в байтах 
G7S (число шагов)  32  

Внутренний доступ использует номер шага, дополненный именем 
структурного элемента. 

Это означает, что возможен следующий доступ в условиях или действиях: 
• S003.X 
• S017.T 

Внешний доступ использует только элемент массива, за которым следует имя 
структурного элемента. 

Предупреждение: Индекс массива это внутренний номер шага, который 
может отличаться от номера, присвоенного пользователем. 
• G7S[1].X 
• G7S[3].T 

Вариант "Memory minimized [Минимизация памяти]"  
Если Вы установите опцию "Memory minimized [Минимизация памяти]", 
создается массив с структурами шагов аналогично варианту "Structure fields 
[Поля структур]". Как структурные элементы сохраняются только булевские 
компоненты и время активации шага T.  

Внутренний и внешний доступ тот же, что в варианте "Structure fields [Поля 
структур]". 

Вариант "Individual structures [Отдельные структуры]"  
Если Вы выберите вариант "Individual Structures [Отдельные структуры]", 
структуры шагов вводятся в экземплярный DB как отдельные разделы, 
следующим образом: 
 
Имя структуры Длина в байтах 
<Step1> 32 
...  
<Stepn> 32 

Внутренний доступ использует номер шага или имя шага, за которым следует 
имя структурного элемента.  

Это означает, что возможен следующий доступ в условиях или действиях: 
• S003.X 
• S017.T 
• DRY.X 
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Внешний доступ использует только имя шага (Имя структуры), за которым 
следует имя структурного элемента, например: 
• DRY.X 
• DRY.T 

15.12 Состояние секвенсора 

Область состояния секвенсора содержит отдельные компоненты (массивы 
или структуры), содержащие информацию о состоянии секвенсора, например, 
следующее: 

• Компонент непрерывных инструкций 

• Компонент индексированных массивов 

• Компонент режима (Режим работы [Mode of Operation, MOP]) 

• времени активации 

• Компонент группы битов 

Область состояния секвенсора начинается с адреса: a = длина параметров 
FB + длина (длины) массива переходов + длина (длины) массива шагов. 

Постоянные инструкции 
Этот компонент области состояния секвенсора  описывает постоянные 
инструкции  которые могут быть запрограммированы до или после 
секвенсора. Компонент опускается, если  постоянные инструкции не 
запрограммированы. 
 

Имя 
 

Описание 
 

Тип дан-
ных 

Длина 
 

Внутр.
чтение 

Внутр. 
запись 

Внешн. 
чтение  

Внешн.  
запись 

PRE_CRIT Состояние постоянных 
инструкций предшеству-
ющих секвенсору  

DWORD 0 - n нет нет Да нет 

POST_CRIT Состояние постоянных 
инструкций следующих 
за секвенсором  

DWORD 0 - n нет нет Да нет 

PRE_CNT Число постоянных 
инструкций предшеству-
ющих секвенсору  

WORD  нет нет да нет 

POST_CNT Число постоянных 
инструкций следующих 
за секвенсором  

WORD  нет нет да Нет 
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Массивы индексов 
Первый компонент области состояния секвенсора содержит массивы 
индексов для управления внутренними номерами шагов и переходов. 

 
Имя 
индекса 
 

Описание 
 

Тип 
дан-
ных 

Длина в 
байтах 

Внутр. 
чтение 

Внутр. 
запись 

Внешн. 
чтение  

Внешн.  
запись 

TVX Массив действительных 
переходов 

BYTE <intern> нет нет да нет 

TTX Массив переходов с 
выполнением условий 

BYTE <intern> нет нет да нет 

TSX Массив переключающих 
переходов 

BYTE <intern> нет нет да нет 

S00X Массив шагов, которые дол-
жны быть деактивированы 
(второй от конца цикл) 

BYTE <intern> нет нет нет нет 

SOFFX Массив 1 шагов, которые 
должны быть 
деактивированы  

BYTE <intern> нет нет нет нет 

SONX Массив 1, которые должны 
быть активированы шагов  

BYTE <intern> нет нет нет нет 

SAX Массив активных шагов BYTE <intern> нет нет да нет 
SERRX Массив шагов с неполадками BYTE S_CNT+2 нет нет да нет 
SMX Массив маркированных 

шагов 
BYTE S_CNT+2 нет нет нет нет 

S0X Массив 2 шагов  BYTE S_CNT+2 нет нет нет нет 
S1X Массив 2 шагов, которые 

должны быть активированы  
BYTE S_CNT+2 нет нет нет нет 

S_DISPLAY Копия выходного параметра  
S_NO (может быть также 
оценена, если выбрано 
минимальное множество 
параметров) 

INT 2 yes нет да нет 

S_SEL_OLD Системная внутренняя INT 2 нет нет нет нет 
S_DISPIDX Системная внутренняя BYTE 1 нет нет нет нет 
T_DISPIDX Системная внутренняя BYTE 1 нет нет нет нет 

Длина массивов индексов 
Длина массивов индексов от TVX до S1X оценивается следующим образом:  

l = (максимальное число элементов) + 2 

Массивы индексов структурируются следующим образом: 
 
Array[0] = Индекс первой свободной позиции массива 
Array[1] - Array[n-2] = Вводы 

Array[n-1] = 0 (индикатор конца массива) 

Новые вводы добавляются в конце. Когда вводы удаляются, массив 
смещается. Это означает, например, что в массиве активных шагов (SAX) 
шаг, который активен дольше всего, имеет меньший индекс. 
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Режимы 
 описывает режимы, другими словами,  состояние или изменение режима и 
коды. 

Создается структура со следующими компонентами: 
 

Имя 
 

Описание 
 

Тип 
дан-
ных 

Внутр. 
чтение 

Внутр. 
запись 

Внешн. 
чтение  

Внешн.  
запись 

AUTO Переключение в автоматический 
режим 

BOOL да да да Да 

MAN Переключение в ручной режим  BOOL да да да Да 
TAP Переключение в режим с 

подталкиванием 
BOOL да да да Да 

TOP Переключение в автоматический 
режим или переключение в 
следующий режим  

BOOL да да да Да 

ACK_S Резерв BOOL нет нет нет Нет 
REG_S Резерв BOOL нет нет нет Нет 
T_PREV Резерв BOOL нет нет нет Нет 
T_NEXT Резерв BOOL нет нет нет Нет 
LOCK Активация/деактивация обработки 

блокировки 
BOOL да да да Да 

SUP Активация/деактивация обработки 
супервизора 

BOOL да да да Да 

ACKREQ Резерв BOOL нет нет нет Нет 
SSKIP Резерв BOOL нет нет нет Нет 
OFF Деактивация секвенсора  BOOL да да да Да 
INIT Активация начальных шагов   BOOL да да да Да 
HALT Остановить/продолжить секвенсор BOOL да да да Да 
TMS_HALT Остановить/продолжить таймеры BOOL да да да Да 
OPS_ZERO Деактивировать/активировать 

действия 
BOOL да да да Да 

SACT_DISP Резерв BOOL нет нет нет Нет 
SEF_DISP Резерв BOOL нет нет нет нет 
SALL_DISP Резерв BOOL нет нет нет нет 
S_PREV Автоматический режим: Индикация 

предыдущего одновременно 
активного шага на S_NO 
Ручной режим: Индикация 
следующего меньшего номера шага  

BOOL да да да да 

S_NEXT Автоматический режим: Индикация 
следующего одновременно 
активного шага на S_NO  
Ручной режим: Отображение 
следующего большего номера шага 

BOOL да да да да 

S_SELOK Резерв BOOL нет нет нет нет 
S_ON Ручной режим: активация 

отображаемого шага 
BOOL да да да да 



Экземплярный DB 

 S7-GRAPH для S7-300/400 Программирование систем последовательного управления 
15-16 A5E00290656-01 

Имя 
 

Описание 
 

Тип 
дан-
ных 

Внутр. 
чтение 

Внутр. 
запись 

Внешн. 
чтение  

Внешн.  
запись 

S_OFF Ручной режим: деактивация 
отображаемого шага  

BOOL да да да да 

T_PUSH Режим с подталкиванием:  
Переход передает управление, 
когда выполненное условие 
подтверждается T_PUSH 

BOOL да да да да 

REG Резерв BOOL нет нет нет нет 
ACK Квитирование ошибки BOOL да да да да 
IL_PERM Постоянная блокировка работы BOOL да да да да 
T_PERM Постоянная обработка переходов BOOL да да да да 
ILP_MAN Постоянная блокировка работы в 

ручном режиме 
BOOL да да да да 

Индикация режимов 
Компонент режимов хранится в экземплярном DB следующим образом: 
 
Имя 
структуры 

Описание Длина в 
байтах 

MOPEDGE Системная внутренняя 4 
MOP Изменение режимов и индикаторы 4 

Пример: 
Как только установится вход MOP.MAN, режим переключается в MANUAL. Он 
может быть установлен или управляющей программой (например, действием 
в секвенсоре) или функцией PG "Modify Variable [Модификация переменной]" 
или использование панели оператора.  

Время активности 
Следующие компоненты содержат структуру, состоящую из информации о 
вычислении времени активности. Они оцениваются только внутренне 
системой. 
 
Имя 
структуры 

Описание Длина в 
байтах 

TICKS Системная внутренняя 12 
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Групповые биты  
Последний компонент области состояния секвенсора содержит групповые 
биты, которые наблюдают внутреннее состояние секвенсора. Структура для 
данной группы битов создается следующим образом: 

 
Имя Описание Тип 

дан-
ных 

Внутр. 
чтение 

Внутр. 
запись 
 

Внешн. 
чтение  

Внешн.  
запись 

ERR_FLT Групповая ошибка BOOL да нет да нет 
ERROR Ошибка блокировки  BOOL да нет да нет 
FAULT Ошибка супервизора  BOOL да нет да нет 
RT_FAIL Групповая индикация: 

ошибка исполнения 
BOOL да нет да нет 

NO_SNO Выбранный шаг не 
существует  

BOOL да нет да нет 

NF_OFL Слишком много шагов 
для активации или 
деактивации  

BOOL да нет да нет 

SA_OFL Слишком много 
активных шагов  

BOOL да нет да нет 

TV_OFL Слишком много 
удовлетворенных 
переходов  

BOOL да нет да нет 

MSG_OFL Слишком много 
сообщений  

BOOL да нет да нет 

NO_SWI Зарезервировано BOOL нет нет нет нет 
CYC_OP Системная внутренняя BOOL нет нет нет нет 
AS_MSG Системная внутренняя BOOL нет нет нет нет 
AS_SEND Системная внутренняя BOOL нет нет нет нет 
SQ_BUSY Системная внутренняя BOOL нет нет нет нет 
SA_BUSY Системная внутренняя BOOL нет нет нет нет 
AS_SIG Системная внутренняя BOOL нет нет нет нет 

 

Компоненты с групповым битами  хранятся в экземплярном DB следующим 
образом: 
 
Имя структуры Тип Описание Длина в 

байтах 
SQ_FLAGS t_sq_flags Групповые биты 2 
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15.13 Внутренняя область данных 

Эта часть экземплярного DB - внутренняя системная область. Эти данные 
должны быть недоступными. Область данных разделена на 4 части:  

Внутренняя рабочая область 1 
 
Описание Данные Длина 
Внутренняя рабочая область 1 Переменная Переменная   

Описания условий 
Эти данные вводятся только, в том случае, если Вы выбрали настройку "With  
Data [С данными анализа критериев]". 

 
Адреса Описание Данные Длина 

 ADR_LOG_T[]: 
Описания для всех переходов с 
содержанием; начальный адрес в поле 
ADR_LOG_T[]; для пустых переходов 
вводится 0 и нет описания. 
LOG_Ti[] 
LOG_Tj[] 
... 
LOG_Tk[] 
Это возможно сопровождается 
заполнением байтов величиной 0 до 
конца LOG_Tx, чтобы следующие 
области запускались по четному адресу. 

 
BYTE[] 
BYTE[] 
... 
BYTE[] 

 

 ADR_LOG_L[]: 
Описание всех условий блокировок с 
содержанием; начальный адрес в поле  
ADR_LOG_L[]; для пустых блокировок 
вводится 0 и нет описания. 
LOG_Lp[] 
LOG_Lq[] 
... 
LOG_Lr[] 
Это возможно сопровождается 
заполнением байтов величиной 0 до 
конца LOG_Ly , чтобы следующие 
области запускались по четному адресу. 

 
BYTE[] 
BYTE[] 
... 
BYTE[] 

 

c 
S_CNT-2 
T_CNT 

ADR_LOG_T: 
Адреса описаний переходов LOG_Tx 
ADR_LOG_T[0...T_CNT] 

WORD[] (T_CNT+1)2 

c+2 
T_CNT+2 

ADR_LOG_L: 
Адреса блокировок LOG_Ly 
ADR_LOG_L[0...S_CNT] 

WORD[] (S_CNT+1)2 
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Адреса Описание Данные Длина 
c+2 
T_CNT+2 
S_CNT+4 

ADR_T1_CRITFLT: 
Адреса критериев переходов с 
нарушениями T1 ADR_T1_CRITFLT == 
address(G7T[1].CRIT_FLT) 

WORD 2 

c+2 
T_CNT+2 
S_CNT+6 

ADR_S1_CRITERR: 
Адреса критериев блокировок с 
нарушениями S1 ADR_S1_CRITERR == 
address(G7S[1].CRIT_ERR) 

WORD 2 

c+2 
T_CNT+2 
S_CNT+8 

ADR_SERRX: 
Адреса массивов шагов с неполадками 
SERRX[] ADR_SERRX == 
address(SERRX[0]) == e 

WORD 2 

n = Длина экземплярного DB в байтах 

Внутренняя рабочая область 2 
 

Описание  Длина 
Внутренняя рабочая область 2 Переменная Переменная   

Числовые данные секвенсора 
 

Адрес Описание Данные  Длина 
n-36 ADR_COND: 

Адрес конца описания условия  
ADR_COND == Адрес(ADR_LOG_T[0]) == 
c 

WORD   2 

n-34 MAX_TVAL: 
Макс. число одновременно 
действительных переходов   

BYTE   1 

n-33 MAX_SACT: 
Макс. число одновременно активных 
шагов   

BYTE   1 

n-32 MAX_CRIT: 
Макс. число критериев на условие  

BYTE   1 

n-31 T_CNT 
Число переходов  

BYTE   1 

n-30 SUP_CNT: 
Число супервизоров  

BYTE   1 

n-29 LOCK_CNT: 
Число блокировок  

BYTE   1 

n-28 S_CNT 
Число шагов  

BYTE   1 

n-27 SQ_CNT: 
Число ветвей  

BYTE   1 

n-26 PRS_INPAR: 
Диапазон входных параметров  

DWORD   1 

n-22 PRS_OUTPAR: 
Диапазон выходных параметров  

DWORD   1 
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Адрес Описание Данные  Длина 
n-18 SQ_FLAGS 

Флаги компилятора, часть 1 
WORD   6 

n-6 SQ_FLAGS 
Флаги компилятора, часть 2 
Bit.0 == 1 --> существует описание 
условий 

BYTE   1 

n-5 SQ_FLAGS 
Флаги компилятора, часть 3 

BYTE   1 

n-4 G7_FBMARK: 
Совместимость с критериями анализа FB  
(010 == 1.0) 

BYTE   1 

n-3 G7_RELEASE: 
Номер версии Graph (010 == 1.0) 

BYTE   1 

n-2 G7_ID2: 
Идентификатор Graph ("7") 

BYTE   1 

n-1 G7_ID1: 
Идентификатор Graph ("G") 

BYTE   1 

n = Длина экземплярного DB в байтах 
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Словарь 

--А— 

Анализ критериев 
Анализ критериев программа для S7 Graph, содержащая критерии FB и 
расширенный экземплярный DB. Анализ критериев обнаруживает и 
позволяет изменять состояния процесса с помощью системы 
последовательного управления S7. 

--Б-- 

Блокировка 
Блокировка – программируемое условие шага. Блокировка влияет на 
выполнение отдельных действий.  

--В— 

Ветвь LAD  
Ветвь LAD соответствует логике ИЛИ для элементов в переходах, 
блокировках и суперевизорах. 

Время выполнения 
Время выполнения инструкции – время, в течение которой инструкция 
активна; другими словами выполняется. 

Время обработки 
Время обработки – время, необходимое CPU для выполнения инструкции 
(действия, условия) и лежит в диапазоне мс на инструкцию. 
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--Д-- 

Действие  
Действие это исполняемая инструкция активного шага. 

Деактивация 
Деактивация означает, что выполнение шага прервано соответствующим 
переходом или из другого шага. 

--К-- 

Комментарий шага 
Это относящийся к шагу текст длиной до 2048 символов  

Контрольная точка 
Контрольная точка – точка программного цикла, начиная с которой установка 
или технологический процесс могут быть измены или опрошены. Имеются 
различные контрольные точки, например 

• системные 

• пользовательские 

--Н-- 

Начальная точка 
Начальная точка определяет начало программного цикла. Когда программа 
запускается, загружается область отображения входов (PII), отража.щих 
состояние процесса. 

Нормально открытый контакт/нормально закрытый контакт  
Нормально открытый и нормально закрытый контакты – операции битовой 
логики. Они используются как элементы в переходах, супервизорах или 
блокировках. 

• Нормально открытый контакт замкнут, когда булевский адрес установлен. 

• Нормально закрытый контакт замкнут, когда булевский адрес не 
установлен. 
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--О-- 

Область отображения процесса 
Область памяти CPU в которой находятся состояния входов и выходов.  

1. Область отображения входов: PII 

2. Область отображения выходов: PIQ. 

Отображение состояния 
Отображение состояния сигнала адреса на мониторе программатора, 
интерактивно подключенного к PLC. 

Оценка фронта 
Оценка фронта требуется для однаружения изменения состояния сигнала.  

Понятие фронт используется когда изменяется состояние сигнала (например, 
на входе). Положительный фронт означает, что сигнал изменяется из "0" вe 
"1". В противоположной ситуации – отрицательный фронт. 

--П-- 

Переход 
Переход – часть секвенсора, торая содержит условия передачи управления 
от одного шага к следующему. 

Действующий - переход, предшествующий шаг которого активен. 

Когда переход действиующий и условия разрешения шага выполняются, 
управление передается следующему шагу. Предшествующий шаг 
деактивируется, а последующий – активируется. 

Пользовательская контрольная точка 
Пользовательская контрольная точка – выбираемая точка в программе 
пользователя для отображния состояния сигналов. 

Пользовательская программа 
Пользовательская программа срдержит все блоки и инструкции программы.  

Путь в альтернативной ветви 
Путь в альтернативной ветви разделяет секвенсор на разлисные шаги в 
зависимости от нескольких параллельных переходов. 
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--С-- 

Секвенсор 
Секвенсор – основа системы последователного управления. С его помощтю 
создается и выполняетя программа последовательного управления.  

Секвенсор состоит из последовательности шагов, выполнение которых 
начинается в определенной зависимости от разрешвющих шаг условий.  

Система последовательного управления 
Система управления, в которой управление последовательно передается от 
одного шага другому в сосответствии с программными условиями.. 

Системная контрольная точка 
Системная контрольная точка – интерфейс между системой и программой 
пользователя. От системной контрольной точки, Вы можете наблюдать или 
изменять состояние переменных процесса и устанавливать состояния 
выходов с помощью программатора. 

Состояние 
Состояние сигнала одного бита по адоесу в PLC. 

Структурный элемент 
Структурный элемент – скачок или переход секвенсора. 

Супервизор 
Супервизор программируемое условие в пределах шага. Супервизор влияет 
на передачу управления от одного шага к следующему.  

--У— 

Условие разрешения шага 
Условие разрешения шага – булевская догическая операция, определяющая  
условия прекращения обработки одного шага и активации следующего. Оно 
является частью перехода. 
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--Ш-- 

Шаг 
Задача управления разбита на отдельные шаги. Действия, заданные в шагах,  
выполняются контроллером в отдельных состояниях (например, для 
управления выходами или активации и деактивации других шагов). 
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А 
Автомат или переключение к следующему 

(SW_TOP), 9-15 
Автоматическая компиляция при сохранении 

FB S7-GRAPH, 8-16 
Автоматический менеджер лицензий, 2-1, 2-3, 

2-6 
Автоматический режим (SW_AUTO), 9-119-12 
Автоматическое создание DB при 
сохранении, 15-3 

Авторизация, 2-1, 2-3 
Адреса S7-GRAPH в условиях, 7-25 
Активный шаг, 6-2 
Альтернативное ветвление, 6-7 
Анализ диагностического буфера, 11-6 
Анализ информации о модуле и режим 
управления, 11-6 

Анализ сообщений CPU, 11-6 
Арифметика в действиях, 7-11, 13-19 

Б 
Блок, 10-3 
выгрузка в программатор из CPU, 10-3 
из программатора, 10-1 

Блокировка, 7-16, 7-17, 14-8 
Булевские логические операции, 7-15, 7-20 

В 
Ввод элементов FBD, 7-23 
Ввод элементов контактных схем, 7-19 
Внутренняя область данных, 15-18 
экземплярный DB, 15-18 

Время активности шага, 7-25, 15-16 
Входные параметры FB S7-GRAPH, 9-6 
Выбор множества параметров FB, 9-3 
Выбор стандартного функционального блока, 

3-14 
Выбор шага с S_PREV или S_NEXT, 9-16 
Выбор шага с S_SEL, 9-16 
Выгрузка блоков из CPU в программатор,  
 10-3 
Вызов FB S7-GRAPH, 9-1, 9-2 
Выходные параметры FB S7-GRAPH, 9-9 

Г 
Групповые биты, 15-17 

 

Д 
Действия, 3-11, 7-3, 13-9, 13-10, 13-11, 13-12, 

13-13, 13-19, 13-20, 13-21 
компоненты, 7-3 
обзор арифметики, 13-19 
обзор счетчиков, 13-9 
обзор таймеров, 13-14 
программирование, 3-11 

Действия, зависящие от событий, 13-2 
Действия, зависящие от событий – для 
активации и деактивации шагов, 7-8 

Действия, зависящие от событий – с 
блокировкой и без, 7-7 

Действия, зависящие от событий - с 
самоблокировкой и без, 13-2 

Длина массивов индексов, 15-14 
Доступ к экземплярному DB, 15-4 

З 
Загрузка блоков из программатора в CPU,  
 10-1 
Загрузка программы в CPU и проверка 
секвенсора, 3-18 

Запуск S7-GRAPH, 4-1 
Запуск программы установки, 2-5 

И 
Изменение секвенсора, 3-20 
Изменения при установке и вводе в 
эксплуатацию, 14-11 

Имя, 7-28, 7-29 
Индикация режимов, 15-16 
Инициализация, 14-8 
Использование стандартных 
функциональных блоков FC70, FC71, FC72, 
и FC73, 8-13 

Исходный файл S7-GRAPH, 5-3 

К 
Ключ лицензии, 2-1, 2-2 
Комментарий, 7-28 
Комментарий блока, 6-11 
Компиляция, 8-16 
компиляция исходного файла S7-GRAPH, 

8-16 
секвенсоры, 8-15 
сохранение и компиляция, 8-2 

Конец ветви, 6-9 
Константа времени, 7-4, 7-5 
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Л 
Лицензионный ключ, 2-3, 2-4, 2-6 
Лицензия, 2-1, 2-2, 2-3 
Логические операции, 7-15 
Логические операции с элементами FBD, 7-24 
Логические операции с элементами 
контактной логики, 7-20 

М 
Максимальный набор параметров, 15-5 
Массив структуры, 15-1 
Массивы индексов, 15-14 
Масштаб, 4-11, 4-12 
Менеджер лицензий, 2-1, 2-3 
Меню, 4-3 
Мониторинг, 11-6 
Мониторинг и тестирование системы 
последовательного управления, 11-1 

Н 
Наблюдение и изменение переменных, 11-6 
Наблюдение информации о состоянии, 11-2 
Навигация в секвенсоре, 4-16 
Назначение экземплярного DB и FB 

S7-GRAPH, 15-2 
Настройка мнемоники, 13-1 
Настройка цветов и шрифтов, 4-13 
Настройки в "Компиляция/Сохранение" 
закладка 
параметры FB, 8-6 

Настройки на закладке "General", 8-4 
Настройки на закладке "Messages", 8-10 
Настройки на закладке "Компиляция и 
сохранение" Предупреждения, 8-10 

Настройки на закладке "Компиляция и 
сохранение" Свойства секвенсора, 8-9 

Настройки рабочей области, 4-9 
Настройки уровня отображения, 4-11 
Начальное значение счетчика, 7-9 
Начальный шаг, 6-5 
Непосредственный способ редактирования, 

4-15 
Новый секвенсор, 6-9 
Номер, 7-28, 7-29 

О 
Обзор S7-GRAPH, 1-1 
Обзор структуры экземплярного DB, 15-4 
Обзорное окно, 4-4 
Области, 7-1, 7-15 
для действий и условий, 7-1 
для условий, 7-15 

Обработка блокировок и ручное управление в 
ручном режиме, 14-7 

Обработка ошибок супервизора, 7-26 
Обязательное квитирование, 7-26 
Окно деталей, 4-6 
Операции битовой логики, 7-20 
Описание шага в экземплярном DB, 15-11 

Определение сигналов системы, 3-6 
Определение структуры программы и 
встраивание секвенсора, 14-3 

Отдельные структуры, 15-2 
Открытие FB или исходного файла 

S7-GRAPH, 5-3 
Отображение и распечатка экземплярного 

DB, 15-3 
Отображение и расположение панели 
инструментов, 4-14 

Отображение отдельного шага, 4-10 
Отображение состояния сигналов адресов, 

11-3 
Отображение состояния шагов и переходов, 

11-3 
Отображение справочных данных, 11-7 
Ошибка 
отображение, 4-16 

Ошибки супервизора, 7-26 
Ошибки супервизора и обязательное 
квитирование, 7-26 

П 
Панели инструментов, 4-3, 4-14, 4-15 
Панель инструментов 
отображение, 4-14 

Пара шаг/переход, 6-5 
Параллельное ветвление, 6-8 
Параметры, 7-30 

FB S7-GRAPH, 15-5 
вставка в секвенсор, 7-30 

Параметры FB, 15-5 
Параметры FB, 9-3 
Перевод к следующему шагу с T_PUSH, 9-16 
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